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Apple, Bonjour, Macintosh, and Mac OS are trademarks of Apple Inc. in the United States and/or other countries.

Adobe, Acrobat, Photoshop, PostScript, and PostScript 3 are either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

PCL is a trademark of Hewlett-Packard Corporation in the United States and/or other countries.

Microsoft, Windows Vista, Windows, and Windows Server are trademarks of Microsoft Corporation in the United States and/or
other countries.

Linux is a registered trademark of Linus Torvalds.

Novell is a registered trademark and SUSE is a trademark of Novell, Inc. in the United States and other countries.

Red Hat and Red Hat Enterprise Linux are registered trademarks of Red Hat, Inc. in the U.S. and other countries.

RSA, BSAFE are either registered trademarks or trademarks of EMC Corporation in the United States and/or other countries.

Wi-Fi is a registered trademark of the Wi-Fi Alliance. WPA and WPA2 are trademarks of the Wi-Fi Alliance.

All product/brand names are trademarks or registered trademarks of the respective holders.

XEROX, the sphere of connectivity design, and DocuPrint are trademarks or registered trademarks of Xerox Corporation in the
U.S. or Fuji Xerox Co., Ltd.

All Xerox and Fuji Xerox product names are either registered trademarks or trademarks of Xerox Corporation or Fuji Xerox Co., Ltd.

In this manual, safety instructions are preceded by the symbol . Always read and follow the instructions before performing 
the required procedures.

It may be a legal offence to print currency notes, certificates of stocks and securities, or any other documents of similar nature, 
regardless of whether they will be used.

The data saved in the hard disk of the machine may be lost if there is any problem in the hard disk. Fuji Xerox is not responsible 
for any direct and indirect damages arising from or caused by such data loss.

Fuji Xerox is not responsible for any breakdown of machines due to infection of computer virus or computer hacking.

IMPORTANT: 

1. This manual is copyrighted with all rights reserved. Under the copyright laws, this manual may not be copied or modified in 
whole or part, without the written consent of the publisher.

2. Parts of this manual are subject to change without prior notice.

3. We welcome any comments on ambiguities, errors, omissions, or missing pages.

4. Never attempt any procedure on the machine that is not specifically described in this manual. Unauthorized operation can 
cause faults or accidents. Fuji Xerox is not liable for any problems resulting from unauthorized operation of the equipment.

An export of this product is strictly controlled in accordance with Laws concerning Foreign Exchange and Foreign Trade of 
Japan and/or the export control regulations of the United States.
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Preface
Thank you for purchasing the DocuPrint P455 d.

This guide is intended for users who use the printer for the first time, and provides all the necessary operating 
information about the print function.

Please read this guide to achieve the best performance from this printer.

This guide assumes you are familiar with computers and the basics of network operation and configuration.

After reading this guide, keep it safe and handy for future reference.
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Types of Manuals

Manuals included with the printer
The following manuals are provided with the DocuPrint P455 d.

Manuals included with an optional accessory
The following manual is provided with the optional accessories (sold separately).

Safety Guide Describes the information you need to know before using the printer and to operate the 
printer safely.

Setup Guide Provides step-by-step instructions on how to set up your printer.

User Guide (this guide) Describes how to get ready to print and set various features. It also covers the operator 
panel menus, troubleshooting tips, and maintenance information.

This guide is on the Driver CD Kit.

PostScript User Guide Describes how to set up your printer as a PostScript® printer and the features that can 
be configured on your print driver.

This guide is on the PostScript Driver Library CD.

Installation Guide Optional accessories that require an installation at the customer's site are provided 
with an Installation Guide.
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Using This Guide
This section includes:

• "Organization" on page 12

• "Conventions" on page 12

 Organization
This guide is organized into the following chapters. The summary of each chapter is as follows:

 Conventions

1 In this guide, personal computers and workstations are collectively called “computers”.

2 The following terms are used throughout this guide:

IMPORTANT: 

• Important information that must be read and followed.

NOTE: 

• Additional information that merits emphasis.

See also: 
• References within this guide.

3 Orientation of documents or paper is described in this guide as follows:

, , Long Edge Feed (LEF): Loading the document or paper in landscape orientation.

, , Short Edge Feed (SEF): Loading the document or paper in portrait orientation.

1 Specifications Describes the printer specifications.

2 Basic Operation Describes the main components of the printer, the Power Saver mode, 
and the preparation of the printer to use.

3 Printer Management Software Describes the software available for the printer.

4 Printer Connection and Software 
Installation

Describes the basic information about how to connect the printer to your 
computer via the network or USB and how to install the print driver.

5 Printing Basics Describes the supported paper, how to load paper, and how to print data 
using various print features.

6 Using the Operator Panel Menus Describes the setting items available on the operator panel, and their 
setup procedures.

7 Troubleshooting Describes the troubleshooting tips for printer problems such as paper 
jams.

8 Maintenance Describes how to clean the printer, how to replace consumables, and how 
to see the printer status.

9 Contacting Fuji Xerox Describes support information.

LEF Orientation SEF Orientation

Paper feed direction Paper feed direction
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Safety Notes
Before using this product, read “Safety Notes” carefully for safety use.

This product and recommended supplies have been tested and found to comply with strict safety requirements 
including safety agency approvals and compliance with environmental standards. Follow the following instructions 
for safety use.

Follow all warning instructions marked on this product. The warning marks stand for the followings:

WARNING:

• Any unauthorized alteration including an addition of new functions or connection to external devices may 
not be covered by the product warranty. Contact your local Fuji Xerox representative for more 
information.

Used for item that if not followed strictly, can lead death or severe or fatal 
injuries and the possibility to do it is comparatively high.

Used for items that if not followed strictly, can lead to severe or fatal injuries.

Used for items that if not followed strictly, can cause injuries to user or 
damages to machine.

: A symbol for items to pay attention to when handling machine. 

Follow instructions carefully to use machine safely.

: A symbol for prohibited items. Follow instructions carefully to avoid any 
dangerous acts.

: A symbol for items that must be performed. Follow instructions carefully 
to carry out these essential tasks.

Caution Flammable Explodable Electric 
shock

Heated 
surface

Moving 
object

Pinched 
fingers

Static 
Sensitive

Prohibited No fire Do not touch Do not use in 
bathroom

Do not tear 
down

Keep away 
from wet

Never touch 
with wet hand

Instructions Unplug Ground/ 
Earth
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 Electrical Safety

 WARNING
This product shall be operated by the power source as indicated on the product's data plate. Consult your local 
power company to check if your power source meets the requirements.

 CAUTION

WARNING:

• Connect this product to a protective earth circuit.

This product is supplied with a plug that has a protective earth pin. The plug fits only into an earthed 
electrical outlet. This is a safety feature. If the plug doesn't fit to the outlet, contact an electrician to 
replace the outlet to avoid risk of electric shock. Never use an earthed adapter plug to connect the 
product to the electrical outlet that has no earth connection terminal.

Improper connection of a grounding conductor may cause electric shock.

Plug the power cord directly into a grounded electrical outlet. To prevent overheat and a fire 
accident, do not use an extension cord, a multi-plug adaptor or a multiple connector. Consult your 
local Fuji Xerox representative to check if an outlet is grounded.

Connect this product to a branch circuit or an outlet that has larger capacity than the rated ampere 
and voltage of this product. See the data plate on the rear panel of this product for its rated ampere 
and voltage.

Never touch the power cord with wet hands. It may cause electric shock.

Do not put an object on the power cord.

Always keep the plug connection free of dust. The dusty and damp environment may bring about 
minute electric current in a connector. It may generate heat and eventually cause a fire accident.

To avoid the risk of electric shock and a fire accident, only use the power cord supplied with this 
product or the ones designated by Fuji Xerox.

The power cord is exclusive use for this product. Do not use it for any other product.

Do not damage or alter the power cord. Damage and alteration may generate heat and eventually 
cause electric shock or a fire accident.

If the power cord is damaged or insulated wires are exposed, contact your local Fuji Xerox 
representative for its replacement. Do not use a damaged or uninsulated cord to avoid the risk of 
electric shock and a fire accident.

When cleaning this product, always switch off and unplug it. Access to a live machine interior may 
cause electric shock.

Do not unplug or re-plug this product with the switch on. Plugging and unplugging a live connector 
may deform the plug and generate heat, and eventually cause a fire accident.

Hold the plug not the cord when unplugging this product, or it may damage the cord and cause 
electric shock or a fire accident.
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Always switch off and unplug the machine when it is not used over weekends or long holidays. It 
may cause deterioration of insulations and eventually electric shock or a fire accident.

Once a month, switch off this product and check if

• the power cord is plugged firmly into an electrical outlet;

• the plug is not excessively heated, rusted or bent;

• the plug and electrical outlet are free of dust; and

• the power cord is not cracked or worn down.

Once you notice any unusual condition, switch off and unplug this product first and contact your 
local Fuji Xerox representative.



16 Safety Notes

 Machine Installation

 WARNING

 CAUTION

Do not locate this product where people might step on or trip over the power cord. Friction or 
excessive pressure may generate heat and eventually cause electric shock or a fire accident.

Never locate this product in the following places:

• Near radiators or any other heat sources

• Near volatile flammable materials such as curtains

• In the hot, humid, dusty or poorly ventilated environment

• In the place receiving direct sunlight

• Near cookers or humidifiers

Never put this product close to fire such as candles and cigarettes. Otherwise, it may cause a fire 
accident.

Locate this product on a level and sturdy surface that can withstand a weight of 22.5 Kg. Otherwise, 
if tilted, the product may fall over and cause injuries.

Locate this product in a well-ventilated area. Do not obstruct ventilation openings of the product.

Keep the minimum clearance as follows for ventilation and an access to the power plug. Unplug the 
product if an abnormal condition is noted.

893 mm

715 mm

400 mm

400 mm

100 mm

600 mm 426 mm 400 mm

600 mm 426 mm 400 mm

393 mm

110 mm

110 mm

315 mm
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Others

Do not incline the product at more than 10 degree angle. Otherwise, it may fall over and cause 
injuries.

To bundle wires and cables, always use the cable ties and spiral tubes that Fuji Xerox supplies. 
Otherwise, it may cause some defects.

To keep this product in a good performance and condition, always use it in the following 
environment: 

• Temperature: 10 - 32 °C

• Humidity: 10 - 85%

When the product is left in a chilly room and the room is rapidly warmed up by heater, dew 
condensation may form inside the product and cause a partial deletion on printing.

Right Left Right Left

Front Back Front Back

10° 10°

10° 10°
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 Operational Safety

 WARNING

The operator's product maintenance procedures are described in the customer documentation 
supplied with this product. Do not carry out any other maintenance procedures not described in the 
documentation.

This product features safety design not to allow operators access to hazard areas. The hazard 
areas are isolated from operators by covers or protectors which require a tool to remove. To prevent 
electric shock and injuries, never remove those covers and protectors.

To avoid the risk of electric shock and a fire accident, switch off and unplug the product promptly in 
the following conditions, then contact your local Fuji Xerox representative.

• The product emits smoke or its surface is unusually hot.

• The product emits unusual noise or odor.

• The power cord is cracked or worn down.

• A circuit breaker, fuse or any other safety device becomes activated.

• Any liquid is spilled into the product.

• The product is soaked in water.

• Any part of the product is damaged.

Do not insert any object into slots or openings of this product. 
Do not put any of the followings on the product:

• Liquid container such as flower vases or coffee cups

• Metal parts such as staples or clips

• Heavy objects

If liquid is spilled over or metal parts are slipped into the product, it may cause electric shock or a fire 
accident.

Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. 
When paper jam occurs, it may cause short-circuit and eventually a fire accident.

When cleaning this product, use the designated cleaning materials exclusive to it. Other cleaning 
materials may result in poor performance of the product. Never use aerosol cleaners to avoid 
catching fire and explosion.

If you cannot remove the paper jam by doing the procedures in the manual, do not try to forcibly 
remove the jam. Doing so may cause injuries. Contact your local Fuji Xerox representative.

Never play the CD-ROM supplied with the product on an audio player. Always use a CD-ROM 
player. Otherwise, large sound may damage audio players or your ears.

Laser Safety

CAUTION: 

• Any operations or adjustments not stated in the operation manual may cause hazardous 
light exposure and eventually burn injuries or loss of eyesight.

This product has been tested and found to comply with the Class 1 Laser Equipment requirements 
defined by the international standard IEC60825 and has no light exposure hazard. The product has 
no hazardous light emission as it features light protection components and covers to shut in all light 
beam during operation and maintenance.
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 CAUTION

Always follow all warning instructions marked on or supplied with this product.

To avoid the risk of burn injuries and electric shock, never touch the area with the "High 
Temperature" or "High Voltage" marks on.

Keep electrical and mechanical safety interlocks active. Keep the safety interlocks away from 
magnetic materials. Magnetic materials may accidentally activate the product and cause injuries or 
electric shock.

Do not attempt to remove a paper deeply jammed inside the product, particularly a paper wrapped 
around the fusing unit or the heat roller. Otherwise, it may cause injuries or burns. Switch off the 
product immediately and contact your local Fuji Xerox representative.

Ventilate well during extended operation or mass printing. It may affect the office air environment 
due to odor such as ozone in a poorly ventilated room. Provide proper ventilation to ensure the 
comfortable and safe environment.
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 Consumable

 WARNING

 CAUTION

Store all consumables in accordance with the instructions given on its package or container.

Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills. It 
may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill a large 
volume of toner, contact your local Fuji Xerox representative.

Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire 
and cause burn injuries or explosion.

If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for 
its disposal.

Fusing Unit Safety

Do not remove the Fusing Unit. If you cannot remove the paper jam by doing the procedures in the 
manual, do not try to forcibly remove the jam. Doing so may cause injuries. Contact your local Fuji 
Xerox representative.

Keep a drum cartridge and a toner cartridge out of the reach of children. If a child accidentally 
swallows toner, spit it out, rinse mouth with water, drink water and consult a physician immediately.

When replacing a drum cartridge and a toner cartridge, be careful not to spill the toner. In case of 
any toner spills, avoid contact with clothes, skin, eyes and mouth as well as inhalation.

If toner spills onto your skin or clothing, wash it off with soap and water.

If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes until 
irritation is gone. Consult a physician if necessary.

If you inhale toner particles, move to a fresh air location and rinse your mouth with water.

If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.

Fusing Unit Safety

When removing the Fusing Unit, always switch off first and wait for 40 minutes until it cools off.
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 Warning and Caution Labels
Be sure to follow the warning and caution labels placed on the machine. Do not touch areas with labels indicating 
high voltage or temperature. This can cause an electric shock or burn.

CAUTION:

• Always follow all warning instructions marked on or supplied with this product. To avoid the risk of burn 
injuries and electric shock, never touch the area with the "High Temperature" or "High Voltage" marks on.
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Environment
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner cartridges and 

drums (photoreceptors) to make recycle parts, recycle materials or energy recovery.

• Proper disposal is required for toner cartridges and drums (photoreceptors) no longer needed. Do not open 
toner cartridges and drums (photoreceptors). Return them to your local Fuji Xerox representative.
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Regulation

 Radio Frequency Emissions (Class B)

This product has been tested and found to comply with the limits for a Class B digital device, 
pursuant to the International Standard for Electromagnetic Interference (CISPR Publ. 22) and 
Radiocommunications Act 1992 in Australia/New Zealand. 

These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This product generates, uses and can radiate radio frequency energy and, if 
not installed and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this product does cause harmful interference to radio or television reception, which 
can be determined by turning this product off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

– Reorient or relocate the receiving antenna.

– Increase the separation between this product and the receiver.

– Connect this product into an outlet on a circuit different from that to which the receiver is 
connected.

– Consult the dealer or an experienced radio/TV technician for help.

Changes and modifications to this product not specifically approved by Fuji Xerox may void the 
user’s authority to operate this product.
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About License

RSA BSAFE
This product includes RSA BSAFE® Cryptographic software from EMC Corporation.

DES
This product includes software developed by Eric Young.

(eay@mincom.oz.au)

AES
Copyright© 2003, Dr BrianGladman, Worcester, UK. All rights reserved. This product uses published AES software 
provided by Dr Brian Gladmanunder BSD licensing terms.

TIFF(libtiff)
LibTIFFCopyright© 1988-1997 SamLeffler

Copyright© 1991-1997 Silicon Graphics, Inc.

ICC Profile (Little cms)
LittlecmsCopyright© 1998-2004 Marti Maria

JPEG
Our printer software uses some of the codes defined by the Independent JPEG Group.
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Illegal Copies and Printouts
Copying or printing certain documents may be illegal in your country. Penalties of fines or imprisonment may be 
imposed on those found guilty. The following are examples of items that may be illegal to copy or print in your 
country. 

• Currency

• Banknotes and checks

• Bank and government bonds and securities

• Passports and identification cards

• Copyright material or trademarks without the consent of the owner

• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact 
your legal counsel.
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Product Features
This section describes the product features and indicates their links.

Duplex Print

The 2-Sided Print feature is to print two or more pages on 
the front and back side of a single sheet of paper. This 
feature helps reduce the paper consumption.

For more information, see "Duplex Printing" on page 139.

Stored Print

The Stored Print feature allows you to temporarily store 
your print data in the printer memory and output it later. 
You can effectively manage your time when you print 
confidential data or large-volume data at off-peak hours.

For more information, see "Using the Stored Print Feature" 
on page 134.

N-up Print

The Pages Per Sheet (N-Up) feature allows you to print 
multiple pages on a single sheet of paper. This feature 
helps reduce the paper consumption.

For more information, see the print driver's help.
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1
Specifications

This chapter lists the main specifications of the printer. Note that the specifications of the product may change 
without prior notice.

Items Description

Product Code DocuPrint P455 d 220 V: TL300672

DocuPrint P455 d 220 V KOREA: TL300671

DocuPrint P455 d 110 V TAIWAN: TL300669

Type Desktop

Printing Method Laser Xerography

IMPORTANT: 
• Laser + electrophotographic system

Fusing System Thermal fusing system

Warm-up Time 20 seconds or less*

(18 seconds* for waking up from the Sleep mode)
*: The values are based on a room temperature of 22 °C and on the factory default setting.

IMPORTANT: 
• It may take longer due to the image quality adjustment.

Continuous Print Speed*1 1 Sided*2: 45 sheets/minute; 2 Sided*3: 28 pages/minute

IMPORTANT: 
*1 Print speed may decrease due to factors such as paper type, paper size, and printing 

conditions. Print speed may also decrease for image quality adjustment.
*2 When continuously printing a single document of A4  plain paper.
*3 A4  continuous printing

First Print Output Time 5 seconds

IMPORTANT: 
• Measurements based on Fuji Xerox test pattern. Time from printer startup until 

output of the first page is complete. In the case of feeding paper from the 
standard 550 sheet tray and the bypass tray. Numerics depend on the output 
environment. 5.5 seconds for the optional 550 sheet feeder (Tray 2), 6.0 seconds 
for the optional 550 sheet feeder (Tray 3), and 6.5 seconds for the optional 550 
sheet feeder (Tray 4).

Print Resolution 600 × 600 dpi, 1,200 × 1,200 dpi (Low speed)

Tone 256 gray level
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Paper Size Bypass tray:

A4, B5, A5, Legal (8.5 × 14"), Folio (8.5 × 13"), Letter (8.5 × 11"), Executive, C5, 
Com-10, DL, Monarch, Custom (Width: 76.2 – 215.9 mm, Length: 127 – 355.6 
mm)

Standard 550 sheet tray / Optional 550 sheet feeder:

A4, B5, A5, Legal (8.5 × 14"), Folio (8.5 × 13"), Letter (8.5 × 11"), Executive, 
Custom (Width: 139.7 – 215.9 mm, Length: 210 – 355.6 mm)

Paper Type Plain (60 – 80 gsm), Plain Thick (81 – 105 gsm), Lightweight Cardstock (106 – 163 
gsm), Heavyweight Cardstock (164 – 216 gsm), Envelope, Labels, Letterhead, Hole 
Punched, Colored, Other Type

IMPORTANT: 
• When using Fuji Xerox P paper (64 gsm) 

• For 2 sided printing, use the 60 – 163 gsm plain paper.

• Use only the recommended paper. Using paper other than that recommended for 
the printer can cause printing problems. Do not use special ink jet paper. For 
information about the kind of the recommended paper, contact your local Fuji 
Xerox representative.

• Note that poor printing quality due to paper-related printing problems can occur 
when using the printer in an environment that is dry, cold, or very humid. 

• Printing over the printed side or on the reverse side of paper that already has 
been printed on can result in poor print quality.

• When printing on envelopes, use envelopes that do not have adhesive applied.

• The type of paper being used and environmental conditions can affect printing 
quality. Because of this, it is recommended that you test print and confirm proper 
print quality before using the printer.

Paper Tray Capacity Standard:

550 sheets (Standard 550 sheet tray (Tray 1)) + 150 sheets (Bypass tray)

Optional:

1650 sheets (Optional 550 sheet feeder: 550 sheets × 3 (Tray 2, 3, 4))

Maximum paper capacity:

2350 sheets (Standard + Optional)

IMPORTANT: 
• For special paper, there is a limitation of the following.

• From the bottom of the tray, up to 20 mm height (Standard 550 sheet tray)

• From the bottom of the tray, up to 10 mm height (Bypass tray)

• When using Fuji Xerox P paper (64 gsm)

Output Tray Capacity Approximately 250 sheets (A4 ) (face down)

IMPORTANT: 
• When using Fuji Xerox P paper (64 gsm) 

2-sided Printing Feature Standard

CPU ARM11 533 MHz

Memory Standard: 256 MB (Onboard)

Optional: 512 MB

Maximum memory capacity: 768 MB (Standard + optional 512MB memory)

IMPORTANT: 
• Depending on the function, the optional 512MB memory is required.

• The above memory capacity does not guarantee print quality depending on the 
type and content of print data. 

HDD Optional: 160 GB or larger

IMPORTANT: 
• Depending on the function, the optional hard disk unit is required.

Items Description



Specifications 29

Standard Fonts Built-in fonts

PCL 5 and PCL 6 fonts: 81 fonts and 36 symbol sets

PostScript® 3™: 136 fonts

PDF Font: 14 fonts

PDL PCL 5, PCL 6, PostScript®, FX-PDF, TIFF, JPEG, HBPL

Operating System Standard: PCL 6 and PostScript® drivers

Microsoft® Windows® XP x86

Microsoft® Windows Server® 2003 x86

Microsoft® Windows Vista® x86

Microsoft® Windows Server® 2008 x86

Microsoft® Windows® 7 x86

Microsoft® Windows® XP x64

Microsoft® Windows Server® 2003 x64

Microsoft® Windows Vista® x64

Microsoft® Windows Server® 2008 x64 

Microsoft® Windows® 7 x64

Microsoft® Windows Server® 2008 R2 x64

Mac OS® X 10.3.9 PPC

Mac OS® X 10.4 PPC

Mac OS® X 10.5 PPC

Mac OS® X 10.4 x86

Mac OS® X 10.5 x86

Mac OS® X 10.6 x86

Mac OS® X 10.7 x86

Mac OS® X 10.6 x64

Mac OS® X 10.7 x64

Red Hat® Enterprise Linux® 5 Desktop x86

Red Hat® Enterprise Linux® 6 Desktop x86

SUSE® Linux Enterprise Desktop 10 x86

SUSE® Linux Enterprise Desktop 11 x86

IMPORTANT: 
• For information about the latest supported OS, contact your local Fuji Xerox 

representative.

Connectivity Standard: Ethernet (1000BASE-T/100BASE-TX/10BASE-T), USB 2.0

Optional: IEEE802.11 b/g/n

IMPORTANT: 
• When the optional wireless printer adapter is installed, the standard Ethernet 

connection cannot be used.

Protocol TCP/IP (LPD, Port9100, WSD, HTTP, HTTPS, SMTP, RARP, AutoIP, WINS, FTP, 
Telnet, DNS, DDNS, IPP, IPPS, SNTP, SMB, NetBEUI), SNMP, DHCP, BOOTP, 
Bonjour® (mDNS)

IMPORTANT: 
• To use the IPPS protocol, you need to install the optional hard disk unit.

• WSD stands for Web Services on Devices.

• WSD is available only on Windows Vista®, Windows® 7, Windows Server® 2008, 
or Windows Server® 2008 R2.

Power Supply AC 100 - 127 V ± 10%; 11 A or less; both 50/60 Hz ± 3%

AC 220 - 240 V ± 10%; 6 A or less; both 50/60 Hz ± 3%

IMPORTANT: 
• Maximum machine measured current

Items Description
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Operating Noise

(main unit only)

During operation: 7.14 B; 55.9 dB (A)

During stand-by: 4.02 B; 24.9 dB (A)

IMPORTANT: 
• Measurements based on ISO7779

Unit B: acoustic power level (LwAd)
Unit dB (A): radiated sound pressure (bystander position)

Power Consumption Maximum: 1200 W, During the Sleep mode: 4 W or less

Average: 

During standby: 70 W

During continuous printing: 650 W

IMPORTANT: 
• Low Power Mode: 9 W average

(The printer does not use electricity when the power is switched off even with the 
power cord is plugged in.)

Dimensions Width 393 × Depth 426 × Height 315 mm

Machine Weight 12.8 kg

IMPORTANT: 

• The weight of paper is not included.

• The weight of the toner cartridge is included.

Usage Environment During Use: Temperature: 10 - 32 °C; Humidity: 10 - 85% (except malfunctions due 
to dew condensation)

Non-Use: Temperature: -20 - 40 °C; Humidity: 5 - 85% (except malfunctions due to 
dew condensation)

IMPORTANT: 
• Until the conditions (temperature and humidity) inside the printer become 

acclimated to the installation environment, certain qualities of the paper can 
cause poor printing. 

Items Description
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2
Basic Operation

This chapter includes:

• "Main Components" on page 32

• "Installing Optional Accessories" on page 36

• "Turning on the Printer" on page 60

• "Printing a Panel Settings Page" on page 61

• "Power Saver Mode" on page 62
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Main Components
This section provides an overview of your printer.

This section includes:

• "Front View" on page 32

• "Rear View" on page 33

• "Operator Panel" on page 34

• "Securing the Printer" on page 35

 Front View

IMPORTANT: 

• To avoid irregular screen image or malfunctioning of your printer, avoid placing the printer in direct sunlight with the bypass 
tray opened.

1 Operator Panel 5 Toner Cartridge

2 Bypass Tray 6 Drum Cartridge

3 Standard 550 Sheet Tray (Tray 1) 7 Front Cover

4 Optional 550 Sheet Feeder (Tray 2, 3, 4)

2346 57

1
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 Rear View

*: The optional wireless printer adapter is not supplied in some regions.

1 Control Board 7 Power Connector

2 Control Board Cover 8 Chute

3 Power Switch 9 Duplexer

4 Ethernet Port 10 Transfer Unit

5 USB Port 11 Fusing Unit

6 Wireless Adapter Socket* 12 Rear Door

1

2

3

5
4

6

7
9

10

11

12

8
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 Operator Panel
The operator panel has a liquid crystal display (LCD) and buttons.

1  (Menu) button

• Moves to the top menu.

2  (Energy Saver) button

• Lights up in the Power Saver mode. Press this button to enter or exit the Power Saver mode.

3 LCD Panel

• Displays various settings, instructions, and error messages. 

4   buttons

• Scrolls through menus or items in the Menu mode. To enter numbers or passwords, press these buttons.

5   buttons

• Selects submenus or setting values in the Menu mode.

6  (Stop) button

• Cancels the current processing or pending job.

7  button

• Displays the selected menu or item and determines the selected value in the Menu mode.

8  (Back) button

• Switches to the Print mode from the top menu of the Menu mode.

• Returns to the upper hierarchy of the menu from the submenu of the Menu mode.

9  (Error) LED

• Lights up when the printer has an error.

10  (Ready) LED

• Lights up when the printer is ready.

1 2

3

4

6
5

7

8

910
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 Securing the Printer
To protect your printer from theft, you can use the optional Kensington lock.

Attach the Kensington lock to the security slot on your printer.

For details, see the operating instructions supplied with the Kensington lock.

Security slot
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Installing Optional Accessories
You can make the printer more functional by installing the optional accessories such as the 512MB Memory, the 550 
Sheet Feeder, the Wireless Network Kit b/g/n, the Font Kit, and the Hard Disk Unit. This section describes how to 
install these printer's options.

This section includes:

• "Installing the Optional 512MB Memory" on page 36

• "Installing the Optional 550 Sheet Feeder" on page 41

• "Installing the Optional Wireless Printer Adapter" on page 48

• "Installing the Optional Font ROM" on page 53

• "Installing the Optional Hard Disk Unit" on page 56

 Installing the Optional 512MB Memory
NOTE: 

• Your printer supports additional 512 MB memory module.

1 Turn off the printer.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Turn the screw on the control board cover counterclockwise.

NOTE: 

• Loosen the screw. You do not need to remove the screw.

3 Slide the control board cover towards the rear of the printer and remove the cover.
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4 Hold the edge of the memory module with the labeled side down and the connector toward the control board, 
and then insert it into the slot.

5 Push the memory module firmly into the slot.

NOTE: 

• Ensure that the memory module is firmly fixed in the slot and does not move easily.

6 Align the guide on the control board cover with the slot around the control board, and slide it towards the front 
of the printer.

7 Turn the screw clockwise.
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8 Turn on the printer.

9 Print the Printer Settings page to confirm that the newly installed memory module is detected by the printer.

a Press the  (Menu) button.

b Select Report / List, and then press the  button.

c Select Printer Settings, and then press the  button.

The Printer Settings page is printed.

10 Confirm the amount of Memory Capacity listed under General in the Printer Settings page.

If the memory capacity has not increased, turn off the printer, and re-install the memory module.

11 If you installed the optional 512MB memory after installing the print driver, update your driver by following the 
instructions for the operating system you are using. If the printer is on a network, update the driver for each 
client.
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Updating Your Driver to Detect Optional 512MB Memory
The following procedure uses Microsoft® Windows® and the PCL 6/PS driver.

NOTE: 

• When you use XML Paper Specification (XPS) driver, the following settings are not required.

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1 Click the Configuration tab, and then select Installable Options.

2 Select RAM Disk in the Items list box.

3 Select Installed in the RAM Disk drop-down menu under Setting for.

4 Select Memory Capacity in the Items list box.

5 Select the total amount of the installed printer memory in the Memory Capacity drop-down menu under 
Setting for.

6 Click OK.

7 Click Apply, and then click OK.

8 Close the Devices and Printers (, Printers, or Printers and Faxes) dialog box.

Windows 7/
Windows 7 x64/
Windows Server® 2008 R2 x64

1 Click Start → Devices and Printers.

2 Right-click the printer icon of the DocuPrint P455 d and select Printer properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers dialog box.

Windows Vista®/
Windows Vista x64

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon of the DocuPrint P455 d and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows Server 2008/
Windows Server 2008 x64

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon of the DocuPrint P455 d and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows XP/
Windows XP x64/
Windows Server 2003/
Windows Server 2003 x64

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the printer icon of the DocuPrint P455 d and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers and Faxes dialog box.
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The following procedure uses Mac OS® X and the PS driver.

Mac OS X 10.7.x 1 Select the Print & Scan in System Preferences.

2 Select the printer in Printers list, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences.

2 Select the printer in Printers list, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup 
Utility).

2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select 
Show Info.

3 Select Installable Options, and select the options that have been installed on the 
printer, and then click Apply Changes.
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 Installing the Optional 550 Sheet Feeder
IMPORTANT: 

• If you install the optional 550 sheet feeder after setting up the printer, be sure to turn off the printer, unplug the power cord, 
and disconnect all cables from the rear of the printer before installing the feeder.

NOTE: 

• Up to three optional 550 sheet feeders can be installed to the printer. If required, prepare the multiple feeders.

1 Turn off the printer.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Disconnect all cables from the rear of the printer.

3 Remove the tape and the bag holding the screws on the front of the optional 550 sheet feeder, and then 
remove the screws from the bag.

4 Place the optional 550 sheet feeder in the location that the printer is located.

When you install the multiple optional 550 sheet feeders, go to step 5.

When you install a single optional 550 sheet feeder, go to step 10.

5 Pull the optional 550 sheet tray out of another optional 550 sheet feeder.
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6 Lift the optional 550 sheet feeder and align the five guide pins of the other 550 sheet feeder with the holes at 
the bottom of the feeder. Gently lower the feeder onto the other feeder.

IMPORTANT: 

• Be careful not to pinch your fingers when lowering the optional 550 sheet feeder onto the other feeder.

7 Secure the optional 550 sheet feeder to the other feeder by tightening the two screws provided with the feeder, 
with a coin or similar object.

NOTE: 

• The screw hole is located in 145 mm recess from the front of the printer.

8 Insert the optional 550 sheet tray into the feeder, and push until it stops.

IMPORTANT: 

• When you set the tray, make sure that the bottom plate is lowered. If the back side of the bottom plate is raised before 
setting the tray, press the 1 to lower the plate.

9 Repeat steps 5 to 8 when installing another 550 sheet feeder.

IMPORTANT: 

• Do not install more than three optional 550 feeders. Doing so could damage the optional 550 feeders.

10 Gently pull open the bypass tray cover.

1
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11 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

12 Pull the standard 550 sheet tray out of the printer about 200 mm.

13 Hold the standard 550 sheet tray with both hands, and remove it from the printer.

14 Lift the printer and align the five guide pins of the optional 550 sheet feeder with the holes at the bottom of the 
printer. Gently lower the printer onto the optional 550 sheet feeder.

IMPORTANT: 

• Be careful not to pinch your fingers when lowering the printer onto the optional 550 sheet feeder.
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15 Secure the optional 550 sheet feeder to the printer by tightening the two screws provided with the feeder with a 
coin or similar object.

NOTE: 

• The screw hole is located in 145 mm recess from the front of the printer.

16 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 

• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

• When you set the tray, make sure that the bottom plate is lowered. If the back side of the bottom plate is raised before 
setting the tray, press the 1 to lower the plate.

17 Insert the bypass tray into the printer, push until it stops, and close the cover.

18 Apply the label to the upper part of the operator panel on the printer.

19 Reconnect all cables into the rear of the printer and turn on the printer.

NOTE: 

• The printer will automatically detect the attached tray but will not detect the paper type.

1
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20  Print the Printer Settings page to confirm the optional 550 sheet feeder is installed correctly.

a Press the  (Menu) button.

b Select Report / List, and then press the  button.

c Select Printer Settings, and then press the  button.

The Printer Settings page is printed.

21 Confirm the optional 550 sheet feeder is listed under Printer Options in the Printer Settings page.

If the feeder is not listed, turn off the printer, unplug the power cord, and re-install the optional 550 sheet feeder.

22 After loading paper in the optional 550 sheet feeder, specify the paper type from the printer operator panel.

a  Press the  (Menu) button.

b Select Tray Settings, and then press the  button.

c Select Tray2, Tray3, or Tray4, and then press the  button.

d Select Paper Type, and then press the  button.

e Select the paper type for the optional 550 sheet feeder, and then press the  button.

23 If you installed the optional 550 sheet feeder after installing the print driver, update your driver by following the 
instructions for each operating system. If the printer is on a network, update the driver for each client.
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Updating Your Driver to Detect Optional 550 Sheet Feeder
The following procedure uses Windows and the PCL 6/PS driver.

NOTE: 

• When you use XML Paper Specification (XPS) driver, the following settings are not required.

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1 Click the Configuration tab, and then select Installable Options.

2 Select Paper Tray Configuration in the Items list box.

3 Select 2 Trays, 3 Trays, or 4 Trays in the Paper Tray Configuration drop-down menu under Setting for.

4 Click OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers (, Printers, or Printers and Faxes) dialog box.

Windows 7/
Windows 7 x64/
Windows Server 2008 R2 x64

1 Click Start → Devices and Printers.

2 Right-click the printer icon of the DocuPrint P455 d and select Printer properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers dialog box.

Windows Vista/
Windows Vista x64

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon of the DocuPrint P455 d and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows Server 2008/
Windows Server 2008 x64

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon of the DocuPrint P455 d and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows XP/
Windows XP x64/
Windows Server 2003/
Windows Server 2003 x64

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the printer icon of the DocuPrint P455 d and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers and Faxes dialog box.
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The following procedure uses Mac OS X and the PS driver.

Mac OS X 10.7.x 1 Select the Print & Scan in System Preferences.

2 Select the printer in Printers list, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences.

2 Select the printer in Printers list, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printers, and then 
click OK.

Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup 
Utility).

2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select 
Show Info.

3 Select Installable Options, and select the options that have been installed on the 
printer, and then click Apply Changes.
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 Installing the Optional Wireless Printer Adapter
The wireless printer adapter is supplied with the Wireless Network Kit b/g/n.

The wireless printer adapter allows you to use the printer with wireless network connection.

The specifications of the wireless printer adapter are described below.

NOTE: 

• The optional wireless printer adapter is not supplied in some regions.

NOTE: 

• When the wireless printer adapter is installed, you cannot use IEEE 802.1x authentication and/or the Ethernet port for a wired 
connection.

Verifying the Contents of the Box

NOTE: 

• To complete wireless installation, you require the corresponding Driver CD Kit that comes with your printer, which can also be 
downloaded from http://www.fujixerox.com/support/docuprint/.

Item Specification

Connectivity Technology Wireless

Compliant Standards IEEE 802.11b, 802.11g, and 802.11n

Bandwidth 2.4 GHz

Data Transfer Rate IEEE 802.11n: 65 Mbps

IEEE 802.11g: 54, 48, 36, 24, 18, 12, 9, and 6 Mbps

IEEE 802.11b: 11, 5.5, 2, and 1 Mbps

Security 64 (40-bit key)/128 (104-bit key) WEP,

WPA- PSK (TKIP, AES), WPA2-PSK (AES)

Wi-Fi® Protected Setup (WPS) Push-Button Configuration (PBC),

Personal Identification Number (PIN)

Fuji Xerox Co., Ltd.

XXXX XXXXX / DE4942Z4-1
(Edition 1) June 2012

Printed in China
Copyright © 2012 by Fuji Xerox Co., Ltd. XXXX XXXXX

Thank you for purchasing the Wireless Network Kit b/g/n. 
To ensure the safe operation of the printer, be sure to read through the "Safety Guide" before starting 
the installation. For more details such as how to configure the wireless settings for the printer, refer to 
"Configuring Wireless Settings (Windows & Mac OS X)" in "User Guide" available on the Driver CD Kit.

Installing the Wireless Printer Adapter
Important
• Ensure that the printer is turned off before installing the wireless printer adapter.

Align the connector and the three protrusions of the wireless printer adapter with the four holes on the rear of the 
printer, and insert the adapter as shown in the illustration.

•

•

Wireless Network Kit b/g/n Installation Guide

Wireless Printer Adapter

Wireless Network Kit b/g/n 
Installation Guide
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Installing the Optional Wireless Printer Adapter Using Video 
Instructions (Recommended)
To install the wireless printer adapter using the video instructions on the Windows computer, perform the following 
method.

1 Insert the Driver CD Kit in your computer. The Easy Install Navi file launches automatically.

2 Select Optional Accessories Setup on the Easy Install Navi window.
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3 Click Wireless Network Kit b/g/n.

4 Click the procedure you want to confirm to start the video instruction.

Follow the on-screen instructions to install the wireless printer adapter.
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Installing the Optional Wireless Printer Adapter

NOTE: 

• You can also install the wireless printer adapter by following the instructions described in Wireless Network Kit b/g/n 
Installation Guide provided with the wireless printer adapter.

1 Turn off the printer.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Align the connector and the three protrusions of the wireless printer adapter with the four holes and insert the 
adapter.

NOTE: 

• Ensure that the adapter is fully inserted and secured.

3 Turn on the printer.

If a message displays telling you to make initial setup on the operator panel, always do as instructed.

4 Print the Printer Settings page to confirm the wireless printer adapter is installed correctly.

a Press the  (Menu) button.

b Select Report / List, and then press the  button.

c Select Printer Settings, and then press the  button.

The Printer Settings page is printed.
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5 Confirm that the Network (Wireless) section exists.

NOTE: 

• For more information on configuring the wireless printer adapter, see "Configuring Wireless Settings (Windows & Mac 
OS X)" on page 103.
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 Installing the Optional Font ROM
The Font ROM is supplied with the Font Kit.

NOTE: 

• Your printer supports TC/SC Font Kit, KR Font Kit, or JP Font Kit.

1 Turn off the printer.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Turn the screw on the control board cover counterclockwise.

NOTE: 

• Loosen the screw. You do not need to remove the screw.

3 Slide the control board cover towards the rear of the printer and remove the cover.

NOTE: 

• If the hard disk unit is installed, remove it before installing the font ROM. Re-install the hard disk unit after installing the 
font ROM.
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4 Open the tabs on both sides of the font ROM.

5 Hold the edge of the font ROM and the connector toward the control board, and then insert it into the slot.

6 Push the font ROM firmly into the slot.

NOTE: 

• Ensure that the font ROM is firmly fixed in the slot and does not move easily.

7 Align the guide on the control board cover with the slot around the control board, and slide it towards the front 
of the printer.
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8 Turn the screw clockwise.

9 Turn on the printer.

10 Print the Printer Settings page to confirm that the newly installed font ROM is detected by the printer.

a Press the  (Menu) button.

b Select Report / List, and then press the  button.

c Select PCL Fonts List, and then press the  button.

The PCL Fonts List page is printed.

11 Confirm the TC/SC fonts, KR fonts, or JP fonts listed in the PCL Fonts List page.

If the TC/SC fonts, KR fonts, or JP fonts has not increased, turn off the printer, and re-install the font ROM.
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 Installing the Optional Hard Disk Unit
NOTE: 

• When installing both the hard disk unit and font ROM, installing the font ROM is required to proceed the hard disk unit. The 
font ROM can not be installed when the hard disk unit is being already installed.

1 Turn off the printer.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Turn the screw on the control board cover counterclockwise.

NOTE: 

• Loosen the screw. You do not need to remove the screw.

3 Slide the control board cover towards the rear of the printer and remove the cover.

4 Insert the two plastic pins on the hard disk unit into the metal casing holes.
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5 Attaching the protrusion and the connector to the control board, push the hard disk unit firmly into place.

6 Align the guide on the control board cover with the slot around the control board, and slide it towards the front 
of the printer.

7 Turn the screw clockwise.

8 Turn on the printer.

9 Print the Printer Settings page to confirm the optional hard disk unit is installed correctly.

a Press the  (Menu) button.

b Select Report / List, and then press the  button.

c Select Printer Settings, and then press the  button.

The Printer Settings page is printed.

10 Confirm the amount of Hard Disk is listed under Printer Options in the Printer Settings page.

If the Hard Disk is not listed, turn off the printer, unplug the power cord, and re-install the hard disk unit.

11 If you installed the hard disk unit after installing the print driver, update your driver by following the instructions 
for the operating system you are using. If the printer is on a network, update the driver for each client.
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Updating Your Driver to Detect Optional Hard Disk Unit
The following procedure uses Windows and the PCL 6/PS driver.

NOTE: 

• When you use XML Paper Specification (XPS) driver, the following settings are not required.

If the printer information is not updated automatically after clicking Get Information from Printer, follow these steps:

1 Click the Configuration tab, and then select Installable Options.

2 Select Hard Disk in the Items list box.

3 Select Installed in the Hard Disk drop-down menu under Setting for.

4 Click OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers (, Printers, or Printers and Faxes) dialog box.

Windows 7/
Windows 7 x64/
Windows Server 2008 R2 x64

1 Click Start → Devices and Printers.

2 Right-click the printer icon of the DocuPrint P455 d and select Printer properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Devices and Printers dialog box.

Windows Vista/
Windows Vista x64

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon of the DocuPrint P455 d and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows Server 2008/
Windows Server 2008 x64

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon of the DocuPrint P455 d and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers dialog box.

Windows XP/
Windows XP x64/
Windows Server 2003/
Windows Server 2003 x64

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the printer icon of the DocuPrint P455 d and select Properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.

4 Select Get Information from Printer and then select OK.

5 Click Apply, and then click OK.

6 Close the Printers and Faxes dialog box.
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The following procedure uses Mac OS X and the PS driver.

Mac OS X 10.7.x 1 Select the Print & Scan in System Preferences.

2 Select the printer in Printers list box, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printer, and then 
click OK.

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences.

2 Select the printer in Printers list box, and click Options & Supplies.

3 Select Driver, select the options that have been installed on the printer, and then 
click OK.

Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup 
Utility).

2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select 
Show Info.

3 Select Installable Options, and select the options that have been installed on the 
printer, and then click Apply Changes.
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Turning on the Printer

IMPORTANT: 

• Do not use extension cords or power strips.

• The printer should not be connected to an uninterrupted power supply (UPS) system.

1 Connect the power cord to the power connector on the rear of your printer.

2 Connect the other end of the power cord to the power source.

3 Turn on the printer.
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Printing a Panel Settings Page
The Panel Settings page shows current settings for the operator panel menus. 

1 Press the  (Menu) button.

2 Select Report / List, and then press the  button.

3 Select Panel Settings, and then press the  button.

The Panel Settings page is printed.
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Power Saver Mode
The printer has an energy saving feature that reduces power consumption during periods of inactivity. This feature 
operates in two modes: the Low Power mode and Sleep mode. As delivered, the printer switches to the Low Power 
mode three minutes after the last print job is printed. The printer then switches to the Sleep mode after another one 
minute of inactivity. When the printer is in the Low Power mode,  (Energy Saver) button lights up, and the LCD 
backlight turns off. In the Sleep mode, the display also goes blank and displays nothing.

The factory default setting of one minute for each mode is changeable within the range of 1 to 60 minutes (Low 
Power mode and Sleep mode). The printer returns to the ready-to-print state in about 18 seconds when re-activated.

The printer can switch from the ready-to-print state to the Low Power mode without waiting right after pressing  
(Energy Saver) button. Press  (Energy Saver) button to switch to Power Saver mode to save electricity.

NOTE: 

• The functions of Low Power mode and Sleep mode cannot be disabled.

See also: 
• "Setting the Power Saver Time Option" on page 198

 Exiting the Power Saver Mode
The printer automatically exits the Power Saver mode when it receives a print job from a computer. To manually exit 
the Low Power mode, press the  (Energy Saver) button on the operator panel. To exit the Sleep mode, press the 

 (Energy Saver) button. 

NOTE: 

• Opening and closing a cover will cause the printer to exit the Low Power mode and the Sleep mode.

• When the printer is in the Sleep mode, all buttons on the operator panel except for the  (Energy Saver) button do not 
function. To use the buttons on the operator panel, press the  (Energy Saver) button to exit the Sleep mode.

See also: 
• "Setting the Power Saver Time Option" on page 198
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3
Printer Management Software

Use the CD-ROMs shipped with your printer to install a combination of software programs, depending on your 
operating system.

This chapter includes:

• "Print Drivers" on page 64

• "CentreWare Internet Services" on page 65

• "SimpleMonitor (Windows Only)" on page 66

• "Setup Disk Creation Tool (Windows Only)" on page 67
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Print Drivers
To access all of your printer's features, install the print drivers from the Driver CD Kit or PostScript Driver Library CD.

• The print drivers enable your computer and printer to communicate and provide access to your printer features.
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CentreWare Internet Services
This section provides information on CentreWare Internet Services, a hyper text transfer protocol (HTTP)-based web 
page service that is accessed through your web browser. 

These pages give you instant access to printer status, and printer configuration options. Anyone on your network 
can access the printer using their web browser software. In administrative mode you can change the configuration of 
the printer, and manage your printer settings without leaving your computer.

NOTE: 

• Users who are not given passwords by the administrator can still view the configuration settings and options in user mode. 
They will not be able to save or apply any changes to the current configuration.

 Creating an Administrative Password

1 Launch your web browser.

2 Enter the IP address in the browser’s address field, and then press the Enter key.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select Administrator Settings.

5 Select Enabled for Administrator Mode. 

6 In the Administrator Login ID field, enter a name for the administrator.

NOTE: 

• The default ID and password are “11111” and “x-admin”, respectively.

7 In the Administrator Password and Re-enter Password fields, enter a password for the administrator.

8 In the Maximum Login Attempts field, enter the number of login attempts allowed.

9 Click Apply.

Your new password has been set and anyone with the administrator name and password can log in and 
change the printer configuration and settings.
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SimpleMonitor (Windows Only)
You can check the printer status with SimpleMonitor. Double-click the SimpleMonitor printer icon  on the taskbar 
at the bottom right of the screen. The Select Printer window appears, which displays the printer name, printer 
connection ports, and printer status. Check the Status column to know the current status of your printer. You can 
also check the toner level of your printer.

Status Settings button: Displays the Status Settings dialog box and allows you to modify the SimpleMonitor 
settings.

Click the name of the desired printer listed on the Select Printer window. The Status Monitor window appears.

The Status Monitor window alerts you when there is a warning or when an error occurs, for example, when a paper 
jam occurs or toner is running low.

By default, the Status Monitor window launches when printing and an error occurs. When an error occurs, the error 
message appears on the Status Monitor window. You can specify the conditions for starting the Status Monitor 
window in Auto start setup.

To change the pop-up settings for the Status Monitor window:

The following procedure uses Microsoft® Windows® 7 as an example.

1 Click Start → All Programs → Fuji Xerox → SimpleMonitor for Asia-Pacific → Activate SimpleMonitor.

The Select Printer window appears.

2 Click Status Settings.

The Status Settings dialog box appears.

3 Select the Pop-up Settings tab, and then select the type of the pop-up from Auto start setup.

SimpleMonitor can be installed from the Driver CD Kit. It is available only for Windows.
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Setup Disk Creation Tool (Windows Only)
The Setup Disk Creation Tool on the Driver CD Kit and the print drivers on the Driver CD Kit and PostScript Driver 
Library CD are used to create driver installation packages that contain custom driver settings. A driver installation 
package can contain a group of saved print driver settings and other data for things such as:

• Print orientation and Multiple Up (document settings)

• Watermarks

• Font references

If you want to install the print driver with the same settings on multiple computers running the same operating 
system, create a setup disk in a floppy disk or in a server on the network. Using the setup disk that you have created 
will reduce the amount of work required when installing the print driver.

• Install the print driver in the computer on which the setup disk is to be created.

• The setup disk can only be used on the operating system on which the disk was created or computers running 
the same operating system. Create a separate setup disk for each of the operating systems.
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4
Printer Connection and Software 
Installation

This chapter includes:

• "Overview of Network Setup and Configuration" on page 70

• "Connecting Your Printer" on page 71

• "Setting the IP Address" on page 74

• "Installing Print Driver on Computers Running Windows" on page 78

• "Installing Print Driver on Computers Running Mac OS X" on page 96

• "Installing Print Driver on Computers Running Linux (CUPS)" on page 97

• "Configuring Wireless Settings (Windows & Mac OS X)" on page 103
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Overview of Network Setup and Configuration
To set up and configure the network:

1 Connect the printer to the network using the recommended hardware and cables.

2 Turn on the printer and the computer.

3 Print the Printer Settings page and keep it for referencing network settings. 

4 Install the driver software on the computer from the Driver CD Kit or PostScript Driver Library CD. For 
information on driver installation, see the section in this chapter for the specific operating system you are using.

5 Configure the printer’s TCP/IP address, which is required to identify the printer on the network. 

• Microsoft® Windows® operating systems: Run the IP address setting tool on the Driver CD Kit to set the 
printer’s IP address if the printer is connected to an established TCP/IP network. You can also manually set 
the printer’s IP address on the operator panel.

• Mac OS® X and Linux® systems: Manually set the printer’s TCP/IP address on the operator panel.

See also: 

• "Setting the IP Address" on page 74

6 Print a Printer Settings page to verify the new settings.

NOTE: 

• If the Driver CD Kit or PostScript Driver Library CD is not available, you can download the latest driver from the Fuji Xerox 
Web Site: http://www.fujixeroxprinters.com/ 

See also: 
• "Printing a Printer Settings Page" on page 148

http://www.fujixeroxprinters.com/
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Connecting Your Printer
Your printer interconnection cables must meet the following requirements:

Connection Type Connection Specifications

USB USB 2.0

Ethernet 1000BASE-T/100BASE-TX/10BASE-T

Wireless (optional) IEEE 802.11b/802.11g/802.11n

1 Ethernet port

2 USB port

3 Wireless adapter socket

1

2

3
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 Connecting Printer to Computer or Network
Connect the printer via USB, Ethernet or wireless (optional). A USB connection is a direct connection and is not 
used for networking. Ethernet and wireless connections are used for networking. Hardware and cabling 
requirements vary for the different connection methods. Ethernet cable and hardware are generally not included with 
your printer and must be purchased separately.

The available features for each connection type are shown in the following table.

USB Connection
A local printer is directly connected to your computer using the USB cable. If your printer is connected to a network 
instead of your computer, skip this section and go to "Wired Network Connection" on page 73.

To connect the printer to a computer:

1 Connect the smaller USB connector into the USB port on the rear of the printer, and the other end of the cable 
into a USB port of the computer.

NOTE: 

• Ensure that you match the USB symbol on the cable to the USB symbol on the printer.

• Do not connect the printer USB cable to the USB port available on the keyboard.

Connection Type Available Features

USB When connected via USB you can:

• Instruct print jobs from a computer.

• Use the SimpleMonitor to check the printer status.

Ethernet When connected via Ethernet you can:

• Instruct print jobs from a computer on the network.

• Use CentreWare Internet Services to configure the printer status or settings.

• Use the SimpleMonitor to check the printer status.

Wireless (optional) When connected via wireless you can:

• Instruct print jobs from a computer on the network.

• Use CentreWare Internet Services to configure the printer status or settings.

• Use the SimpleMonitor to check the printer status.
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Wired Network Connection
To connect the printer to a network:

1 Connect one end of the Ethernet cable into the Ethernet port on the rear of the printer, and the other end to a 
LAN drop or hub.

Wireless Network Connection
To set up a wireless connection, insert the optional wireless printer adapter into the wireless adapter socket on the 
rear of the printer. For details about wireless connection, see "Installing the Optional Wireless Printer Adapter" on 
page 48.

NOTE: 

• To use the wireless printer adapter, be sure to disconnect the Ethernet cable.
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Setting the IP Address
This section includes:

• "TCP/IP and IP Addresses" on page 74

• "Setting the Printer’s IP Address through the Driver CD Kit" on page 74

• "Dynamic Methods of Setting the Printer’s IP Address" on page 75

• "Assigning an IP Address (for IPv4 Mode)" on page 76

• "Verifying the IP Settings" on page 77

• "Printing and Checking the Printer Settings Page" on page 77

 TCP/IP and IP Addresses
If your computer is on a large network, contact your network administrator for the appropriate TCP/IP addresses and 
additional system settings information. 

If you are creating your own small Local Area Network or connecting the printer directly to your computer using 
Ethernet, follow the procedure for automatically setting the printer’s IP address. 

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. With TCP/IP 
protocols, each printer and computer must have a unique IP address. It is important that the addresses are similar, 
but not the same; only the last digit needs to be different. For example, your printer can have the address 
192.168.1.2 while your computer has the address 192.168.1.3. Another device can have the address 192.168.1.4.

Many networks have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server automatically 
programs an IP address into every computer and printer on the network that is configured to use DHCP. A DHCP 
server is built into most cable and Digital Subscriber Line (DSL) routers. If you use a cable or DSL router, see your 
router’s documentation for information on IP addressing.

 Setting the Printer’s IP Address through the Driver CD Kit
If the printer is connected to a small established TCP/IP network without a DHCP server, use the IP address setting 
tool on the Driver CD Kit to detect or assign an IP address to your printer. For further instructions, insert the Driver 
CD Kit into your computer’s CD-ROM drive. After the IP address setting tool launches, click Install Driver and 
Software. Start IP address setting tool on the Admin Tools tab, and follow the displayed instructions.

NOTE: 

• For the IP address setting tool to function, the printer must be connected to an established TCP/IP network.
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 Dynamic Methods of Setting the Printer’s IP Address
There are two protocols available for dynamically setting the printer’s IP address: 

• DHCP (enabled by default)

• AutoIP

You can turn on/off both protocols using the operator panel or CentreWare Internet Services.

NOTE: 
• You can print a report that includes the printer’s IP address. On the operator panel, press the  (Menu) button, select 

Report / List, press the  button, select Printer Settings, and then press the  button. The IP address is listed 
on the Printer Settings page.

Using the Operator Panel
To turn on/off either the DHCP or AutoIP protocol:

1 On the operator panel, press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Network Setup, and then press the  button.

4 Select TCP/IP, and then press the  button.

5 Select IPv4, and then press the  button.

6 Select Get IP Address, and then press the  button.

7 Select DHCP / Autonet, and then press the  button.

8 Turn off and turn on the printer.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

Using CentreWare Internet Services
To turn on/off either the DHCP or AutoIP protocol:

1 Launch your web browser.

2 Enter the IP address in the browser’s address field, and then press the Enter key.

3 Select Properties.

4 Select the Protocol Settings folder on the left navigation panel.

5 Select TCP/IP.

6 In the Get IP Address field, select the DHCP / Autonet option.

7 Click the Apply button.
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 Assigning an IP Address (for IPv4 Mode)
NOTE: 

• When you assign an IP address manually in IPv6 mode, use the CentreWare Internet Services. To display the CentreWare 
Internet Services, use the link local address. To check a link local address, see "Printing and Checking the Printer Settings 
Page" on page 77.

• Assigning an IP address is considered as an advanced function and is normally done by a system administrator.

• Depending on the address class, the range of the IP address assigned may be different. On Class A, for example, an IP 
address in the range from 0.0.0.0 to 127.255.255.255 will be assigned. For assignment of IP addresses, contact 
your system administrator. 

You can assign the IP address by using the operator panel.

1 Turn on the printer.

2 Ensure that Ready message appears on the LCD panel.

3 On the operator panel, press the  (Menu) button.

4 Select Admin Menu, and then press the  button.

5 Select Network Setup, and then press the  button.

6 Select TCP/IP, and then press the  button.

7 Select IPv4, and then press the  button.

8 Select Get IP Address, and then press the  button.

9 Select Panel, and then press the  button.

10 Ensure that the message Restart Printer to apply setting appears, and then press the  (Back) 
button twice.

11 Select IP Address, and then press the  button.

The cursor is located at the first octet of the IP address.

12 Specify the value of the IP address using the  or  button.

13 Press the  button.

The cursor moves to the next octet.

14 Repeat steps 12 to 13 to set all of the digits in the IP address, and then press the  button.

15 Ensure that the message Restart Printer to apply setting appears, and then press the  (Back) 
button twice.

16 Select Subnet Mask, and then press the  button.

The cursor is located at the first octet of the subnet mask.

17 Specify the value of the subnet mask using the  or  button.

18 Press the  button.

The cursor moves to the next octet.

19 Repeat steps 17 to 18 to set the subnet mask, and then press the  button.

20 Ensure that the message Restart Printer to apply setting appears, and then press the  (Back) 
button twice.

21 Select Gateway Address, and then press the  button.

The cursor is located at the first octet of the gateway address.
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22 Specify the value of the gateway address using the  or  button.

23 Press the  button.

The cursor moves to the next octet.

24 Repeat steps 22 to 23 to set the gateway address, and then press the  button.

25 Ensure that the message Restart Printer to apply setting appears.

26 Turn off and turn on the printer.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

See also: 
• "Operator Panel" on page 34

 Verifying the IP Settings
You can confirm the settings by printing the system settings report or using the ping command.

The following procedure uses Windows 7 as an example.

1 Print the Printer Settings page.

2 Look under the IPv4 heading on the Printer Settings page to ensure that the IP address, subnet mask, and 
gateway address are appropriate.

To verify if the printer is active on the network, run the ping command in your computer:

1 Click Start → All Programs → Accessories → Run.

2 Enter cmd, and then click OK.

A black window is displayed.

3 Enter ping xx.xx.xx.xx (where xx.xx.xx.xx is the IP address of your printer), and then press the Enter key.

Reply from the IP address denotes printer is active on the network.

See also: 
• "Printing and Checking the Printer Settings Page" on page 77

 Printing and Checking the Printer Settings Page
Print the Printer Settings page and check your printer's IP address by using the operator panel.

1 On the operator panel, press the  (Menu) button.

2 Select Report / List, and then press the  button.

3 Select Printer Settings, and then press the  button.

The Printer Settings page is printed.

4 Confirm the IP address next to IP Address under Network Setup on the Printer Settings page. If the IP 
address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and then print the Printer 
Settings page again.

If the IP address is not resolved automatically, see "Assigning an IP Address (for IPv4 Mode)" on page 76.
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Installing Print Driver on Computers Running 
Windows
This section includes:

• "Identifying Print Driver Pre-install Status (For Network Connection Setup)" on page 78

• "Inserting the CD-ROM" on page 79

• "USB Connection Setup" on page 80

• "Network Connection Setup" on page 82

• "Setting Up for Shared Printing" on page 87

 Identifying Print Driver Pre-install Status (For Network 
Connection Setup)

Before installing the print driver on your computer, print the Printer Settings page to check the IP address of your 
printer.

This section includes:

• "The Operator Panel" on page 78

• "Changing the Firewall Settings Before Installing Your Printer" on page 79

The Operator Panel

1 Press the  (Menu) button.

2 Select Report / List, and then press the  button.

3 Select Printer Settings, and then press the  button.

The Printer Settings page is printed.

4 Find the IP address next to IP Address under Network Setup on the Printer Settings page.

If the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and then print the 
Printer Settings page again.

If the IP address is not resolved automatically, see "Assigning an IP Address (for IPv4 Mode)" on page 76.
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Changing the Firewall Settings Before Installing Your Printer
If you are running one of the following operating systems, you must change the firewall settings before installing the 
Fuji Xerox printer software:

• Windows 7

• Windows Vista®

• Windows Server® 2008 R2

• Windows Server 2008

• Windows XP

NOTE: 

• For Windows XP, Service Pack 2 or 3 must be installed.

The following procedure uses Windows 7 as an example.

1 Insert the Driver CD Kit into your computer.

2 Click Start → Control Panel.

3 Click System and Security.

4 Click Windows Firewall.

5 Click Allow a program or feature through Windows Firewall.

6 Click Change settings.

7 Click Allow another program.

8 Click Browse.

9 Click D:\setup.exe (where D is the drive letter of the optical drive) in the File name text box, and then click 
Open.

10 Click Add.

11 Click OK.

 Inserting the CD-ROM

• For Installing PCL 6 Driver

1 Insert the Driver CD Kit into your computer to start Easy Install Navi.

NOTE: 

• If the CD does not automatically launch, click Start (start for Windows XP) → All Programs (for Windows Vista and 
Windows 7) → Accessories (for Windows Vista and Windows 7) → Run, and then enter D:\setup.exe (where D is the 
drive letter of the optical drive), and then click OK.

• For Installing PS Driver

1 Insert the PostScript Driver Library CD into your computer.

• For Installing XML Paper Specification (XPS) Print Driver

1 Extract the zip file in the following path to your desired location.

D:\Eng\XPS (where D is the drive letter of the optical drive)
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 USB Connection Setup
NOTE: 

• A personal printer is a printer attached to your computer or a print server using a USB. If your printer is attached to a network 
and not your computer, see "Network Connection Setup" on page 82.

• For Installing PCL 6 Driver

1 On the top screen of Easy Install Navi, click Installing Driver and Software.

2 Click Print Driver. 

3 Click Connect via USB.

4 Follow the procedures described in the Help to install the print driver.

• For Installing PS Driver
For information on how to install the PS driver, refer to the PostScript User Guide.

• For Installing XML Paper Specification (XPS) Print Driver

NOTE: 

• XML Paper Specification (XPS) driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit 
Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, and Windows 7 
64-bit Edition.

Windows Vista or Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 79.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box displayed under the 
Printer name.

11 Click Next.

Installation starts.

If the User Account Control dialog box appears, click Continue.

NOTE: 

• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 
action.

12 As the driver installation is completed, click Print a test page to print a test page.

13 Click Finish.
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Windows Server 2008 or Windows Server 2008 64-bit Edition

NOTE: 

• You must log in as an administrator.

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 79.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box.

11 Click Next.

Installation starts.

12 If you do not share your printer, select Do not share this printer.

If you share your printer, select Share this printer so that others on your network can find and use it.

13 Click Next.

14 As the driver installation is completed, click Print a test page to print a test page.

15 Click Finish.

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer.

If the User Account Control dialog box appears, click Yes.

NOTE: 

• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 79.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.
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10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

11 If you do not share your printer, select Do not share this printer.

If you share your printer, select Share this printer so that others on your network can find and use it.

12 Click Next.

13 To use this printer as the default printer, select the Set as the default printer check box.

14 As the driver installation is completed, click Print a test page to print a test page.

15 Click Finish.

 Network Connection Setup
NOTE: 

• To use this printer in a Linux environment, you need to install a Linux driver. For more information on how to install and use 
these, see also "Installing Print Driver on Computers Running Linux (CUPS)" on page 97.

• For Installing PCL 6 Driver

1 On the top screen of Easy Install Navi, click Installing Driver and Software.

2 Click Print Driver. 

3 Select Standard or Custom setup.

4 Follow the on-screen instructions to install the print driver.

• For Installing PS Driver
For information on how to install the PS driver, refer to the PostScript User Guide.
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• For Installing XML Paper Specification (XPS) Print Driver

NOTE: 

• XML Paper Specification (XPS) driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit 
Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, and Windows 7 
64-bit Edition.

Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select printer or click The printer that I want isn't listed.

When you select your printer, go to step 7.

When you click The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.

If the User Account Control dialog box appears, click Continue.

NOTE: 

• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 
action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 79.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box.

13 Click Next.

Installation starts.

14 As the driver installation is completed, click Print a test page to print a test page.

15 Click Finish.
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Windows Server 2008 and Windows Server 2008 64-bit Edition

NOTE: 

• You must log in as an administrator.

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select printer or click The printer that I want isn't listed.

When you select your printer, go to step 7.

When you click The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.

If the User Account Control dialog box appears, click Continue.

NOTE: 

• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 
action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 79.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box.

13 Click Next.

Installation starts.

14 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this 
printer so that others on your network can find and use it.

15 Click Next.

16 As the driver installation is completed, click Print a test page to print a test page.

17 Click Finish.
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Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select printer or click The printer that I want isn't listed.

NOTE: 

• When you click The printer that I want isn't listed, Find a printer by name or TCP/IP address screen appears. Find 
your printer on the screen.

If the User Account Control dialog box appears, click Continue.

NOTE: 

• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 
action.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 79.

7 Click Open.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this 
printer so that others on your network can find and use it.

12 Click Next.

13 To use this printer as the default printer, select the Set as the default printer check box.

14 As the driver installation is completed, click Print a test page to print a test page.

15 Click Finish.
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Windows 7 and Windows 7 64-bit Edition

1 Click Start → Devices and Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select printer or click The printer that I want isn't listed.

When you select your printer, go to step 7.

When you click The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.

If the User Account Control dialog box appears, click Yes.

NOTE: 

• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "For Installing XML Paper 
Specification (XPS) Print Driver" on page 79.

9 Click Open.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

13 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this 
printer so that others on your network can find and use it.

14 Click Next.

15 To use this printer as the default printer, select the Set as the default printer check box.

16 As the driver installation is completed, click Print a test page to print a test page.

17 Click Finish.

Use CentreWare Internet Services to monitor the status of your network printer without leaving your desk. You can 
view and/or change the printer settings, monitor toner level, and acknowledge the timing of ordering replacement 
consumables. You can click our web site link for ordering supplies.

NOTE: 

• CentreWare Internet Services is not available when the printer is directly connected to a computer or a print server.

To launch CentreWare Internet Services, type the printer's IP address in your web browser. The printer configuration 
appears on the screen.
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 Setting Up for Shared Printing
You can share your new printer on the network using the Driver CD Kit that comes with your printer, or using 
Microsoft peer-to-peer method. However, if you use the Microsoft method, some features, such as the 
SimpleMonitor and other printer utilities, installed with the Driver CD Kit, may not be available.

If you want to use the printer on a network, share the printer and install its drivers on all the computers on the 
network.

• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, 
and Windows Server 2003 64-bit Edition

1 Click Start (start for Windows XP) → Printers and Faxes.

2 Right-click the printer icon and select Properties.

3 On the Sharing tab, select the Share this printer radio button, and then enter a name in Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

5 Click OK.

If you are missing files, you are prompted to insert the server operating system CD.

6 Click Apply, and then click OK.

• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Right-click the printer icon and select Sharing.

3 Click Change sharing options.

The message Windows needs your permission to continue appears.

4 Click Continue.

5 Select the Share this printer check box, and then enter a name in Share name.

6 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

7 Click OK.

8 Click Apply, and then click OK.

• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Printers.

2 Right-click the printer icon and select Sharing.

3 Select the Share this printer check box, and then enter a name in Share name.

4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

5 Click OK.

6 Click Apply, and then click OK.
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• For Windows 7, Windows 7 64-bit Edition, and 
Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, select the Share this printer check box, and then enter a name in Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

5 Click OK.

6 Click Apply, and then click OK.

To confirm that the printer is properly shared:

• Ensure that the printer object in the Printers, Printers and Faxes or Devices and Printers folder is shared. 
The shared icon is shown under the printer icon.

• Browse Network or My Network Places. Find the host name of the server and the shared name you assigned 
to the printer.

Now that the printer is shared, you can install the printer on network clients using the peer-to-peer method.
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 Point and Print
Point and Print is a Microsoft Windows technology that allows you to connect to a remote printer. This feature 
automatically downloads and installs the print driver.

• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, 
and Windows Server 2003 64-bit Edition

1 On the Windows desktop of the client computer, double-click My Network Places.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Printers and Faxes folder. The copy time varies, based on network traffic and 
other factors.

4 Close My Network Places.

5 Print a test page to verify installation.

a Click start (Start for Windows Server 2003 and Windows Server 2003 64-bit Edition) → Printers and 
Faxes.

b Select the printer you just created.

c Click File → Properties.

d On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.
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• For Windows Vista and Windows Vista 64-bit Edition

1 On the Windows desktop of the client computer, click Start → Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Click Continue in the User Account Control dialog box.

6 Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Printers folder. The time this takes varies, based on network traffic and other 
factors.

7 Print a test page to verify installation.

a Click Start → Control Panel → Hardware and Sound.

b Select Printers.

c Right-click the printer you just created and click Properties.

d On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.

• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 On the Windows desktop of the client computer, click Start → Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Printers folder. The time this takes varies, based on network traffic and other 
factors.

6 Print a test page to verify installation.

a Click Start → Control Panel.

b Select Printers.

c Right-click the printer you just created and select Properties.

d On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.
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• For Windows 7, Windows 7 64-bit Edition, and Windows 
Server 2008 R2

1 On the Windows desktop of the client computer, click Start → your user name → Network (Start → Network 
for Windows Server 2008 R2).

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait for the driver information to be copied from the server computer to the client computer, and for a new 
printer object to be added to the Devices and Printers folder. The time this takes varies, based on network 
traffic and other factors.

6 Print a test page to verify installation.

a Click Start → Devices and Printers.

b Right-click the printer you just created and select Printer properties.

c On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.
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 Peer-to-Peer
If you use the peer-to-peer method, the print driver is fully installed on each client computer. Network clients retain 
control of driver modifications. The client computer handles the print job processing.

• For Windows XP, Windows XP 64-bit Edition, Windows Server 2003, 
and Windows Server 2003 64-bit Edition

1 Click start (Start for Windows Server 2003 / Windows Server 2003 64-bit Edition) → Printers and Faxes.

2 Click Add a printer (Add Printer for Windows Server 2003 / Windows Server 2003 64-bit Edition) to launch 
the Add Printer Wizard.

3 Click Next.

4 Select A network printer, or a printer attached to another computer, and then click Next.

If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Connect to this printer (or to browse for a printer, select this option and click Next).

b Enter the path of the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it on the network. 

The shared printer name is the name assigned during the server installation process.

5 Click Browse for a printer, and then click Next.

6 Select the printer, and then click Next.

If this is a new printer, you may be prompted to install a print driver. 

If no system driver is available, you need to specify the path to available drivers.

7 Specify the following settings if you want, and then click Next.

If you want to verify installation, click Yes to print a test page.

• Click Yes to set this printer as the default printer.

• Click Yes to print a test page for verifying installation.

8 Click Finish.

When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start → Control Panel → Hardware and Sound → Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next.

If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.

b Enter the path of the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it on the network. 

The shared printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, you need to 
specify the path to available drivers.

4 Specify the following settings if you want, and then click Next.

• Click Yes to set this printer as the default printer.

• Click Print a test page to print a test page for verifying installation.

5 Click Finish.

When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start → Control Panel → Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next.

If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.

b Enter the path of the printer in the text box, and then click Next.

For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it on the network. The shared 
printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, you will 
need to provide a path to available drivers.

4 Specify the following settings if you want, and then click Next.

• Click Yes to set this printer as the default printer.

• Click Print a test page to print a test page for verifying installation.

5 Click Finish.

When a test page prints successfully, installation is complete.
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• For Windows 7, Windows 7 64-bit Edition, and 
Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer.

If the printer is listed, select the printer and click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name

b Enter the path of the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it to the network. The shared printer 
name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, you will 
need to provide the path to the available driver.

4 Confirm the printer name, and then click Next.

5 Specify the following settings if you want, and then click Finish.

• Click Set as the default printer to set this printer as the default printer.

• Click Print a test page to print a test page for verifying installation.

When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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Installing Print Driver on Computers Running 
Mac OS X
For information on how to install the print driver, refer to the PostScript User Guide.
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Installing Print Driver on Computers Running Linux 
(CUPS)
This section provides information for installing or setting up the print driver with CUPS (Common UNIX Printing 
System) on Red Hat® Enterprise Linux® 5/6 Desktop (x86) or SUSE® Linux Enterprise Desktop 10/11 (x86).

NOTE: 

• When using a CD drive in a Linux environment, you need to mount the CD according to your system environment. The 
command strings are mount/media/CD-ROM.

This section includes:

• "Installing the Print Driver" on page 97

• "Setting Up the Queue" on page 98

• "Setting the Default Queue" on page 99

• "Specifying the Printing Options" on page 100

• "Setting the Password for Authority as the Printer Administrator" on page 101

• "Uninstalling the Print Driver" on page 101

 Installing the Print Driver
This section includes:

• "For Red Hat Enterprise Linux 5/6 Desktop(x86)" on page 97

• "For SUSE Linux Enterprise Desktop 10/11 (x86)" on page 97

NOTE: 

• The print driver Fuji_Xerox-DocuPrint_P455-x.x-x.noarch.rpm is included in the linux folder in the Eng folder on the Driver 
CD Kit.

• For Red Hat Enterprise Linux 5/6 Desktop(x86)
The following procedure uses Red Hat Enterprise Linux 6 Desktop(x86) as an example:

1 Copy the .rpm file from \Eng\linux folder on the Driver CD Kit to your desired location.

2 Double-click the .rpm file.

3 Click Install.

4 Enter the administrator password, and click Authenticate.

Installation starts. When the installation is complete, the window is automatically closed.

• For SUSE Linux Enterprise Desktop 10/11 (x86)
The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Copy the .rpm file from \Eng\linux folder on the Driver CD Kit to your desired location.

2 Double-click the .rpm file.

3 Click Install.

4 Enter the administrator password, and click Authenticate.

Installation starts. When the installation is complete, the window is automatically closed.
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 Setting Up the Queue
To execute printing, you must set up the print queue on your workstation.

NOTE: 

• When you have finished setting up the queue, you can print jobs from the applications. Start the print job from the application, 
and specify the queue in the print dialog box. 
However, you may be able to print only from the default queue depending on the application. In these cases, before you start 
printing, set queue you want to print to as the default queue. For information on specifying the default queue, see also "Setting 
the Default Queue" on page 99.

• For Red Hat Enterprise Linux 5/6 Desktop (x86)
The following procedure uses Red Hat Enterprise Linux 6 Desktop(x86) as an example:

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Add Printer.

4 Enter root as the user name, and then enter the administrator password.

5 Click OK.

6 Select either of the following according to the type of your printer connection.

For network connections:

a Select LPD/LPR Host or Printer from the Other Network Printers menu, and then click Continue.

b Enter the IP address of the printer in Connection. 

Format: lpd://xxx.xxx.xxx.xxx (the IP address of the printer)

c Click Continue.

d Enter the name of the printer in Name in the Add Printer window, and then click Continue.

You can optionally specify the location and description of the printer for further information.

If you want to share the printer, select the Share This Printer check box.

For USB connections:

a Select FUJI XEROX DocuPrint XXX from the Local Printers menu, and then click Continue.

b Enter the name of the printer in Name in the Add Printer window, and then click Continue.

You can optionally specify the location and description of the printer for further information.

If you want to share the printer, select the Share This Printer check box.

7 Select FX from the Make menu, and then click Continue.

8 Select FX DocuPrint XXX from the Model menu, and then click Add Printer.

The setup is complete.

You can optionally specify the default options settings of the printer.

• For SUSE Linux Enterprise Desktop 10/11 (x86)
The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Select Computer → More Applications..., and select YaST on Application Browser.

2 Enter the administrator password.

YaST Control Center is activated.
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3 Select Hardware on YaST Control Center, and select Printer.

The Printer Configurations dialog box opens.

For network connections:

a Click Add.

The Add New Printer Configuration dialog box opens.

b Click Connection Wizard.

The Connection Wizard dialog box opens.

c Select Line Printer Daemon (LPD) Protocol from Access Network Printer or Printserver Box via.

d Enter the IP address of the printer in IP Address or Host Name:.

e Select Fuji Xerox in Select the printer manufacturer:.

f Click OK.

The Add New Printer Configuration dialog box appears.

g Select DocuPrint XXX vx.x [FujiXerox/Fuji_Xerox_DocuPrint_XXX.ppd.gz] from the Assign Driver list.

NOTE: 

• You can specify the printer name in Set Name:.

For USB connections:

a Click Add.

The Add New Printer Configuration dialog box opens.

The printer name is displayed in the Determine Connection list.

b Select DocuPrint XXX vx.x. [FujiXerox/Fuji_Xerox_DocuPrint.ppd.gz] from the Assign Driver list.

NOTE: 

• You can specify the printer name in Set Name:.

4 Confirm the settings, and then click OK.

 Setting the Default Queue

• For Red Hat Enterprise Linux 5/6 Desktop (x86)
The following procedure uses Red Hat Enterprise Linux 6 Desktop(x86) as an example:

1 Select Applications → System Tools → Terminal.

2 Enter the following command in the terminal window.

• For SUSE Linux Enterprise Desktop 10/11 (x86)
The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Select Computer → More Applications..., and select YaST on Application Browser.

2 Enter the administrator password.

YaST Control Center is activated.

3 Select Hardware on YaST Control Center, and select Printer.

The Printer Configurations dialog box opens.

su

(Enter the administrator password)

lpadmin -d (Enter the queue name)
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4 Click Edit.

A dialog box to modify the specified queue opens.

5 Confirm that the printer you want to set is selected in the Connection list.

6 Select the Default Printer check box.

7 Confirm the settings, and click OK.

 Specifying the Printing Options
You can specify the printing options such as the 2-sided printing.

• For Red Hat Enterprise Linux 5/6 Desktop (x86)
The following procedure uses Red Hat Enterprise Linux 6 Desktop(x86) as an example:

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Manage Printers.

4 Click the queue name for which you want to specify the printing options.

5 Enter root as the user name, and enter the administrator password.

6 Click the Administration drop-down list box, and then select Modify Printer.

7 Specify the required settings, and click Continue or Modify Printer.

The message Printer xxx has been modified successfully. appears.

The setting is complete. 

• For SUSE Linux Enterprise Desktop 10/11 (x86)
The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Open a web browser.

2 Enter http://localhost:631/admin in the address bar, and press the Enter key.

3 Enter root as the user name, and enter the administrator password.

The CUPS window appears.

NOTE: 

• Set the password for authority as the printer administrator before setting the printer queue. If you have not set it, go to 
"Setting the Password for Authority as the Printer Administrator" on page 101.

4 Click Manage Printers.

5 Click Modify Printer on the printer.

6 Specify the required settings, and click Continue.

7 Enter root as the user name, enter administrator password and click OK.

The message Printer xxx has been modified successfully. appears.

The setting is complete. Execute printing from the application.
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 Setting the Password for Authority as the Printer 
Administrator

For SUSE Linux Enterprise Desktop 10 and 11, you must set the password for authority as the printer administrator 
to do operations as the printer administrator.

• For SUSE Linux Enterprise Desktop 10/11 (x86)
The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Select Computer → More Applications... and select GNOME Terminal on Application Browser.

2 Enter the following command in the terminal window.

 Uninstalling the Print Driver

• For Red Hat Enterprise Linux 5/6 Desktop (x86)
The following procedure uses Red Hat Enterprise Linux 6 Desktop (x86) as an example:

1 Select Applications → System Tools → Terminal.

2 Enter the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Enter the following command in the terminal window.

The print driver is uninstalled.

su

(Enter the administrator password)

lppasswd -g sys -a root

(Enter the password for authority as the printer 
administrator after the Enter password prompt.)

(Reenter the password for authority as the printer 
administrator after the Enter password again prompt.)

su

(Enter the administrator password)

/usr/sbin/lpadmin -x (Enter the print queue name)

rpm -e Fuji_Xerox-DocuPrint_P455-x.x-x.noarch
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• For SUSE Linux Enterprise Desktop 10/11 (x86)
The following procedure uses SUSE Linux Enterprise Desktop 11 (x86) as an example:

1 Select Computer → More Applications... and select GNOME Terminal on Application Browser.

2 Enter the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Enter the following command in the terminal window.

The print driver is uninstalled.

su

(Enter the administrator password)

/usr/sbin/lpadmin -x (Enter the print queue name)

rpm -e Fuji_Xerox-DocuPrint_P455-x.x-x
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Configuring Wireless Settings (Windows & Mac OS X)
This section includes:

• "Determining the Wireless Network Settings" on page 103

• "Configuring the Optional Wireless Printer Adapter" on page 104

• "Reconfiguring the Wireless Settings" on page 113

Determining the Wireless Network Settings
You need to know the settings for the wireless network to set up the wireless printer. For details of the settings, 
contact your network administrator.

Wireless Settings SSID Specifies the name that identifies the wireless network with up to 32 
alphanumeric characters.

Network Mode Specifies the network mode from Ad-hoc or Infrastructure.

Security Settings Security Selects the encryption method from No Security, Mixed mode PSK*, 
WPA-PSK-TKIP, WPA-PSK-AES, WPA2-PSK-AES, and WEP.

Transmit Key Specifies the transmit WEP key from the list.

WEP Key Specifies the WEP key used through the wireless network only when 
WEP is selected as the encryption method.

Pass Phrase Specifies the pass phrase of alphanumeric characters from 8 to 63 
bytes long only when Mixed mode PSK*1, WPA-PSK-TKIP, or 
WPA2-PSK-AES is selected as the encryption method.

*: Mixed mode PSK automatically selects an available encryption method from WPA-PSK-TKIP, WPA-PSK-AES, or 
WPA2-PSK-AES.
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Configuring the Optional Wireless Printer Adapter
This section describes how to configure a wireless printer adapter through Easy Install Navi, operator panel and 
CentreWare Internet Services.

You can select a method to configure a wireless printer adapter from the following:

IMPORTANT: 

• Ensure that the Ethernet cable has been disconnected from the printer before you configure the wireless settings other than 
through Ethernet cable and CentreWare Internet Services.

NOTE: 

• Before you configure the wireless settings on the operator panel, you need to set up the wireless network settings on your 
computer. For details, refer to the manuals provided with the wireless LAN access point or if your computer provides a 
wireless adapter tool, configure the wireless settings using that tool.

• If the Panel Lock Set is set to Enable, you need to enter the four digit password to enter the Admin Menu menu.

Wizard Setup through
(Windows Only)

USB cable (recommended)

WPS-PBC*1

WPS-PIN*2

Operator Panel

Ethernet Cable

CentreWare Internet Services

Non-Wizard Setup through WPS-PBC*1

WPS-PIN*2

Operator Panel

CentreWare Internet Services

*1 WPS-PBC (Wi-Fi® Protected Setup-Push Button Configuration) is a method to authenticate and register devices 
required for wireless configuration, by pressing the button provided on the access point via wireless routers, and 
then performing WPS-PBC setting on the operator panel. This setting is available only when the access point 
supports WPS.

*2 WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register 
devices required for wireless configuration, by entering PIN assignments in the printer and computer. This setting, 
performed through access point, is available only when the access points of your wireless router supports WPS.
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• Using Wizard Setup to Configure a Wireless Printer Adapter (Windows 
Only)

You can configure the wireless printer adapter with the following connection methods:

• USB cable

• WPS-PBC

• WPS-PIN

• Operator Panel

• Ethernet Cable

• CentreWare Internet Services

The following procedure uses USB cable for connection method as an example.

1 Insert the Driver CD Kit provided with the printer in your computer. Easy Install Navi launches automatically.

2 Click Optional Accessories Setup.
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3 Click Wireless Network Kit b/g/n.

4 Click Start wireless settings.
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5 Click Wireless Configuration.

6 Select Wizard, and then click Next.
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7 Click Connect the wireless printer adapter.

The instruction video starts.

Follow the on-screen instructions to configure wireless settings.

• Using Non-Wizard Setup to Configure a Wireless Printer Adapter
For Mac OS X, you can configure a wireless settings only through non-wizard setup.

NOTE: 

• The optional wireless printer adapter must be installed on the printer. For details about installing a wireless printer adapter, 
see "Installing the Optional Wireless Printer Adapter" on page 48.

You can configure the wireless printer adapter with the following connection methods:

• WPS-PBC

• WPS-PIN

• Operator Panel

• CentreWare Internet Services
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WPS-PBC
You can start Push Button Control only from the operator panel.

NOTE: 

• WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register devices required for 
wireless configuration by pressing the button provided on the access point via wireless routers, and then performing 
WPS-PBC setting on the operator panel. This setting is available only when the access point supports WPS.

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Network Setup, and then press the  button.

4 Select WPS Setup, and then press the  button.

5 Select Push Btn. Ctrl, and then press the  button.

6 Select Start, and then press the  button.

7 Ensure that the message Please wait Wireless Setting is displayed, and start pressing the button on 
the wireless LAN access point, within two minutes of the step 6 operation.

NOTE: 

• For details about WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless LAN 
access point.

When the WPS operation is successful and the printer is rebooted, wireless settings are correctly configured.

WPS-PIN
The PIN code of WPS-PIN can only be configured from the operator panel.

NOTE: 

• WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register devices required 
for wireless configuration by entering PIN assignments to a printer and computer. This setting, performed through an access 
point, is available only when the access points of your wireless router supports WPS.

• Before WPS-PIN starts, you will need to enter your PIN code at the web page of the wireless LAN access point. For details, 
refer to the manuals provided with the wireless LAN access point.

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Network Setup, and then press the  button.

4 Select WPS Setup, and then press the  button.

5 Select PIN Code, and then press the  button.

6 Write down the displayed 8-digit PIN code or select Print PIN Code, and then press the  button. The PIN 
code is printed.

7 Select Start Config., and then press the  button.

8 Ensure that the message Please wait Wireless Setting is displayed, and enter the PIN code displayed 
on step 6 into the web page of the wireless LAN access point.

NOTE: 

• For details about WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless LAN 
access point.

When the WPS operation is successful and the printer is rebooted, wireless settings are correctly configured.
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Operator Panel
Auto SSID Setup

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Network Setup, and then press the  button.

4 Select Wireless Setup, and then press the  button.

The printer automatically searches the access points on wireless network.

5 Select the desired access point, and then press the  button.

If the desired access point does not appear, go to "Manual SSID Setup" on page 110.

NOTE: 

• Some hidden SSID may not be displayed. If the SSID is not detected, turn on SSID broadcast from the router.

6 Enter the WEP key or pass phrase, and then press the  button.

The Restart Printer to apply setting message appears.

7 Turn off the printer, and turn it on again to apply the settings.

Wireless settings are correctly configured.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

Manual SSID Setup

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Network Setup, and then press the  button.

4 Select Wireless Setup, and then press the  button.

5 Select Manual Setup, and then press the  button.

6 Enter the SSID, and then press the  button.

7 Select the network mode from Infrastructure or Ad-hoc depending on your environment, and then press 
the  button.

When you select Infrastructure, proceed to step 8.

When you select Ad-hoc, proceed to step 9.

8 Select the encryption method from Mixed mode PSK, WPA-PSK-TKIP, WPA2-PSK-AES, or WEP, and then 
press the  button.

IMPORTANT: 

• Be sure to use one of the supported encryption methods to protect your network traffic.

To use Mixed mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES encryption:

a Select the desired encryption method.

b Enter the pass phrase, and then press the  button.

The Restart Printer to apply setting message appears.

To use WEP encryption:

a Select WEP for the encryption method, and then press the  button.
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b Enter the WEP key, and then press the  button.

c Select the desired transmit key from Auto or WEP Key 1 to WEP Key 4, and then press the  button.

The Restart Printer to apply setting message appears.

Proceed to step 12.

9 Select WEP for the encryption method, and then press the  button.

IMPORTANT: 

• Be sure to use one of the supported encryption methods to protect your network traffic.

10 Enter the WEP key, and then press the  button.

11 Select the desired transmit key from WEP Key 1 to WEP Key 4, and then press the  button.

The Restart Printer to apply setting message appears.

12 Turn off the printer, and turn it on again to apply the settings.

Wireless settings are correctly configured.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.
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CentreWare Internet Services

1 Ensure that the printer is turned off and the wireless printer adapter is connected to the printer.

2 Connect the printer to the network with an Ethernet cable.

For details about connecting the Ethernet cable, see "Connecting Printer to Computer or Network" on page 72.

3 Turn on the printer.

4 Launch the CentreWare Internet Services by entering the IP address of the printer in your web browser.

5 Click the Properties tab.

6 Click Wireless.

7 Enter the SSID in the SSID text box.

8 Select Ad hoc or Infrastructure in the Network Type drop-down menu.

9 Select the encryption method from WEP 128-bit HEX (26 Bytes), WEP 128-bit ASCII (13 Bytes), WEP 64-bit 
HEX (10 Bytes), WEP 64-bit ASCII (5 Bytes), WPA-PSK AES/WPA2-PSK AES, WPA-PSK TKIP, and Mixed 
Mode PSK in the Encryption drop-down menu, and then set each item for the encryption method selected.

IMPORTANT: 

• Be sure to use one of the supported encryption methods to protect your network traffic.

NOTE: 

• For details on each item, see the Help on CentreWare Internet Services.

10 Click Apply to apply the settings.

11 Turn off the printer, disconnect the Ethernet cable and turn it on again.

Wireless LAN connection setting is complete.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.
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Reconfiguring the Wireless Settings
To change the wireless setting through the wireless connection from your computer, perform the following.

NOTE: 

• Ensure that the wireless connection setting is completed in "Configuring the Optional Wireless Printer Adapter" on page 104.

• The following settings are available when the network mode is set to infrastructure in "Configuring the Optional Wireless 
Printer Adapter" on page 104.

1 Check the IP address of the printer.

a On the operator panel, press the  (Menu) button.

b Select Report / List, and then press the  button.

c Select Printer Settings, and then press the  button.

The Printer Settings page is printed.

d Confirm the IP address next to IP Address under Network (Wireless) on the Printer Settings page.

2 Launch the CentreWare Internet Services by entering the IP address of the printer in your web browser.

3 Click the Properties tab.

4 Click Wireless.

5 Change the wireless settings of the printer.

6 Click Apply to apply the settings.

7 Reboot the printer.

8 Change the wireless settings on your computer or access point accordingly.

NOTE: 

• To change the wireless settings on your computer, refer to the manuals provided with the wireless LAN access point or if your 
computer provides a wireless adapter tool, change the wireless settings using that tool.
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5
Printing Basics

This chapter includes:

• "About Print Media" on page 116

• "Supported Print Media" on page 118

• "Loading Print Media" on page 122

• "Setting Paper Sizes and Types" on page 131

• "Printing" on page 132

• "Printing With Web Services on Devices (WSD)" on page 150

• "Using Digital Certificates" on page 152
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About Print Media
This section includes:

• "Print Media Usage Guidelines" on page 116

• "Print Media That Can Damage Your Printer" on page 117

• "Print Media Storage Guidelines" on page 117

Using paper that is not appropriate for the printer can cause paper jams, image quality problems, or printer failure. 
To achieve the best performance from your printer, we recommend you to use only the paper described in this 
section.

When using paper other than that recommended, contact the Fuji Xerox local representative office or an authorised 
dealer.

 Print Media Usage Guidelines
The printer tray accommodates various sizes and types of paper and other specialty media. Follow these guidelines 
when loading paper and media in the tray:

• Envelopes can be printed from the bypass tray.

• Fan paper or other specialty media before loading in the paper tray.

• Do not print on label stock once a label has been removed from a sheet.

• Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with release strips.

• Print all envelopes single-sided only. 

• Some wrinkling and embossing may occur when printing envelopes.

• Do not overload the paper tray. Do not load print media above the fill line on the inside of the width guides.

• Adjust the width guides to fit the paper size.

• If excessive jams or wrinkles occur, use paper or other media from a new package.

See also: 
• "Loading Print Media in the Standard 550 Sheet Tray and the Optional 550 Sheet Feeder" on page 123

• "Loading Print Media in the Bypass Tray" on page 126

• "Loading Envelope in the Bypass Tray" on page 129

• "Printing on Custom Size Paper" on page 146

WARNING:

• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. When paper jam 
occurs, it may cause short-circuit and eventually a fire accident.
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 Print Media That Can Damage Your Printer
The following paper types are not recommended for use with the printer:

• Chemically treated paper used to make copies without carbon paper, also known as carbonless paper, 
carbonless copy paper (CCP), or no carbon required (NCR) paper.

• Preprinted paper with chemicals that may contaminate the printer.

• Preprinted paper that can be affected by the temperature in the fusing unit.

• Preprinted paper that requires a registration (the precise print location on the page) greater than ±0.09 inches, 
such as optical character recognition (OCR) forms.
In some cases, you can adjust registration with your software program to successfully print on these forms.

• Coated paper (erasable bond), synthetic paper, thermal paper, and short grain paper.

• Rough-edged, rough or heavily textured surface paper, or curled paper.

• Recycled paper containing more than 25% post-consumer waste that does not meet DIN 19 309.

• Multiple-part forms or documents.

• Print quality may deteriorate (blank spaces or blotches may appear in the text) when you print on talc or acid 
paper.

 Print Media Storage Guidelines
For proper print media storage, the following guidelines will help to avoid media feeding problems and uneven print 
quality.

• Store print media in an environment where the temperature is approximately 70 °F/21 °C and the relative 
humidity is 40%.

• Store print media in dark, cool, relatively dry locations. Most paper items are susceptible to damage from 
ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and fluorescent bulbs, is particularly 
damaging to paper items. The intensity and length of exposure to visible light on paper items should be 
reduced as much as possible.

• Maintain constant temperatures and relative humidity.

• Avoid attics, kitchens, garages, and basements for storing print media. 

• Store print media flat. Print media should be stored on pallets, cartons, shelves, or in cabinets.

• Avoid having food or drinks in the area where print media is stored or handled.

• Do not open sealed packages of paper until you are ready to load them into the printer. Leave paper in the 
original packaging. For most commercial cut-size grades, the ream wrapper contains an inner lining that 
protects the paper from moisture loss or gain.

• Leave the media inside the bag until you are ready to use it; reinsert unused media in the bag and reseal it for 
protection. Some specialty media is packaged inside resealable plastic bags.

• Do not place anything on top of the print media packages.

WARNING:

• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. When paper jam 
occurs, it may cause short-circuit and eventually a fire accident.
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Supported Print Media
Using unsuitable print media may lead to paper jams, poor print quality, breakdown and damage to your printer. To 
use the features of this printer effectively, use the suggested print media that is recommended here.

IMPORTANT: 

• The toner may come off the print media, if it gets wet by water, rain, steam and so on. For details, contact the Fuji Xerox local 
representative office or an authorised dealer.

 Usable Print Media
The types of print media that can be used on this printer are as follows:

Bypass Tray

*:XML Paper Specification (XPS) driver does not support custom size paper.

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Executive SEF (7.25 × 10.5 inches)

Folio SEF (8.5 × 13 inches)

Legal SEF (8.5 × 14 inches)

Com 10 Envelope SEF (4.125 × 9.5 inches)

Monarch Envelope SEF (3.875 × 7.5 inches)

DL Envelope SEF (110 × 220 mm)

C5 Envelope SEF (162 × 229 mm)

Custom size*:

Width: 76.2–215.9 mm (3–8.5 inches)

Length: 127–355.6 mm (5 –14 inches)

Custom size (duplex print)*:

Width: 139.7–215.9 mm (5.5–8.5 inches)

Length: 210–355.6 mm (8.27–14 inches)

Paper Type Plain Thick

Plain

Lightweight Cardstock

Heavyweight Cardstock

Hole Punched

Labels

Envelope

Letterhead

Colored

Other Type

Loading Capacity 150 sheets of standard paper
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Standard 550 Sheet Tray / Optional 550 Sheet Feeder

*:XML Paper Specification (XPS) driver does not support custom size paper.

NOTE: 

• SEF and LEF indicate the paper feed direction; SEF stands for short-edge feed. LEF stands for long-edge feed.

• For Plain paper, you can set the paper density by selecting Adjust PaperType (Lightweight or Heavyweight) 
under Maintenance Mode from the operator panel. Once you set the Adjust PaperType settings, the printer uses 
the settings for Plain paper.

See also: 
• "Loading Print Media in the Standard 550 Sheet Tray and the Optional 550 Sheet Feeder" on page 123

• "Loading Letterhead in the Standard 550 Sheet Tray and the Optional 550 Sheet Feeder" on page 125

• "Loading Print Media in the Bypass Tray" on page 126

• "Loading Small Print Media in the Bypass Tray" on page 127

• "Loading Envelope in the Bypass Tray" on page 129

• "Loading Letterhead in the Bypass Tray" on page 130

Printing on print media that differs from the paper size or paper type selected on the print driver, or loading print 
media into an unsuitable paper tray for printing, may lead to paper jams. To ensure that printing is correctly done, 
select the correct paper size, paper type, and paper tray.

Paper Size A4 SEF (210 × 297 mm)

B5 SEF (182 × 257 mm)

A5 SEF (148 × 210 mm)

Letter SEF (8.5 × 11 inches)

Executive SEF (7.25 × 10.5 inches)

Folio SEF (8.5 × 13 inches)

Legal SEF (8.5 × 14 inches)

Custom size*:

Width: 139.7–215.9 mm (5.5–8.5 inches)

Length: 210–355.6 mm (8.27–14 inches)

Paper Type Plain Thick

Plain

Lightweight Cardstock

Heavyweight Cardstock

Hole Punched

Labels

Letterhead

Colored

Other Type

Loading Capacity 550 sheets of standard paper
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 Standard Paper and Tested Paper
The following paper and media are standard or usable for the printer.

When you print a generally used paper (which called general paper), please use a paper that suits the standard. To 
print clearly, Fuji Xerox recommends the standard paper shown in the following table. For information about the 
other paper and media, contact Fuji Xerox Customer Support Center.

Paper Name Size Weight Paper Type Notes

Standard 
Paper

Fuji Xerox P A4 64 gsm Plain Medium-thickness paper 
for in-house documents 
and general office use.

Xerox Premier 80 A4 80 gsm Plain Paper for general office 
use with minimum 
see-through.

XeroxBusiness4200 Letter 20 lb Plain

Supported 
Paper

XeroxBusiness4200 Legal 20 lb Plain

Boise X-9 Letter Plain

Hammermill Tidal MP Letter Plain

Cascade X-9000 Folio Plain

Cascade X-9000 Statement Plain

Xerox Color Xpressions 
Select

Legal 24 lb Plain Thick

XeroxBusiness4200 Letter Plain Thick

Hammermill Writing 
Bond

Letter Plain Thick

Hammermill Laser Print Letter Plain Thick

GP Laser1000 Executive Plain Thick

Xerox Color Xpressions 
Elite

Letter 28 lb Plain Thick

XeroxBusiness4200 Letter Plain Thick

Fuji Xerox P B5 64 gsm Plain Medium-thickness paper 
for in-house documents 
and general office use.

Fuji Xerox FR A4 64 gsm Plain Environmentally-consciou
s paper (50% of pulp 
sourced from 
plantation-grown trees + 
50% of recycled pulp).

Fuji Xerox G70 A4 67 gsm Plain Recycled copy/printer 
paper compounded 70% 
of recycled pulp.

Fuji Xerox GR100 Plain

V-Paper Plain

V-Paper MG Plain

SG Plain

Fuji Xerox C2 A4 70 gsm Plain

Fuji Xerox C2r Plain 70% recycled pulp paper.

Performer Plain

Express Plain

Business+ Plain

Fuji Xerox C2r B5 Plain

Fuji Xerox C2 A5 Plain
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Supported 
Paper

Performer+ A4 75 gsm Plain

A-paper Plain

A-paper Letter Plain

A-paper B5 Plain

Xerox Business 80 A4 80 gsm Plain

Business Plain

Business+ Plain

Data copy Plain

Steinbeis Recycling 
Copy

Plain

Yes Bronze Plain

Laserprint Plain

Performer Plain

Quality Plain

Performer+ Plain

H-paper Plain

H-paper B5 Plain

Xerox Premier 80 A5 Plain

Fuji Xerox J A4 82 gsm Plain Thick Hi-quality paper suitable 
for a variety of uses, 
including project 
proposals and color 
samples.

Fuji Xerox J B5 Plain Thick

Xerox Premier 90 A4 90 gsm Plain Thick

Xerox-90 Colotech A4 Plain Thick

Fuji Xerox JD A4 98 gsm Plain Thick Double-sided paper 
suitable for a variety of 
uses, including brochures 
and booklet.

Fuji Xerox JD B5 Plain Thick

Special 
Paper

(Label) A4 Label Labels

Labels(24/Page) A4 Labels

Labels A4 Labels

(Label) A4 Labels

Avery Labels 5165 Letter Labels

Colombia Brand Com-10 Envelope Envelope

PrintMaster White

Wove 24#

#Monarch

Monarch 
(98.4 × 
190.5)

Envelope

River Series DL (110 × 
220)

Envelope

River Series C5 (162 × 
229)

Envelope

Colotech+ A4 90 gsm Plain Thick

Colotech+ (Mondi) A4 100 gsm Plain Thick

Colotech+ Plain Thick

Colotech+ (Mondi) A4 120 gsm Light Card

Colotech+ Light Card

Colotech+ (Mondi) A4 160 gsm Light Card

Special 
Paper

Color Copy200 A4 200 gsm Heavy Card

Xerox Color Xpressions 
Planet 20 80lb

Letter 216 gsm Heavy Card

Paper Name Size Weight Paper Type Notes
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Loading Print Media
Loading print media properly helps prevent jams and ensures trouble-free printing.

Before loading any print media, identify the recommended print side of the print media. This information is usually 
indicated on the print media package.

 Capacity
The standard 550 sheet tray and the optional 550 sheet feeder can hold:

• 550 sheets of the standard paper.

The bypass tray can hold:

• 150 sheets of the standard paper.

For special paper, there is a limitation of the following.

• From the bottom of the tray, up to 20 mm height (standard 550 sheet tray)

• From the bottom of the tray, up to 10 mm height (bypass tray)

 Print Media Dimensions
The maximum dimensions of print media that the standard 550 sheet tray and the optional 550 sheet feeder can 
handle are:

• Width: 139.7 mm (5.5 inches) to 215.9 mm (8.5 inches)

• Length: 210 mm (8.27 inches) to 355.6 mm (14 inches)

The maximum dimensions of print media that the bypass tray can handle are:

• Width: 76.2 mm (3 inches) to 215.9 mm (8.5 inches)

• Length: 127 mm (5 inches) to 355.6 mm (14 inches)
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 Loading Print Media in the Standard 550 Sheet Tray and 
the Optional 550 Sheet Feeder
NOTE: 

• To avoid paper jams, do not remove the tray while printing is in progress.

• Use only laser print media. Do not use ink jet print media in your printer.

1 Pull the tray out of the printer about 200 mm.

2 Hold the tray with both hands, and remove it from the printer.

3 Adjust the paper guides.

NOTE: 

• When loading Legal size or user-specified print media, slide the extendable part of the tray while pinching the lever.



124 Printing Basics

4 Before loading the print media, flex the sheets and fan them. Straighten the edges of the stack on a level 
surface.

5 Load the print media into the tray with the recommended print side facing up.

NOTE: 

• Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.

6 Align the width guides and length guide against the edges of the print media.

7 Make sure that the paper is set properly by pressing down the paper from top.

8 After confirming that the guides are securely adjusted, insert the tray into the printer.

IMPORTANT: 

• Do not use excessive force on the tray. Doing so could damage the tray or inside of the printer.

NOTE: 

• If the front side of the tray is extended, the tray protrudes when it is inserted into the printer.

9 On the operator panel, select the appropriate paper size, and then press the  button.
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10 Select the appropriate paper type, and then press the  button.

Loading Letterhead in the Standard 550 Sheet Tray and the 
Optional 550 Sheet Feeder
When you use the standard 550 sheet tray and the optional 550 sheet feeder, letterhead and hole punched paper 
must be inserted top edge first with the print side facing up.
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 Loading Print Media in the Bypass Tray

1 Gently pull open the bypass tray cover.

2 Slide the width guides to the edge of the tray. The width guides should be fully extended.

3 Insert all media face up and top edge first into the bypass tray.

NOTE: 

• Do not force the print media into the bypass tray.

4 Slide both width guides until they rest lightly against the edge of the print media stack.

NOTE: 

• Do not force the print media into the bypass tray.

5 On the operator panel, select the appropriate paper size, and then press the  button.

NOTE: 

• If you use the driver setting, select Use Driver Settings.

6 Select the appropriate paper type, and then press the  button.
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Loading Small Print Media in the Bypass Tray
When loading small print media such as monarch envelope or the user-specified print media whose feed direction 
length is 191.6 mm or less in the bypass tray, remove the bypass tray from the printer.

1 Gently pull open the bypass tray cover.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Slide the width guides to the edge of the tray. The width guides should be fully extended.

4 Pull up the length guide and slide it toward the bypass tray cover until it stops.

5 Load the print media into the bypass tray with the recommended print side facing up so that the top edge of the 
print media enters the printer first.
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6 Align the paper guides against the edges of the print media.

7 Insert the bypass tray into the printer.

8 On the operator panel, select the appropriate paper size, and then press the  button.

NOTE: 

• If you use the driver setting, select Use Driver Settings.

9 Select the appropriate paper type, and then press the  button.
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Loading Envelope in the Bypass Tray
Use the following guidelines to load each size of envelopes in the bypass tray:

IMPORTANT: 

• Never use envelopes with windows, coated linings, or self-stick adhesives. These lead to paper jams and can cause damage 
to the printer.

NOTE: 

• When five envelopes are set on the bypass tray, a misfeed may occur. If this happens, reduce the number of envelopes.

• If you do not load envelopes in the bypass tray right after they have been removed from the packaging, they may bulge. To 
avoid jams, flatten them as shown below before loading the envelopes in the bypass tray.

• Com 10/DL
Load the envelopes short edge feed with the flaps closed and the print side up. Ensure that the flaps come at the 
right when you face towards the printer.

• Monarch
You need to pull up and slide the length guide. Load the envelopes short edge feed with the flaps closed and the 
print side up. Ensure that the flaps come at the right when you face towards the printer.

• C5
Load the envelopes short edge feed with the flaps open or closed and the print side up.

Ensure that the flaps come at the bottom with the flaps open or at the top with the flaps closed when you face 
towards the printer.

When you print with the orientation of the 1, position of the envelopes may be distorted on the output tray. In this 
case, set the orientation of the 2.

                       

1 2
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Loading Letterhead in the Bypass Tray
When you use the bypass tray, letterhead and hole punched paper must be inserted top edge first with the print side 
facing up.

Using the Bypass Tray
• Load only one size and type of print media during a single print job.

• To achieve the best possible print quality, use only high-quality print media that is designed for use in laser 
printer. For more guidelines on print media, see "Print Media Usage Guidelines" on page 116.

• Do not add or remove print media when there is still print media in the bypass tray or when the printer is printing 
from the bypass tray. This may result in a paper jam.

• Print media should be loaded with the recommended print side up and the top of the print media going into the 
bypass tray first.

• Do not place objects on the bypass tray. Also, avoid pressing down or applying excessive force on it.

• The icons on the bypass tray show how to load the bypass tray with print media, and how to turn an envelope 
for printing.
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Setting Paper Sizes and Types
When loading print media in the tray, set the paper size and type on the operator panel before printing.

See also: 
• "Understanding the Printer Menus" on page 162

This section includes:

• "Setting Paper Sizes" on page 131

• "Setting Paper Types" on page 131

 Setting Paper Sizes

1 On the operator panel, press the  (Menu) button.

2 Select Tray Settings, and then press the  button.

3 Select the desired tray, and then press the  button.

NOTE: 

• When you select Bypass Tray, MPT Mode is set to Driver Specified by default. Select Panel Specified for 
MPT Mode to specify the paper size and type on the operator panel.

4 Select Paper Size, and then press the  button.

5 Select the correct paper size for the print media loaded, and then press the  button.

 Setting Paper Types
IMPORTANT: 

• Paper type settings must match those of the actual print media loaded in the tray or the feeder. Otherwise, print-quality 
problems can occur.

1 On the operator panel, press the  (Menu) button.

2 Select Tray Settings, and then press the  button.

3 Select the desired tray, and then press the  button.

NOTE: 

• When you select Bypass Tray, MPT Mode is set to Driver Specified by default. Select Panel Specified for 
MPT Mode to specify the paper size and type on the operator panel.

4 Select Paper Type, and then press the  button.

5 Select the correct paper type for the print media loaded, and then press the  button.
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Printing
This section covers how to print certain information from your printer and how to cancel a job.

This section includes:

• "Sending a Job to Print" on page 132

• "Canceling a Print Job" on page 133

• "Using the Stored Print Feature" on page 134

• "Printing PDF Files Using PDF Bridge (Windows Only)" on page 137

• "Selecting Printing Options" on page 141

• "Printing Custom Size Paper" on page 144

• "Auditron" on page 147

• "Checking Status of Print Data" on page 148

• "Printing a Report Page" on page 148

• "Printer Settings" on page 149

 Sending a Job to Print
To support all of the printer features, use the print driver. When you choose Print from a software program, a window 
representing the print driver opens. Select the appropriate settings for the specific job that you are sending to print. 
Print settings selected from the driver override the default menu settings selected from the operator panel.

You may need to click Preferences from the initial Print box to see all of the available system settings you can 
change. If you are not familiar with a feature in the print driver window, open the Help for more information.

To print a job from a typical Microsoft® Windows® application:

1 Open the file you want to print.

2 From the application menu, select Print.

3 Verify that the correct printer is selected in the dialog box. Modify the system settings as appropriate (such as 
the pages you want to print or the number of copies).

4 Click Preferences to adjust system settings that are not available from the first screen, and then click OK. 

5 Click Print to send the job to the selected printer.
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 Canceling a Print Job
There are several methods for canceling a job.

This section includes:

• "Canceling a Job From the Operator Panel" on page 133

• "Canceling a Job From a Computer Running Windows" on page 133

Canceling a Job From the Operator Panel
To cancel a job after it has started printing:

1 Press the  (Stop) button.

Printing is canceled only for the current job. All the following jobs will continue to print.

Canceling a Job From a Computer Running Windows

• Canceling a Job From the Taskbar
When you send a job to print, a small printer icon appears in the bottom right corner of the taskbar.

1 Double-click the printer icon. 

A list of print jobs appears in the printer window.

2 Select the job you want to cancel.

3 Press Delete key on the keyboard.

4 Click Yes on the Printers dialog box to cancel a print job.

• Canceling a Job From the Desktop

1 Click start → Printers and Faxes (for Windows XP).

Click Start → Printers and Faxes (for Windows Server® 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista®).

Click Start → Control Panel → Printers (for Windows Server 2008).

A list of available printers appears.

2 Double-click the printer that you selected when you sent the job for print.

A list of print jobs appears in the printer window.

3 Select the job you want to cancel.

4 Press Delete key on the keyboard.

5 Click Yes on the Printers dialog box to cancel a print job.
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 Using the Stored Print Feature
When you send a job to the printer, you can specify in the print driver to store the job in the memory or hard disk. 
When you are ready to print the job, go to the printer and use the operator panel menus to identify which job in the 
memory or hard disk you want to print.

NOTE: 

• The stored print feature is available when:

- The optional 512MB memory is installed.

- The RAM disk is enabled in the operator panel menu.

- RAM Disk is set to Installed in the print driver.

OR

- The optional hard disk unit is installed.

- Hard Disk is set to Installed in the print driver.

• The data in memory is cleared when the printer is turned off. The data on the optional hard disk unit is not cleared even when 
the printer is turned off.

The stored print feature includes the following job types:

• "Secure Print" on page 134

• "Sample Print" on page 134

Secure Print
You can store print jobs secured with a passcode in the memory. Users with the passcode can print them from the 
operator panel. This feature can be used to print confidential documents. You can select whether to delete the stored 
job after printing. Otherwise, the stored jobs remain in the memory until you delete them from the operator panel or 
turn off the printer, or in the hard disk until you delete them from the operator panel.

NOTE: 

• Secure Print is available when you use the PCL 6 or PS driver.

Sample Print
The collated print job is stored in the memory or hard disk, but a single copy is printed automatically so you can 
check the print result. If you do not have problems with the print result, you can choose to print more copies. This 
prevents large number of misprinted copies from being printed at one time.

NOTE: 

• Sample Print is available when you use the PCL 6 or PS driver.

Send confidential data.

Enter the passcode from 
the operator panel.

Print data.

Confidential

Send data.

One set is 
printed.

Check if the print result 
is OK.

Print the rest of sets 
from the operator panel.
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Procedures for Printing Stored Print
The following are procedures for storing and printing jobs.

• Storing Print Jobs
For Secure Print, select Secure Print for Job Type and specify the user ID, passcode and job name by clicking 
Setup in the Paper/Output tab of the print driver. When you send the job to the printer, the job will be stored in the 
memory until you request to print it from the operator panel or turn off the printer, or in the hard disk until you request 
to print it from the operator panel.

For Sample Print, select Sample Set for Job Type and specify the user ID and job name by clicking Setup in the 
Paper/Output tab of the print driver. When you send the job to the printer, the first set is printed. The remaining 
copies will be stored in the memory until you select to print them on the operator panel or turn off the printer, or in the 
hard disk until you request to print it from the operator panel.

NOTE: 

• If a print job is too large for the memory available, the printer may display error messages.

• If a document name is not assigned to your print job in the print driver, the job's name will be identified using the printer's time 
and date of submission to distinguish it from other jobs you have stored under your name.

• Printing the Stored Jobs
Once jobs are stored, you can use the operator panel to specify printing. Select the job type you are using from 
Secure Print and Sample Print. Then, select your user ID from a list. Secure Print requires the passcode you 
specified in the driver when you sent the job. 

To print the stored documents, use the procedure below.

1 Press the  button.

2 Select Secure Print or Sample Print, and then press the  button.

3 Select your user ID, and then press the  button.

If you select Secure Print, go to step 4.

If you select Sample Print, go to step 5.

4 Enter the passcode you specified in the print driver, and then press the  button.

For details about specifying the passcode, see "Specifying Your Passcode on the Operator Panel (Secure 
Print)" on page 135.

5 Select the document you want to print, and then press the  button.

6 Select Print and Delete or Print and Save, and then press the  button.

7 Specify the number of copies to be printed using the  and  buttons, and then press the  button.

The stored document will be printed.

• Specifying Your Passcode on the Operator Panel (Secure Print)
When you select your user ID for Secure Print, a screen to enter the passcode appears.

Use the buttons on the operator panel to enter the numeric passcode you specified in the print driver. The passcode 
you entered will be displayed as asterisks (*******) to ensure confidentiality.

If you enter an invalid passcode, the message Wrong password Re-enter appears. Wait three seconds, or press 
the  button to return to the screen to enter the passcode.

When you enter a valid passcode, you have access to all print jobs matching the user name and passcode you 
entered. The print jobs matching the passcode you entered appear on the screen. You can then choose to print or to 
delete jobs matching the passcode you entered. 

See also: 
• "Printing the Stored Jobs" on page 135
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• Deleting Stored Jobs
A job that has been stored will be deleted after printing if selected to do so on the operator panel. Otherwise, the job 
remains stored until you delete them on the operator panel or turn off the printer.

NOTE: 

• The data in the memory is cleared when the printer is turned off. The data on the optional hard disk unit is not cleared even 
when the printer is turned off.
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 Printing PDF Files Using PDF Bridge (Windows Only)
The printer has the PDF Bridge feature, which enables you to print PDF files directly without a print driver. Printing 
PDF files without a print driver is much easier and faster when compared to printing with a print driver. This section 
describes how to print PDF files using PDF Bridge.

This section includes:

• "Supported PDF Files" on page 137

• "Using the ContentsBridge Utility" on page 137

• "Using the Commands" on page 137

Supported PDF Files
PDF files created on the following versions of Adobe® Acrobat® can be printed using PDF Bridge.

• Adobe Acrobat 5.X (excluding some of the features added to PDF1.4)

• Adobe Acrobat 6.X (excluding some of the features added to PDF1.5)

• Adobe Acrobat 7.X (excluding some of the features added to PDF1.6)

NOTE: 

• Some PDF files cannot be printed depending on how they are created. In such case, open the files and print them using a 
print driver.

Using the ContentsBridge Utility
The ContentsBridge Utility is software that enables direct printing of PDF files by simply dragging and dropping files 
onto the icon. To use the ContentsBridge Utility, refer to the manual included on the Driver CD Kit.

Using the Commands
You can also print PDF files using the lpr or ftp command. When you print using these commands, the following PDF 
settings on the operator panel become effective.

• Quantity

• 2-Sided Print

• Print Mode

• Password

• Collated

• Output Size

• Layout

NOTE: 

• When you print using the lpr command, the print quantity must be set also using lpr command. In such case, the Quantity 
setting on the operator panel becomes invalid. If you do not specify the quantity using the lpr command, the printer recognizes 
the quantity as "1 set".

• To print PDF files using the lpr or ftp command, you must enable the printer's LPD or FTP port using the operator panel or 
CentreWare Internet Services (default: Enable).
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Using the lpr command

NOTE: 

• For Windows Vista or later, enable the lpr command first. The following procedure uses Windows 7 as an example.

a Click Start → Control Panel → Programs → Turn Windows features on or off.

b In the Windows Features dialog box, select the LPR Port Monitor check box under Print and Document 
Services.

In the command prompt, enter the lpr command as described in the following example:

Example: Printing "event.pdf" when the printer's IP address is 192.168.1.100.

Using the ftp command
In the command prompt, enter the ftp command as described in the following example:

Example: Printing "event.pdf" when the printer's IP address is 192.168.1.100.

C:\> lpr -S 192.168.1.100 -P lp event.pdf

C:\> ftp 192.168.1.100
Connected to 192.168.1.100.

220 FUJI XEROX DocuPrint XXXX

User (192.168.1.100:(none)):

331 Password required

Password:

230 Logged in

ftp> bin
200 Command successful

ftp> put event.pdf
200 Command successful

150 Opening data connection

226 Transfer complete

ftp: xxxxx bytes sent in xxxSeconds xxxxxkbytes/sec.

ftp>
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 Duplex Printing
Duplex printing (or 2-sided printing) allows you to print on both sides of a sheet of paper. A4, A5, B5, Letter, Folio, 
Legal and Executive paper sizes are acceptable.

This section includes:

• "Using 2-Sided Print" on page 139

• "Using Booklet Print" on page 140

Using 2-Sided Print
The following procedure uses the PCL 6 driver as an example.

1 Click start → Printers and Faxes (for Windows XP).

Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista).

Click Start → Control Panel → Printers (for Windows Server 2008).

A list of available printers appears. 

2 Right-click the printer and select Printing preferences.

The Paper/Output tab appears.

3 From the drop-down menu of Paper, select Select By Tray and then select Automatically Select, Tray 1, 
Tray 2, Tray 3, Tray 4, or Bypass Tray.
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4 From 2-Sided Print, select 2-Sided Print or 2-Sided Print, Flip on Short Edge.

5 Click OK.

Using Booklet Print
To use the Booklet Print feature, select the Booklet Layout check box in the Layout/Watermark tab of the printer's 
Printing Preferences dialog box. Click Booklet Creation for detailed settings. The binding position is automatically 
set to 2-Sided Print for 2-Sided Print in the Paper/Output tab.

NOTE: 

• When the XML Paper Specification (XPS) driver or the PS driver is used, the Booklet Print feature is not available.

• For details on the 2-Sided Print option, see "2-Sided Print" on page 140.

2-Sided Print Assumes binding along the long edge of the page (left edge for portrait orientation and top edge for 
landscape orientation). The following illustration shows long-edge binding for portrait and landscape 
pages:

2-Sided Print, 
Flip on Short 
Edge

Assumes binding along the short edge of the page (top edge for portrait orientation and left edge for 
landscape orientation). The following illustration shows short-edge binding for portrait and landscape 
pages:

Portrait Landscape

Portrait Landscape
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 Selecting Printing Options
This section includes:

• "Selecting Printing Preferences (Windows)" on page 141

• "Selecting Options for an Individual Job (Windows)" on page 141

• "Selecting Options for an Individual Job (Mac OS X)" on page 143

Selecting Printing Preferences (Windows)
Printer Preferences control all of your print jobs, unless you override them specifically for a job. For example, if you 
want to use duplex printing for most jobs, set this option in Printing Preferences.

To select Printing Preferences:

1 Click start → Printers and Faxes (for Windows XP).

Click Start → Printers and Faxes (for Windows Server 2003).

Click Start → Devices and Printers (for Windows 7 and Windows Server 2008 R2).

Click Start → Control Panel → Hardware and Sound → Printers (for Windows Vista).

Click Start → Control Panel → Printers (for Windows Server 2008).

A list of available printers appears. 

2 Right-click the icon for your printer, and then select Printing preferences.

The printer's Printing Preferences screen appears.

3 Make selections on the driver tabs, and then click OK to save your selections.

NOTE: 

• For more information about Windows print driver options, click Help on the print driver tab to view the help.

Selecting Options for an Individual Job (Windows)
If you want to use special printing options for a particular job, change the driver settings before sending the job to the 
printer. For example, if you want to use Photo print-quality mode for a particular graphic, select this setting in the 
driver before printing that job.

1 With the desired document or graphic open in your application, access the Print dialog box.

2 Select your printer and click Preferences to open the print driver.

3 Make selections on the driver tabs.

NOTE: 

• When using the PCL 6 or PS driver, you can save current printing options with a distinctive name and apply them to other 
print jobs. Select either the Paper/Output, Image Options, Layout/Watermark, or Advanced tab, and then click 
Save under Saved Settings on the Paper/Output tab. Click Help for more information.

4 Click OK to save your selections.

5 Print the job.
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See the following table for specific printing options:

The table shown below uses the PCL 6 driver as an example.

Printing Options for Windows

Driver Tab Printing Options

Paper/Output tab • Job Type

• 2-Sided Print

• Paper

– Size

– Type

– Select By Tray

– Advanced Paper Selection

– Covers/Separators

• Output

• Saved Settings

• Envelope/Paper Setup Wizard

• Status

• Defaults

• Default All

Image Options tab • Image Quality

• Image Settings

• Application Reduce/Enlarge

• Toner Saver

• Margins

• Screen

• Image Shift Summary

• Tone Balance

• Defaults

Layout/Watermark tab • Page Layout

– Pages Per Sheet (N-Up)

– Poster

– Booklet Layout

• Page Layout Options

• Background Form

• Watermark

• Annotation

• Defaults

Advanced tab • Advanced Settings

• Document Options

– Specify Font

– Paper/Output

– Image Options

– Layout/Watermark

– Others

• About

• Defaults
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Selecting Options for an Individual Job (Mac OS X)
To select print settings for a particular job, change the driver settings before sending the job to the printer.

1 With the document open in your application, click File, and then click Print.

2 Select your printer from Printer.

3 Select the desired printing options from the menus and drop-down list boxes that are displayed.

NOTE: 

• In Mac OS® X, click Save As on the Presets menu to save the current printer settings. You can create multiple presets 
and save each with its own distinctive name and printer settings. To print jobs using specific printer settings, click the 
applicable saved preset in the Presets menu.

4 Click Print to print the job.

Mac OS X Print Driver Printing Options:

The table shown below uses Mac OS X 10.6 TextEdit as an example.

Printing options for Mac OS X

Item Printing Options

• Copies

• Collated

• Two-Sided

• Pages

• Paper Size

• Orientation

Layout • Pages per Sheet

• Layout Direction

• Border

• Two-Sided

• Reverse page orientation

• Flip horizontally

Paper Handling • Pages to Print

• Page Order

• Scale to fit paper size

• Destination Paper Size

• Scale down only

Paper Feed • All pages From

• First Page From

• Remaining From

Cover Page • Print Cover Page

• Cover Page Type

• Billing Info

Scheduler • Print Document

• Priority

Job Accounting • Account Mode

• User Details Setup

Job Type • Job Type

• Setup

• Defaults
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 Printing Custom Size Paper
This section explains how to print on custom size paper using the print driver.

The way to load custom size paper is the same as the one to load standard size paper.

NOTE: 

• You can use custom size paper between the following ranges:

• For the standard 550 sheet tray, the optional 550 sheet feeder, and the bypass tray (duplex print)

- Width: 139.7 mm (5.5 inches) to 215.9 mm (8.5 inches)

- Length: 210 mm (8.27 inches) to 355.6 mm (14 inches)

• For the bypass tray

- Width: 76.2 mm (3 inches) to 215.9 mm (8.5 inches)

- Length: 127 mm (5 inches) to 355.6 mm (14 inches)

• XML Paper Specification (XPS) driver does not support custom size paper.

See also: 
• "Loading Print Media in the Standard 550 Sheet Tray and the Optional 550 Sheet Feeder" on page 123

• "Loading Print Media in the Bypass Tray" on page 126

• "Setting Paper Sizes and Types" on page 131

Watermark • Watermark

– Edit

– Delete

– New

• Print on Page 1 only

• Defaults

Printer Features • Feature Sets: General

– Feed Orientation

– Paper Type

– Substitute Tray

– Custom Paper Auto Orientation

– Draft Mode

– Skip Blank Pages

– Halftone Screen Lock

– Image Quality

– Halftone

– Letterhead Duplex Mode

• Feature Sets: Color Balance K

– Low Density (K)

– Medium Density (K)

– High Density (K)

Supply Levels • Toner Cartridge

• PHD unit

• Fusing Unit

Summary

Item Printing Options
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Defining Custom Paper Sizes
Before printing, set the custom size on the print driver.

NOTE: 

• When setting the paper size on the print driver and the operator panel, be sure to specify the same size as the actual print 
media used. Setting the wrong size for printing can cause printer failure. This is especially true if you configure a bigger size 
when using a narrow width paper.

• Using the Windows Print Driver
On the Windows print driver, set the custom size in the Custom Paper Size dialog box. This section explains the 
procedure using Windows 7 and the PCL 6 driver as an example.

An administrator’s password only allows users with administrator rights to change the settings. Users without the 
rights of administrator can only view the contents.

1 Click Start → Devices and Printers.

2 Right-click the printer, and then select Printer properties.

3 Select the Device Settings tab.

4 Select Custom Paper Size and click Setup.

5 Select the Create a New Form check box.

6 Enter a name for the custom paper size in Name. Up to 31 characters can be used for the paper name.

7 Specify the values for Width and Length either by entering the number directly or using the up arrow and down 
arrow buttons.

The value for Width cannot be greater than that of Length, even if it is within the specified range.

NOTE: 

• You can switch the units by selecting either Millimeters or Inches under Units.

• If you do not want to share the custom paper size with other users, clear the Share it with Other Users check box.

8 Click Save.

9 If necessary, repeat steps 5 to 8 to define another custom size.

10 Click Close.

11 Click OK.
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Printing on Custom Size Paper
Use the following procedures to print using either the Windows or Mac OS X print drivers.

• Using the Windows Print Driver
To print on custom size paper using the PCL 6 driver as an example:

NOTE: 

• The way to display the printer Properties/Printing Preferences dialog box differs according to the application software. 
Refer to the manual of each application software.

1 From the application menu, select Print.

2 Select your printer and click Preferences.

3 Select the Paper/Output tab.

4 From the drop-down menu of Paper, select Advanced Paper Selection.

5 Select the desired paper tray from Paper Tray.

NOTE: 

• If you select Bypass Tray, Bypass Feed Orientation appears. Specify the orientation of the paper set on the bypass 
tray. 

6 Select the size of the original document from Original Document Size.

7 Specify Scale Options.

If you select the custom paper size from Original Document Size in step 6, select No Scaling and go to step 
9.

If you select the standard paper size from Original Document Size in step 6, select Automatically Scale and 
go to step 8.

8 Select the custom paper size from Output Paper Size.

9 Select the appropriate paper type from Paper Type.

10 Click OK twice.

11 Click Print in the Print dialog box to start printing.

• Using the Mac OS X Print Driver
This section explains the procedure using Mac OS X 10.6 TextEdit as an example.

1 From the File menu, select Page Setup.

2 Select your printer from Format For.

3 From Paper Size, select Manage Custom Sizes.

4 In the Custom Paper Sizes window, click +.

A newly created setting “Untitled” is displayed in the list.
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5 Double-click "Untitled" and enter the name for the setting.

6 Enter the size of the original document in the Width and Height boxes of Paper Size.

7 Specify Non-Printable Area if necessary.

8 Click OK.

9 Make sure that the newly created paper size is chosen in Paper Size, and then click OK.

10 From the File menu, select Print.

11 Make sure that your printer is selected in Printer.

12 Click Print to start printing.

 Auditron
Auditron contains an authentication function that can set limits on what processes can be used, as well as an 
account management that can be used to control usage based on authentication.

The following illustration shows how the printer works with Auditron. 

NOTE: 

• You can configure the printer's Auditron settings with CentreWare Internet Services. For more information, refer to the online 
Help of CentreWare Internet Services.

• To print using Auditron, you need to set the print driver. For more information, refer to the Help of the driver.

Registered user A
Registered user B

Can print up to 
10,000 pages

Print account report

Normal user D System administrator C

Can print up to 9,000 
pages

Cannot print if not a 
registered user, or if the 
printed pages exceeds the 
limit

Reference account report 
for each registered user
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 Checking Status of Print Data
This section includes:

• "Checking Status (Windows Only)" on page 148

• "Checking Status in CentreWare Internet Services (Windows & Mac OS X)" on page 148

Checking Status (Windows Only)
Printer information and status can be checked with SimpleMonitor. By default, the Status Monitor window launches 
when printing and an error occurs. To display the Status Monitor window manually, double-click the SimpleMonitor 
printer icon  on the taskbar at the bottom right of the screen. From the displayed window, click the name of the 
desired printer listed.

For more information about SimpleMonitor, see Help: The following procedure uses Windows 7 as an example:

1 Click Start → All Programs.

2 Select Fuji Xerox.

3 Select SimpleMonitor for Asia-Pacific.

4 Select SimpleMonitor Help.

See also: 
• "SimpleMonitor (Windows Only)" on page 66

Checking Status in CentreWare Internet Services (Windows & Mac 
OS X)
You can check the status of the print job sent to the printer at the Jobs tab of CentreWare Internet Services.

See also: 
• "Printer Management Software" on page 63

 Printing a Report Page
You can print a various types of reports and lists. For details on each report and list, see "Report / List" on page 162.

Taking the Printer Settings page as an example, this section describes how to print a report page.

Printing a Printer Settings Page
To verify detailed printer settings, print a Printer Settings page. A printed Printer Settings page also allows you to 
verify whether or not options have been installed properly.

See also: 

• "Understanding the Printer Menus" on page 162

1 Press the  (Menu) button.

2 Select Report / List, and then press the  button.

3 Select Printer Settings, and then press the  button.

The Printer Settings page is printed.
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 Printer Settings
You can select menu items and corresponding values from the operator panel.

When you first browse through the menus from the operator panel, you see some values marked with an asterisk (*).

These values are the factory default and original system settings.

NOTE: 

• Factory defaults may vary for different regions.

When you select a new value from the operator panel, the value selected is marked with an asterisk (*) to identify it 
as the current user setting.

These settings are active until new ones are selected or the factory defaults are restored.

To select a new value as a setting:

1 Press the  (Menu) button.

2 Select the desired menu, and then press the  button.

3 Select the desired menu or menu item, and then press the  button.

• If the selection is a menu, the menu is opened and the first menu item in the menu appears.

• If the selection is a menu item, the current user setting for the menu item appears with an asterisk (*).

Each menu item has a list of values for the menu item. A value can be:

• A phrase or word to describe a setting

• A numerical value that can be changed

• An On or Off setting

4 Select the desired value, and then press the  button.

5 Press the  (Back) or  button to return to the previous menu.

To continue setting other items, select the desired menu. To quit setting new values, press the  (Back) 
button.

Driver settings may have precedence over the settings made on the operator panel.
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Printing With Web Services on Devices (WSD)
This section provides information for network printing with WSD, the new Microsoft protocol for Windows Vista, 
Windows Server 2008, Windows Server 2008 R2, and Windows 7.

NOTE: 

• WSD stands for Web Services on Devices.

This section includes:

• "Adding Roles of Print Services" on page 150

• "Printer Setup" on page 151

 Adding Roles of Print Services
When you use Windows Server 2008 or Windows Server 2008 R2, you need to add the roles of print services to the 
Windows Server 2008 or Windows Server 2008 R2 client.

• For Windows Server 2008:

1 Click Start → Administrative Tools → Server Manager.

2 Select Add Roles from the Action menu.

3 Select the Print Services check box on the Server Roles window in the Add Roles Wizard, and then click 
Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.

• For Windows Server 2008 R2:

1 Click Start → Administrative Tools → Server Manager.

2 Select Add Roles from the Action menu.

3 Select the Print and Document Services check box on the Server Roles window in the Add Roles Wizard, 
and then click Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.
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 Printer Setup
You can install your new printer on the network using the Driver CD Kit that shipped with your printer, or using 
Microsoft Windows’ Add Printer wizard. The following procedure uses the PCL 6 driver as an example.

Installing a Print Driver Using the Add Printer Wizard

1 Click Start → Devices and Printers (Start → Control Panel → Hardware and Sound → Printers for 
Windows Vista and Windows Server 2008).

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer.

4 In the list of available printers, select the one you want to use, and then click Next.

NOTE: 

• In the list of available printers, the WSD printer is displayed in the form of http://IP address/ws/.

• If no WSD printer is displayed in the list, enter the printer's IP address manually to create a WSD printer. To enter the 
printer's IP address manually, follow the instructions below.
For Windows Server 2008 R2, to create a WSD printer, you must be a member of Administrators group.

1 Click The printer that I want isn't listed. 

2 Select Add a printer using a TCP/IP address or hostname and click Next. 

3 Select Web Services Device from Device type.

4 Enter the printer's IP address in Hostname or IP address and click Next.

• Before installing the driver using the Add Printer wizard on Windows Server 2008 R2 or Windows 7, perform one of the 
following:

- Establish the Internet connection so that Windows Update can scan your computer.

- Add the print driver to your computer.

5 If prompted, install the print driver on your computer. If you are prompted for an administrator password or 
confirmation, enter the password or provide confirmation.

6 Complete the additional steps in the wizard, and then click Finish.

7 Configure the option settings and print a test page to verify print installation.

a Click Start → Devices and Printers (Start → Control Panel → Hardware and Sound → Printers for 
Windows Vista and Windows Server 2008).

b Right-click the printer you just created, and then click Printer properties (Properties for Windows Vista 
and Windows Server 2008).

On the Configuration tab, click Installable Options to configure the option settings, and then click Apply.

c On the General tab, click Print Test Page. When a test page prints successfully, installation is complete.
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Using Digital Certificates
The authentication feature using digital certificates upgrades security when sending print data or setting data.

This section describes how to manage digital certificates.

NOTE: 

• For information about digital certificate error, see "Understanding Printer Messages" on page 244 and "Digital Certificate 
Problem" on page 241.

The following is a typical setup flow for using digital certificates.

 Managing Certificates
This section describes how to manage digital certificates.

This section includes:

• "Preparing to Manage Certificates" on page 152

• "Importing a Digital Certificate" on page 154

• "Setting a Digital Certificate" on page 155

• "Confirming the Settings of a Digital Certificate" on page 155

• "Deleting a Digital Certificate" on page 156

• "Exporting a Digital Certificate" on page 157

NOTE: 

• The external certificate management described in this section is enabled only when the optional hard disk unit is installed and 
Data Encryption is set to On.

Preparing to Manage Certificates
Before managing digital certificates, the following settings must be applied.

• "Changing the Encryption Setting of the Hard Disk Unit" on page 153

• "Setting HTTPS Communication" on page 153

Prepare to manage digital certificates.

• Change the Encryption Setting of the hard disk unit

• Set HTTPS Communication

Import and set digital certificates.

• Import a Digital Certificate

• Set a Digital Certificate

• Confirm the Settings of a Digital Certificate

Set various security features using digital certificates.
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• Changing the Encryption Setting of the Hard Disk Unit
Some items are effective only when encryption of the optional hard disk unit is set to On. Change the encryption 
setting to On and set a key that is required to encrypt from the operator panel, if necessary.

IMPORTANT: 

• All files stored on the optional hard disk unit are cleared when changing the encryption setting.

NOTE: 

• You can enter only characters from 0 to 9, a to z, A to Z, and NULL values for encryption key.

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Secure Settings, and then press the  button.

4 Select Data Encryption, and then press the  button.

5 Select Encryption, and then press the  button.

6 Select On, and then press the  button.

7 Enter the passphrase for the encryption key using the  and  buttons, and then press the  button.

8 The Initialize HDD Are You Sure? message appears.

When you confirm that all stored documents will be deleted to change the encryption setting, press the  
button to change the setting.

When you quit changing encryption setting, press the  button.

• Setting HTTPS Communication
Before managing certificates, set HTTPS communication with a self-signed certificate using CentreWare Internet 
Services.

NOTE: 

• Set HTTPS communication after changing the Data Encryption setting to On.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

The printer's web page appears.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

5 Click Generate Self-Signed Certificate of Machine Digital Certificate.

If user name and password are required, enter the correct user name and password.

NOTE: 

• The default user name is "11111", and the default password is "x-admin".

The Create New Certificate page is displayed.
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6 Select the public key method from the list of Public Key Method.

7 Select the size of public key from the list of Public Key Size.

8 Confirm the issuer of SSL self-signed certificate.

9 Specify the validity period of the certificate in Validity.

10 Click Generate Signed Certificate.

11 When Settings have been changed. Restart system for new settings to take effect. is displayed, click 
Restart Printer to restart the printer.

12 Enter the IP address of the printer in the address bar, and press the Enter key.

NOTE: 

• To access CentreWare Internet Services when data encryption is enabled, enter "https" before its address instead of 
"http".
Example: https://192.168.1.100/

The printer's web page appears.

13 Repeat steps 3 to 4 to display the SSL/TLS Server Communication page.

14 Check that Enabled for SSL/TLS Server Communication is selected.

Importing a Digital Certificate

IMPORTANT: 

• Before importing a certificate file, back up the certificate file.

NOTE: 

• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates" on page 152.

• Be sure to import the certificate with Internet Explorer®.

• After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

NOTE: 

• To access CentreWare Internet Services when data encryption is enabled, enter "https" before its address instead of 
"http".
Example: https://192.168.1.100/

The printer's web page appears.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

5 Click Upload Signed Certificate of Machine Digital Certificate.

The Upload Signed Certificate page is displayed.

NOTE: 

• The Upload Signed Certificate button is displayed only when the optional hard disk unit is installed and Data 
Encryption is set to On.
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6 Enter a password corresponding to the certificate file to be imported.

7 Re-enter the password again to confirm it.

8 Click Browse of File Name, and select the file to be imported.

9 Click Import to import the certificate.

Setting a Digital Certificate

NOTE: 

• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates" on page 152.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

NOTE: 

• To access CentreWare Internet Services when data encryption is enabled, enter "https" before its address instead of 
"http".
Example: https://192.168.1.100/

The printer's web page appears.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

5 Click Certificate Management to display the Certificate Management page.

NOTE: 

• The Certificate Management button is displayed only when the optional hard disk unit is installed and Data 
Encryption is set to On.

6 Select Local Device.

7 Select the purpose of use from the Certificate Purpose list.

8 Click Display the List to display the Certificate List page.

NOTE: 

• If the list includes more than 20 certificates, click Next to display the next page.

9 Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid.

10 Click Certificate Details to display the Certificate Details page.

11 Confirm the content, and click Use this certificate at the upper-right corner.

Confirming the Settings of a Digital Certificate

NOTE: 

• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates" on page 152.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

NOTE: 

• To access CentreWare Internet Services when data encryption is enabled, enter "https" before its address instead of 
"http".
Example: https://192.168.1.100/

The printer's web page appears.
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3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

5 Click Certificate Management to display the Certificate Management page.

NOTE: 

• The Certificate Management button is displayed only when the optional hard disk unit is installed and Data 
Encryption is set to On.

6 Select the category from the Category list.

7 Select the purpose of use from the Certificate Purpose list.

8 Click Display the List to display the Certificate List page.

NOTE: 

• If the list includes more than 20 certificates, click Next to display the next page.

9 The certificate displayed with an asterisk as "*Valid" in the Validity column is the certificate associated with the 
use purpose and actually used.

Deleting a Digital Certificate

NOTE: 

• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates" on page 152.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

NOTE: 

• To access CentreWare Internet Services when data encryption is enabled, enter "https" before its address instead of 
"http".
Example: https://192.168.1.100/

The printer's web page appears.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

5 Click Certificate Management to display the Certificate Management page.

NOTE: 

• The Certificate Management button is displayed only when the optional hard disk unit is installed and Data 
Encryption is set to On.

6 Select the category from the Category list.

7 Select the purpose of use from the Certificate Purpose list.

8 Click Display the List to display the Certificate List page.

NOTE: 

• If the list includes more than 20 certificates, click Next to display the next page.
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9 Select the certificate to be deleted.

10 Click Certificate Details to display the Certificate Details page.

11 To delete the selected certificate, click Delete at the upper-right corner.

12 Click Delete.

NOTE: 

• When a certificate is deleted, the features associated with the deleted certificate are disabled. To delete a certificate 
being used, either disable the feature in advance or switch the association to another certificate, and then switch to 
another operation mode if possible before deleting the certificate.

- For an SSL Server, switch to another certificate such as a self-signed certificate.

- For an SSL Client, disable the IEEE 802.1x (EAP-TLS) feature.

- For IPsec, change the IKE setting to Preshared Key or disable the feature.

Exporting a Digital Certificate

NOTE: 

• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates" on page 152.

• Since the secret key is not exported, an imported PKCS#12 format certificate can be exported only as a PKCS#7 certificate.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

NOTE: 

• To access CentreWare Internet Services when data encryption is enabled, enter "https" before its address instead of 
"http".
Example: https://192.168.1.100/

The printer's web page appears.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select SSL/TLS Server Communication.

5 Click Certificate Management to display the Certificate Management page.

NOTE: 

• The Certificate Management button is displayed only when the optional hard disk unit is installed and Data 
Encryption is set to On.

6 Select the category from the Category list.

7 Select the purpose of use from the Certificate Purpose list.

8 Click Display the List to display the Certificate List page.

NOTE: 

• If the list includes more than 20 certificates, click Next to display the next page.

9 Select the certificate to be exported.

10 Click Certificate Details to display the Certificate Details page.

11 To export the selected certificate, click Export this certificate.
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 Setting the Features
You can set various security features using digital certificates.

This section includes:

• "Setting the Certificate in the IPsec Digital Signature Mode" on page 158

• "Setting the SSL-use Server Certificate (HTTP/IPP)" on page 158

• "Setting Client Certificate for IEEE 802.1x (EAP-TLS)" on page 159

Setting the Certificate in the IPsec Digital Signature Mode

NOTE: 

• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates" on page 152.

1 Import the certificate to be used with IPsec.

See also: 

• "Importing a Digital Certificate" on page 154

2 Set the certificate to be used with IPsec.

See also: 

• "Setting a Digital Certificate" on page 155

3 Confirm whether the certificate is set correctly in IPsec.

See also: 

• "Confirming the Settings of a Digital Certificate" on page 155

4 Launch CentreWare Internet Services.

5 Click the Properties tab.

6 In the left navigation panel, scroll down to Security and select IP sec.

7 Select the Enabled check box for Protocol.

8 Select Digital Signature from the IKE Authentication Method list.

9 Set each item, as necessary.

10 Click Apply.

11 After restarting the printer, IPsec communication using digital signatures is enabled. You can execute IPsec 
communication (Digital Signature mode) between the printer and the network device (such as computer) on 
which the certificate and IPsec are set identically as on this device.

Setting the SSL-use Server Certificate (HTTP/IPP)

NOTE: 

• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates" on page 152.

1 Import the certificate to be used with the SSL-use server.

See also: 

• "Importing a Digital Certificate" on page 154

2 Set the certificate to be used with the SSL-use server.

See also: 

• "Setting a Digital Certificate" on page 155
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3 Confirm whether the certificate is set correctly.

See also: 

• "Confirming the Settings of a Digital Certificate" on page 155

NOTE: 

• Confirm whether the newly set certificate, not the self-signed certificate, is associated.

4 After restarting the printer, the certificate set as described above is used as the server certificate when 
executing communication with HTTP/IPP-SSL/TLS.

Setting Client Certificate for IEEE 802.1x (EAP-TLS)

NOTE: 

• To manage digital certificates, you must first set encryption of the optional hard disk unit to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates" on page 152.

• This feature is enabled only when Enable is set for IEEE 802.1x (EAP-TLS).

1 Import a certificate to be used with SSL Client.

See also: 

• "Importing a Digital Certificate" on page 154

2 Set a certificate to be used with SSL Client.

See also: 

• "Setting a Digital Certificate" on page 155

3 Confirm whether the certificate is set correctly.

See also: 

• "Confirming the Settings of a Digital Certificate" on page 155

4 After restarting the printer, the IEEE 802.1x (EAP-TLS) certificate is presented when IEEE 802.1x 
communication with the RADIUS server starts. When the RADIUS server is set to require a client certificate, 
the client certificate provided by the printer is verified by the RADIUS server.
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6
Using the Operator Panel Menus

This chapter includes:

• "Understanding the Printer Menus" on page 162

• "Panel Lock Function" on page 196

• "Changing the Language" on page 197

• "Setting the Power Saver Time Option" on page 198

• "Resetting to Factory Defaults" on page 199
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Understanding the Printer Menus
When your printer is connected to a network and available to a number of users, the access to the Admin Menu can 
be limited. This prevents other users from using the operator panel to inadvertently change a user default that has 
been set by the administrator. 

However, you can use your print driver to override user defaults and select settings for individual print jobs.

 Report / List
Use the Report / List menu to print various types of reports and lists.

Printer Settings
Purpose:

To print a list of the current user default values, the installed options, the amount of installed print memory, and the 
status of printer supplies.

Panel Settings
Purpose:

To print a detailed list of all the settings on the operator panel menus.

PCL Fonts List
Purpose:

To print a sample of the available PCL fonts.

PCL Macros List
Purpose:

To print the information on the downloaded PCL macros.

PS Fonts List
Purpose:

To print a sample of the available PS fonts.

PDF Fonts List
Purpose:

To print a sample of the available PDF fonts.

Job History
Purpose:

To print a detailed list of the print jobs that have been processed. This list contains the last 20 jobs.

Error History
Purpose:

To print a detailed list of paper jams and fatal errors.
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Print Meter
Purpose:

To print the reports for the total number of pages printed.

Demo Page
Purpose:

To print a test page.

Stored Documents
NOTE: 

• Stored Documents feature is available only when the optional 512MB memory is installed on the printer and RAM Disk under 
System Settings is enabled or when the optional hard disk unit is installed.

Purpose:

To print a list of all files stored for Secure Print and Sample Print in the RAM disk or hard disk.

 Meter Readings
Purpose:

To check the total number of printed pages.

Values:

*1 This item always shows 0 on your printer.

 Admin Menu
Use the Admin Menu menu to configure a variety of printer features.

PCL Settings
Use the PCL Settings menu to change printer settings that only affect jobs using the PCL emulation printer 
language.

NOTE: 

• Values marked by an asterisk (*) are the factory default menu settings.

• Paper Tray
Purpose:

To specify the default paper tray.

Values:

*1 Tray2, Tray3, and Tray4 are available only when the optional 550 sheet feeder is installed.

Meter 1*1 Displays the total number of color prints.

Meter 2 Displays the total number of monochrome prints.

Meter 3*1 Displays the total number of large size color prints. 

Meter 4 Displays the total number of color and monochrome prints (Meter 1 + Meter 2).

Auto*

Bypass Tray

Tray1

Tray2*1

Tray3*1

Tray4*1
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• Output Size
Purpose:

To specify the default paper size.

Values:

mm series

*1 The default for Output Size varies depending on region-specific factory.

inch series

*1 The default for Output Size varies depending on region-specific factory.

NOTE: 
• Selecting New Custom Size for the paper size prompts you to enter a custom length and width.

A4 - 210x297*1

A5 - 148x210

B5 - 182x257

Letter - 8.5x11

Folio - 8.5x13

Legal - 8.5x14

Executive

Monarch Env.

DL Env- 110x220

C5 Env- 162x229

#10Env- 4.1x9.5

New Custom Size Portrait(Y) 297 mm* Specifies the length of the 
custom size paper.127 - 355 mm

Landscape(X) 210 mm* Specifies the width of the 
custom size paper.77 - 215 mm

Letter - 8.5x11*1

Folio - 8.5x13

Legal - 8.5x14

Executive

A4 - 210x297

A5 - 148x210

B5 - 182x257

Monarch Env.

DL Env- 110x220

C5 Env- 162x229

#10Env- 4.1x9.5

New Custom Size Portrait(Y) 11.7"* Specifies the length of the 
custom size paper.5.0-14.0"

Landscape(X) 8.3"* Specifies the width of the 
custom size paper.3.0-8.5"
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• Orientation
Purpose:

To specify how text and graphics are oriented on the page.

Values:

• 2-Sided
Purpose:

To specify whether to print on both sides of a sheet of paper.

Values:

• Font
Purpose:

To specify the default font from the fonts registered in the printer.

Values:

Portrait* Prints text and graphics parallel to the short edge of the paper.

Landscape Prints text and graphics parallel to the long edge of the paper.

2-Sided Print Off* Does not print on both sides of a sheet of paper.

On Prints on both sides of a sheet of paper.

Binding Edge Long Edge Flip* Prints on both sides of a sheet of paper to be bound by long edge.

Short Edge Flip Prints on both sides of a sheet of paper to be bound by short edge.

CG Times LetterGothic CourierPS

CG Times It LetterGothic It CourierPS Ob

CG Times Bd LetterGothic Bd CourierPS Bd

CG Times BdIt Albertus Md CourierPS BdOb

Univers Md Albertus XBd SymbolPS

Univers MdIt Clarendon Cd Palatino Roman

Univers Bd Coronet Palatino It

Univers BdIt Marigold Palatino Bd

Univers MdCd Arial Palatino BdIt

Univers MdCdIt Arial It ITCBookman Lt

Univers BdCd Arial Bd ITCBookman LtIt

Univers BdCdIt Arial BdIt ITCBookmanDm

AntiqueOlv Times New ITCBookmanDm It

AntiqueOlv It Times New It HelveticaNr

AntiqueOlv Bd Times New Bd HelveticaNr Ob

CG Omega Times New BdIt HelveticaNr Bd

CG Omega It Symbol HelveticaNrBdOb

CG Omega Bd Wingdings N C Schbk Roman

CG Omega BdIt Line Printer N C Schbk It

GaramondAntiqua Times Roman N C Schbk Bd

Garamond Krsv Times It N C Schbk BdIt

Garamond Hlb Times Bd ITC A G Go Bk

GaramondKrsvHlb Times BdIt ITC A G Go BkOb

Courier* Helvetica ITC A G Go Dm

Courier It Helvetica Ob ITC A G Go DmOb

Courier Bd Helvetica Bd ZapfC MdIt

Courier BdIt Helvetica BdOb ZapfDingbats
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• Symbol Set
Purpose:

To specify a symbol set for a specified font.

Values:

• Font Size
Purpose:

To specify the font size for scalable typographic fonts, within the range of 4.00 to 50.00. The default is 12.00.

Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an inch.

NOTE: 

• The Font Size menu is only displayed for typographic fonts.

• Font Pitch
Purpose:

To specify the font pitch for scalable mono spaced fonts, within the range of 6.00 to 24.00. The default is 10.00.

Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For nonscheduled mono 
spaced fonts, the pitch is displayed, but cannot be changed.

NOTE: 

• The Font Pitch menu is only displayed for fixed or mono spaced fonts.

• Form Line
Purpose:

To set the number of lines in a page.

Values:

*1 Denotes region-specific factory default values. 

The printer sets the amount of space between each line (vertical line spacing) based on the Form Line and 
Orientation menu items. Select the correct Form Line and Orientation before changing Form Line.

See also: 
• "Orientation" on page 165

ROMAN-8* WIN L1 ISO-6

ISO L1 WIN L2 ISO-11

ISO L2 WIN L5 ISO-15

ISO L5 DESKTOP ISO-17

ISO L6 PS TEXT ISO-21

PC-8 MC TEXT ISO-60

PC-8 DN MS PUB ISO-69

PC-775 MATH-8 WIN 3.0

PC-850 PS MATH WINBALT

PC-852 PI FONT SYMBOL

PC-1004 LEGAL WINGDINGS

PC-8 TK ISO-4 DNGBTSMS

64*1 (mm series)/60*1 (inch series) Sets the value in increments of 1.

5–128
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• Quantity
Purpose:

To set the default print quantity, within the range of 1 to 999. The default is 1. (Set the number of copies required for 
a specific job from the print driver. Values selected from the print driver always override values selected from the 
operator panel.)

• Hex Dump
Purpose:

To help isolate the source of a print job problem. With Hex Dump selected, all data sent to the printer is printed in 
hexadecimal and character representation. Control codes are not executed.

Values:

• Draft Mode
Purpose:

To save toner by printing in the draft mode. The print quality is reduced when you print in the draft mode.

Values:

• LineTermination
Purpose:

To add the line termination commands.

Values:

• Ignore FormFeed
Purpose:

To specify whether to ignore blank pages that only contain Form Feed control codes.

Values:

Disable* Disables the Hex Dump feature.

Enable Enables the Hex Dump feature.

Disable* Does not print in the draft mode.

Enable Prints in the draft mode.

Off* The line termination command is not added.

CR=CR, LF=LF, FF=FF

Add-LF The LF command is added.

CR=CR-LF, LF=LF, FF=FF

Add-CR The CR command is added.

CR=CR, LF=CR-LF, FF=CR-FF

CR-XX The CR and LF commands are added.

CR=CR-LF, LF=CR-LF, FF=CR-FF

Off* Disables the Ignore FormFeed feature.

On Enables the Ignore FormFeed feature.
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• A4 Wide
Purpose:

To expand the printable area width 8 inch.

Values:

PDF Settings
Use the PDF Settings menu to change printer settings that only affect the PDF jobs.

NOTE: 

• Values marked by an asterisk (*) are the factory default menu settings.

• Quantity
Purpose:

To specify the number of copies to print.

Values:

• 2-Sided Print
Purpose:

To specify whether to print on both sides of a sheet of paper.

Values:

• Print Mode
Purpose:

To specify the print mode.

Value:

• Password
Purpose:

To specify the password to print the secure PDF. 

Value:

Off* Disables A4 Wide.

On Enables A4 Wide.

1sets* Sets the value in increments of 1.

1–999sets

1-Sided* Prints on one side of a sheet of paper.

Long Edge Flip Prints on both sides of a sheet of paper to be bound by long edge. 

Short Edge Flip Prints on both sides of a sheet of paper to be bound by short edge.

Normal* For documents with normal sized characters.

High Quality For documents with small characters or thin lines, or documents 
printed using a dot-matrix printer.

High Speed Prints with the higher speed than the Normal mode, but the quality is 
less.

Password Enter the password to print the secure PDF.
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• Collated
Purpose:

To specify whether to sort the job.

Values:

• Output Size
Purpose:

To specify the output paper size for PDF.

Values:

*1 The default paper size is displayed.

• Layout
Purpose:

To specify the output layout.

Values:

PS Settings
Use the PS Settings menu to change printer settings that only affect jobs using the PostScript® emulation printer 
language.

NOTE: 

• Values marked by an asterisk (*) are the factory default menu settings.

• PS Error Report
Purpose:

To specify whether to print the contents of PostScript errors. The change becomes effective after the printer is turned 
off and then on again.

Values:

NOTE: 

• Instructions from the PS driver override the settings specified on the operator panel.

Off* Does not sort the job. 

On Sorts the job.

A4 - 210x297*1

Letter - 8.5x11*1

Auto

Auto %*

100% (No Zoom)

Booklet

2 Pages Up

4 Pages Up

Off Discards the print job without printing an error message.

On* Prints an error message before it discards the job.
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• PS Job Time-out
Purpose:

To specify the runtime of one PostScript job. The change becomes effective after the printer is turned off and then on 
again.

Values:

• PaperSelect Mode
Purpose:

To set the way to select the paper tray for PostScript mode. The change becomes effective after the printer is turned 
off and then on again.

Values:

Network Setup
Use the Network Setup menu to change the printer settings affecting jobs sent to the printer through the network.

NOTE: 

• Values marked by an asterisk (*) are the factory default menu settings.

• Ethernet

NOTE: 

• Ethernet feature is available only when the printer is connected using the wired network.

Purpose:

To specify the communication speed and the duplex settings of Ethernet. The change becomes effective after the 
printer is turned off and then on again.

Values:

• Wireless Status

NOTE: 

• Wireless Status feature is available only when the printer is connected using the wireless network.

Purpose:

To confirm the wireless communication status.

Values:

Off* Job time-out does not occur.

On 1min A PostScript error occurs if processing is not completed after the specified 
time.1-900min

Auto* The tray is selected as the same setting as in the PCL mode.

Select FromTray The tray is selected in a method compatible with regular PostScript printers.

Auto* Detects the Ethernet settings automatically.

10BASE-T Half Uses 10BASE-T Half-duplex.

10BASE-T Full Uses 10BASE-T Full-duplex.

100BASE-TX Half Uses 100BASE-TX Half-duplex.

100BASE-TX Full Uses 100BASE-TX Full-duplex.

1000BASE-T Full Uses 1000BASE-T Full-duplex.

Connection Displays the connection condition.
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• Wireless Setup

NOTE: 

• Wireless Setup feature is available only when the printer is connected using the wireless network.

Purpose:

To configure the wireless network interface. The printer automatically searches and list available access points. 
Select one of the access points, and enter a pass phrase or WEP Key to complete the wireless setup. You can also 
specify and configure the wireless network manually.

Values:

Select access Select the desired access point 
from the list, or select Manual 
Setup to specify and configure 
wireless network manually.

PassPhraseEntry Displayed when the selected 
access point uses the security 
method of WPA-PSK-TKIP or 
WPA2-PSK-AES. Specify the 
pass phrase of 8 to 63 
alphanumeric characters.

WEP Key Displayed when the selected 
access point uses the security 
method of WEP. Specify the 
WEP key of 10 or 26 
hexadecimal characters.

The transmit key is set to Auto.
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Manual 
Setup

Enter (SSID) Specify a name to identify the 
wireless network. Up to 32 
alphanumeric characters can 
be entered.

Network 
Mode

Infrastructure Select to configure the wireless 
setting through the access 
point such as a wireless router.

Encryption 
Type

No Security Specify No Security to 
configure the wireless setting 
without specifying a security 
method from Mixed mode PSK, 
WPA-PSK-TKIP, 
WPA2-PSK-AES, and WEP.

Mixed mode PSK Specify Mixed mode PSK to 
automatically select an 
available encryption method 
from WPA-PSK-TKIP or 
WPA2-PSK-AES.

PassPhrase
Entry

Specify the pass phrase for 
Mixed mode PSK. Enter 8 to 63 
alphanumeric characters.

WPA-PSK-TKIP Select to configure the wireless 
setting with the security method 
of WPA-PSK-TKIP.

PassPhrase
Entry

Specify the pass phrase for 
WPA-PSK-TKIP. Enter 8 to 63 
alphanumeric characters.

WPA2-PSK-AES Select to configure the wireless 
setting with the security method 
of WPA2-PSK-AES.

PassPhrase
Entry

Specify the pass phrase for 
WPA2-PSK-AES. Enter 8 to 63 
alphanumeric characters.

WEP Select to configure the wireless 
setting with the security method 
of WEP.

WEP Key Specify the WEP Key to use 
through the wireless network. 
Enter 10 or 26 hexadecimal 
characters.

Transmit 
Key

Specify the transmit key from 
Auto, WEP Key1, WEP Key2, 
WEP Key3, and WEP Key4.

Ad-hoc Select to configure the wireless 
setting without the access point 
such as a wireless router.

Encryption 
Type

No Security Specify No Security to 
configure the wireless setting 
without specifying a security 
method of WEP.

WEP Select to configure the wireless 
setting with the security method 
of WEP.

WEP Key Specify the WEP Key to use 
through the wireless network. 
Enter 10 or 26 hexadecimal 
characters.

Transmit 
Key

Specify the transmit key from 
WEP Key1, WEP Key2, WEP 
Key3, and WEP Key4.
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• WPS Setup

NOTE: 

• WPS Setup feature is available only when the printer is connected using the wireless network.

Purpose:

To configure the wireless setting with the security method of WPS.

Values:

• Reset Wireless

NOTE: 

• Reset Wireless feature is available only when the printer is connected using the wireless network.

Purpose:

To initialize wireless network settings. After executing this function and rebooting the printer, all wireless network 
settings are reset to their default values.

Push Btn. Ctrl Cancel Cancels the wireless setting with the security method of WPS-PBC.

Start Starts the wireless setting with the security method of WPS-PBC.

PIN Code Start Config. Configures the wireless setting using the PIN code assigned 
automatically by the printer.

Print PIN Code Prints the PIN code. Confirm it when entering PIN assigned to the 
printer into your computer.
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• TCP/IP
Purpose:

To configure TCP/IP settings. 

Values:

*1 IPsec feature is available only when IPsec is enabled on the CentreWare Internet Services.

IP Mode Dual Stack* Uses both IPv4 and IPv6 to set the IP address.

IPv4 Uses IPv4 to set the IP address.

IPv6 Uses IPv6 to set the IP address.

IPv4 Get IP Address DHCP / Autonet* Sets the IP address automatically. A random value in the 
range of 169.254.1.0 to 169.254.254.255 that is not 
currently in use on the network is set as the IP address. The 
subnet mask is set as 255.255.0.0.

BOOTP Sets the IP address using BOOTP.

RARP Sets the IP address using RARP. 

DHCP Sets the IP address using DHCP.

Panel Use this option when you want to set the IP address manually 
on the operator panel.

IP Address When an IP address is being set manually, the IP is allocated 
to the printer using the format nnn.nnn.nnn.nnn. Each octet 
that makes up nnn.nnn.nnn.nnn is a value in the range of 0 
to 254. 127 and any value in the range of 224 to 254 cannot 
be specified for the first octet of a gateway address. 

Subnet Mask When an IP address is being set manually, the subnet mask is 
specified using the format nnn.nnn.nnn.nnn. Each octet 
that makes up nnn.nnn.nnn.nnn is a value in the range of 0 
to 255. 255.255.255.255 cannot be specified as the 
subnet mask.

Gateway Address When an IP address is being set manually, the gateway 
address is specified using the format nnn.nnn.nnn.nnn. 
Each octet that makes up nnn.nnn.nnn.nnn is a value in 
the range of 0 to 254. 127 and any value in the range of 224 
to 254 cannot be specified for the first octet of a gateway 
address. 

IPsec*1 Disable Disables IPsec.
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• Protocol
Purpose:

To enable or disable each protocol. The change becomes effective after the printer is turned off and then on again.

Values:

*1 HTTP-SSL/TLS is available only when a certificate is created using CentreWare Internet Services. For details about creating a 
certificate, see the Help on the CentreWare Internet Services.

• IP Filter

NOTE: 

• IP Filter feature is available only when LPD or Port9100 under Protocol is set to Enable.

Purpose:

To block data received from certain IP addresses through the wired network. You can set up to five IP addresses. 
The change becomes effective after the printer is turned off and then on again.

Values:

LPD Disable Disables the Line Printer Daemon (LPD) port.

Enable* Enables the LPD port.

Port9100 Disable Disables the Port9100 port.

Enable* Enables the Port9100 port.

FTP Disable Disables the FTP port.

Enable* Enables the FTP port.

IPP Disable Disables IPP port.

Enable* Enables IPP port.

SMB (TCP/IP) Disable Disables SMB TCP/IP port.

Enable* Enables SMB TCP/IP port.

SMB (NetBEUI) Disable Disables SMB Net BEUI port.

Enable* Enables SMB Net BEUI port.

WSD Disable Disables WSD port.

Enable* Enables WSD port.

SNMP (UDP/IP) Disable Disables the Simple Network Management Protocol (SNMP) UDP port.

Enable* Enables the SNMP UDP port.

StatusMessenger Disable Disables the Status Messenger feature.

Enable* Enables the Status Messenger feature.

InternetServices Disable Disables an access to CentreWare Internet Services embedded in the 
printer.

Enable* Enables an access to CentreWare Internet Services embedded in the 
printer.

Bonjour(mDNS) Disable Disables Bonjour® (mDNS).

Enable* Enables Bonjour (mDNS).

Telnet Disable* Disables Telnet.

Enable Enables Telnet.

HTTP-SSL/TLS*1 Disable Disables HTTP-SSL/TLS.

Enable* Enables HTTP-SSL/TLS.

No. n / Address (n is 1–5.) Sets the IP address for Filter n.

No. n / Mask (n is 1–5.) Sets the address mask for Filter n.

No. n / Mode (n is 1–5.) Off* Disables the IP Filter feature for Filter n.

Accept Accepts an access from the specified IP address.

Reject Rejects an access from the specified IP address.
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• IEEE 802.1x

NOTE: 

• IEEE 802.1x feature is available only when the printer is connected using LAN cable and the IEEE 802.1x authentication is 
enabled using CentreWare Internet Services. For details about setting IEEE 802.1x, see the Help on the CentreWare Internet 
Services.

Purpose:

To disable IEEE 802.1x authentication. The change becomes effective after the printer is turned off and then on 
again.

Value:

• Initialize NVM
Purpose:

To initialize wired and wireless network data stored in non-volatile memory (NVM). After executing this function and 
rebooting the printer, all wired and wireless network settings are reset to their default values.

• Adobe Protocol
Purpose:

To specify PostScript communication protocol for a parallel interface, you can configure the Adobe Protocol settings 
for the wired network. The change becomes effective after the printer is turned off and then on again.

Values:

USB Settings
Use the USB Settings menu to change printer settings affecting a USB port.

NOTE: 

• Values marked by an asterisk (*) are the factory default menu settings.

• Port Status

NOTE: 

• Port Status feature is available only for the USB port on the rear of the printer.

Purpose:

To specify whether to enable the USB port. The change becomes effective after the printer is turned off and then on 
again.

Values:

Disable Disables IEEE 802.1x.

Auto* Sets the PostScript communications protocol automatically.

Standard Sets the PostScript communications protocol to Standard.

BCP Sets the PostScript communications protocol to BCP.

TBCP Sets the PostScript communications protocol to TBCP.

Binary Sets the PostScript communications protocol to Binary.

Disable Disables the USB port.

Enable* Enables the USB port.
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• Adobe Protocol
Purpose:

To specify PostScript communication protocol. You can configure the Adobe Protocol settings for the wired 
network. The change becomes effective after the printer is turned off and then on again.

Values:

System Settings
Use System Settings to configure a variety of printer features.

NOTE: 

• Values marked by an asterisk (*) are the factory default menu settings.

• Power Saver Time
Purpose:

To specify the time for transition to Power Saver mode.

Values:

Select 1min (default) for Low Power Timer if your printer shares an electrical circuit with your room lights and you 
notice them flickering. Otherwise, select a high value to keep your printer available for frequent use with the 
minimum warm-up time.

The printer automatically returns to the standby mode from the Power Saver mode when it receives data from the 
computer. You can also change the status of the printer to the standby mode by pressing the  (Energy Saver) 
button on the operator panel.

• Auto Reset
Purpose:

To automatically reset the settings to the default settings and return to the standby mode after you do not specify any 
settings for the specified time.

Values:

Auto Sets the PostScript communications protocol automatically.

Standard Sets the PostScript communications protocol to Standard.

BCP Sets the PostScript communications protocol to BCP.

TBCP* Sets the PostScript communications protocol to TBCP.

Binary Sets the PostScript communications protocol to Binary.

Low Power 
Timer

1min* Specifies the time taken by the printer to enter Low Power mode after 
it finishes a job.1–60 min

Sleep Timer 1min* Specifies the time taken by the printer to enter Sleep mode after it has 
entered Low Power mode.1–60 min

45sec*

1min

2min

3min

4min
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• Fault Time-out
Purpose:

To specify the amount of time the printer waits before canceling a job that stops abnormally. The print job is 
cancelled if the time-out time is exceeded. 

Values:

• Job Time-out
Purpose:

To specify the amount of time the printer waits for data to arrive from the computer. The print job is cancelled if the 
time-out time is exceeded.

Values:

• Clock Settings
Purpose:

To specify the date and time formats.

Values:

*1 The default for Date Format varies depending on region-specific factory default.

Off Disables the fault time-out.

On* 60sec* Sets the amount of time the printer waits before canceling a job that 
stops abnormally.3–300 sec

Off Disables the job time-out.

On* 30sec* Sets the time the printer waits for data to arrive from the computer.

5–300 sec

Set Date & Time Time Zone Sets the time zone. 

Set Date Sets the date depending on the Date Format settings.

Set Time Sets the time.

Date Format yy/mm/dd*1 Sets the date format.

mm/dd/yy

dd/mm/yy

Time Format 12H Sets the time in 12-hour format.

24H* Sets the time in 24-hour format.
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• Audio Tones
Purpose:

To configure settings for tones emitted by the printer during operation or when a warning message appears.

Values:

• mm / inch
Purpose:

To specify the default measurement unit displayed after the numeric value on the operator panel.

Values:

NOTE: 

• The default for mm / inch varies depending on other settings, such as Region and Document Size.

• DefaultPaperSize
Purpose:

To specify the default paper size.

Values:

NOTE: 
• The default for DefaultPaperSize varies depending on region-specific factory default.

Control Panel Off* Does not emit a tone when the operator panel input is correct.

On Emits a tone when the operator panel input is correct.

Invalid Key Off* Does not emit a tone when the operator panel input is incorrect.

On Emits a tone when the operator panel input is incorrect.

Machine Ready Off Does not emit a tone when the printer is ready to process a job.

On* Emits a tone when the printer is ready to process a job.

Job Completed Off Does not emit a tone when a job is complete.

On* Emits a tone when a job is complete.

Fault Tone Off Does not emit a tone when a job ends abnormally.

On* Emits a tone when a job ends abnormally.

Alert Tone Off Does not emit a tone when a problem occurs.

On* Emits a tone when a problem occurs.

Out of Paper Off Does not emit a tone when the printer runs out of paper.

On* Emits a tone when the printer runs out of paper.

Low Toner Alert Off Does not emit a tone when a toner is low.

On* Emits a tone when a toner is low.

AutoClear Alert Off* Does not emit a tone 5 seconds before the printer performs auto

clear.

On Emits a tone 5 seconds before the printer performs auto clear.

All Tones Off Disables all the alert tones.

On Sets the volume of all the alert tones at once.

Millimeters(mm)* Selects millimeter as the default measurement unit.

Inches(") Selects inch as the default measurement unit.

A4 - 210x297

Letter - 8.5x11
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• Auto Job History
Purpose:

To automatically print a job history report after every 20 jobs.

Values:

The job history report can also be printed using the Report / List menu.

• 2-Sided Report
Purpose:

To specify whether to print on both sides.

Values:

• Print ID
Purpose:

To specify a location where the user ID is printed. 

Values:

NOTE: 

• When you print on DL size paper, a part of the user ID may not be printed correctly.

• Print Text
Purpose:

To specify whether the printer outputs PDL data, which is not supported by the printer, as text when the printer 
receives it. Text data is printed on A4 or Letter size paper.

Values:

Off* Does not automatically print a job history report.

On Automatically prints a job history report.

1-Sided* Prints on one side of a sheet of paper.

2-Sided Prints on both sides of a sheet of paper.

Off* Does not print the user ID.

Top Left Prints the user ID on the top left of the page.

Top Right Prints the user ID on the top right of the page.

Bottom Left Prints the user ID on the bottom left of the page.

Bottom Right Prints the user ID on the bottom right of the page.

Off Does not print the received data.

On* Prints the received data as text data.
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• Banner Sheet

NOTE: 

• Banner Sheet feature is available only when the optional 550 sheet feeder is installed on the printer.

Purpose:

To specify the position of banner sheet, and also specify the tray in which the banner sheet is loaded. 

Values:

*1 Tray2 is available only when the optional 550 sheet feeder is installed.
*2 Tray3 is available only when two or more optional 550 sheet feeders are installed.
*3 Tray4 is available only when three optional 550 sheet feeders are installed.

• RAM Disk

NOTE: 

• RAM Disk feature is available only when the optional 512MB memory is installed on the printer.

Purpose:

To allocate memory to the RAM disk file system for the Secure Print and Sample Print features. The change 
becomes effective after the printer is turned off and then on again.

Values:

NOTE: 

• Restart your printer when you change the settings for the RAM Disk menu.

• Substitute Tray
Purpose:

Specifies whether to use paper of a different size when the paper that is loaded in the specified tray does not match 
the paper size settings for the current job.

Values:

Insert Position Off* Does not print the banner sheet.

Start Sheet Inserted before the first page of every job.

End Sheet Inserted after the last page of every job.

Start&End 
Sheet

Inserted before the first page of every job and after the last page of 
every job.

Select Tray Bypass Tray The banner sheet is loaded in the bypass tray.

Tray1* The banner sheet is loaded in the standard 550 sheet tray.

Tray2*1 The banner sheet is loaded in the optional 550 sheet feeder.

Tray3*2 The banner sheet is loaded in the optional 550 sheet feeder.

Tray4*3 The banner sheet is loaded in the optional 550 sheet feeder.

Disable Does not allocate memory to the RAM disk file system. Secure Print 
and Sample Print jobs will abort and be recorded to the job log.

Enable* 200MB* Sets the allocation of memory to the RAM disk file system in 
increments of 50 MB.50-350MB

Off* No tray size substitute accepted.

Larger Size Substitutes paper of next largest size. When there is no larger paper 
size, the printer substitutes paper of nearest size.

Closest Size Substitutes paper of nearest size.

Bypass Tray Substitutes paper from the bypass tray.



182 Using the Operator Panel Menus

• Auditron Mode
Purpose:

To specify whether to limit the functions that can be used per user by Auditron authentication.

Values:

• No Acct User Prt
Purpose:

To specify whether to permit the printing of data without authentication information.

Values:

• LetterH Dup Mode
Purpose:

To specify whether to print on both sides when you use letterhead.

Values:

• Low Toner Msg
Purpose:

To specify whether to show the alert message when the toner is low.

Values:

• FW Download Mode
Purpose:

To specify whether to update the printer by downloading firmware.

Values:

Off* Does not limit functions by Auditron authentication.

On Limits functions by Auditron authentication.

Off* Does not permit non-account user to print the data.

On Permits non-account user to print the data.

Disable* Does not print on both sides of letterhead.

Enable Prints on both sides of letterhead.

Off Does not show the alert message when the toner is low.

On* Shows the alert message when the toner is low.

Disable Disables updating the printer.

Enable* Enables updating the printer.
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Maintenance Mode
Use the Maintenance Mode menu to initialize the NV (non-volatile) memory, configure the plain paper quality 
adjustment settings, and configure the security settings.

NOTE: 

• Values marked by an asterisk (*) are the factory default menu settings.

• F/W Version
Purpose:

To confirm the current F/W version.

• Adjust PaperType
Purpose:

To specify paper density settings.

Values:

• Adjust TransUnit
Purpose:

To specify the transfer unit voltage adjustment for each paper type.

The default settings may not give the best output on all paper types. If you see mottles on the print output, try to 
increase the voltage. If you see white spots on the print output, try to decrease the voltage.

NOTE: 

• The print quality changes depending on the setting values you select for this item.

Values:

Plain Lightweight

Heavyweight*

Plain 0*

-5 to +10

Plain Thick 0*

-5 to +10

Light Card 0*

-5 to +10

Heavy Card 0*

-5 to +10

Envelope 0*

-5 to +10

Labels 0*

-5 to +10
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• AdjustFusingUnit
Purpose:

To adjust the fusing temperature setting for each paper type.

The default settings may not give the best output on all paper types. When the printed paper has curled, try to lower 
the temperature. When the toner does not fuse on the paper properly, try to increase the temperature.

NOTE: 

• The print quality changes depending on the setting values you select for this item.

Values:

• Adjust Density
Purpose:

To adjust density level.

Values:

• Chart
Purpose:

To print various charts that can be used for diagnosis of the printer.

Values:

• Clean Developer
Purpose:

To stir the developer in a drum cartridge.

Plain 0*

-3 to +3

Plain Thick 0*

-3 to +3

Light Card 0*

-3 to +3

Heavy Card 0*

-3 to +3

Envelope 0*

-3 to +3

Labels 0*

-3 to +3

0*

-3 to +3

Pitch Chart Prints a full halftone page. Also prints a page to check 
the pitch. A total of two pages are printed.

Full Page Solid 1-Sided Prints a chart of the full page solid on the paper.

2-Sided Prints a chart of the full page solid on both sides of the 
paper.

Alignment Chart Prints a chart to check for proper alignment of the print 
image on the paper.



Using the Operator Panel Menus 185

• Clean TransUnit
Purpose:

To clean the transfer unit.

• Toner Refresh
Purpose:

To clean the toner in a drum cartridge.

NOTE: 

• Toner Refresh feature uses the toner, and shorten the life of the toner cartridge and the drum cartridge.

• Initialize NVM
Purpose:

To initialize the non-volatile (NV) memory. After executing this function and rebooting the printer, all the menu 
parameters, except the parameters for the network, are reset to their default values.

See also: 
• "Resetting to Factory Defaults" on page 199

• Init Print Meter
Purpose:

To initialize the print meter of the printer. When the print meter is initialized, the meter count is reset to zero.

• Reset TransUnit
Purpose:

To initialize the transfer unit counter.

• Reset FusingUnit
Purpose:

To initialize the life counter of the fusing unit. After replacing the fusing unit, be sure to initialize its life counter.

• Clear JobHistory
Purpose:

To clear the job history of all finished jobs.

• Clear Storage

NOTE: 

• Clear Storage feature is available only when the optional 512MB memory or the optional hard disk unit is installed.

Purpose:

To clear all files stored as Secure Print and Sample Print in the RAM disk or hard disk.

Values:

All Clear Deletes all files stored as Secure Print and Sample Print in the RAM 
disk or hard disk.

Secure Document Deletes all files stored as Secure Print in the RAM disk or hard disk.

Stored Document Deletes all files stored as Sample Print in the RAM disk or hard disk.
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• Format HDD

NOTE: 

• Format HDD feature is available only when the optional hard disk unit is installed.

Purpose:

To initialize the optional hard disk unit.

• Non-Genuine
Purpose:

To use toner cartridge of another manufacturer.

NOTE: 

• Using a non-Fuji Xerox toner cartridge may severely damage your printer. The warranty does not cover damages caused by 
using non-Fuji Xerox toner cartridge.

Values:

• Adjust Altitude
Purpose:

To specify the altitude of the location where the printer is installed.

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 
performed by specifying the altitude of the location where the printer is being used.

NOTE: 

• An incorrect altitude adjustment setting leads to problems such as poor printing quality and incorrect indication of remaining 
toner.

Values:

• StaticMemory Ctr
Purpose:

To widen the print gap not to leave toner streak on the next page.

NOTE: 

• StaticMemory Ctr feature shortens the life of the drum cartridge.

Values:

• Ghost Control
Purpose:

To reduce negative ghost.

Values:

Toner Off* Does not use toner cartridge of another manufacturer.

On Uses toner cartridge of another manufacturer.

0m* Sets the altitude of the location where the printer is installed.

1000m

2000m

3000m

Off* Does not widen the print gap.

On Widens the print gap.

Off* Does not reduce negative ghost.

On Reduces negative ghost.
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Secure Settings
Use the Secure Settings menu to set a password to limit access to the menus. This prevents items from being 
changed accidentally.

NOTE: 

• Values marked by an asterisk (*) are the factory default menu settings.

• Panel Lock
Purpose:

To set a limited access to Admin Menu with a password, and to set or change the password. 

See also: 
• "Panel Lock Function" on page 196

Values:

*1 This item is available only when Panel Lock Set is set to Enable.

• Data Encryption
Purpose:

To disable or enable data encryption when using the printer.

Values:

• HDD Over write

NOTE: 

• HDD Over write feature is available only when the optional hard disk unit is installed.

• Overwrite of the hard disk may take several hours. When overwriting the hard disk, all functions of the printer are inoperable.

Purpose:

To erase the contents of the entire optional hard disk unit by overwriting the optional hard disk unit with meaningless 
data.

Values:

Panel Lock Set Disable* Disables password protection for Admin Menu.

Enable Enables password protection for Admin Menu.

Change Password*1 0000–9999 Sets or changes the password required to access Admin 
Menu.

Encryption Off* Disables encryption of the data.

On Enables encryption of the data.

Encryption Key Sets a key that is required for encryption.

Off* Disables overwrite of the optional hard disk unit.

1Time Overwrites the optional hard disk unit once.

3Times Overwrites the optional hard disk unit three times.
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• Login Error

NOTE: 

• Login Error feature is available only when Panel Lock Set is set to Enable.

Purpose:

To specify the number of error entry attempts allowed when you log in as an administrator in the Admin Menu and 
Report / List menu.

Values:

 Tray Settings
Use the Tray Settings menu to define the print media loaded in the bypass tray, the standard 550 sheet tray and 
the optional 550 sheet feeder.

NOTE: 

• Values marked by an asterisk (*) are the factory default menu settings.

Off* Does not allow an administrator to log in after one error entry attempt.

On 5 times* Sets the number of error entry attempts allowed when an 
administrator logs in.1-10
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Bypass Tray
Purpose:

To specify the paper loaded in the bypass tray.

Values:

Paper Size

mm series

Driver Size*

A4 - 210x297

A5 - 148x210

B5 - 182x257

Letter - 8.5x11

Folio - 8.5x13

Legal - 8.5x14

Executive

Monarch Env.

DL Env- 110x220

C5 Env- 162x229

#10Env- 4.1x9.5

New Custom Size Portrait(Y) 297 mm* Specifies the 
length of the 
custom size paper.

127 - 355 mm

Landscape(X) 210 mm* Specifies the width 
of the custom size 
paper.

77 - 215 mm

inch series Driver Size*

Letter - 8.5x11

Folio - 8.5x13

Legal - 8.5x14

Executive

A4 - 210x297

A5 - 148x210

B5 - 182x257

Monarch Env.

DL Env- 110x220

C5 Env- 162x229

#10Env- 4.1x9.5

New Custom Size Portrait(Y) 11.7"* Specifies the 
length of the 
custom size paper.

5.0-14.0"

Landscape(X) 8.3"* Specifies the width 
of the custom size 
paper.

3.0-8.5"

Paper Type Plain*

Plain Thick

Light Card

Heavy Card

Envelope

Labels

Letterhead

Hole Punched

Colored

Other Type
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NOTE: 
• When MPT mode is set to DriverSpecified, Paper Size, Paper Type, and Display Screen are not available.

• For more information on supported paper sizes, see also "Usable Print Media" on page 118.

Tray1
Purpose:

To specify the paper loaded in the standard 550 sheet tray. 

Values:

NOTE: 
• For more information on supported paper sizes, see also "Usable Print Media" on page 118.

MPT mode Panel Specified Configures the paper size and type on the operator panel.

DriverSpecified* Configures the paper size and type on the print driver.

Display Screen Off Does not display a popup menu that prompts to set Paper 
Type and Paper Size when paper is loaded in the bypass tray.

On* Displays a popup menu that prompts to set Paper Type and 
Paper Size when paper is loaded in the bypass tray.

Paper Size

mm series

Auto*

New Custom Size Portrait(Y) 297 mm* Specifies the 
length of the 
custom size paper.

210 - 355 mm

Landscape(X) 210 mm* Specifies the width 
of the custom size 
paper.

140 - 215 mm

inch series Auto*

New Custom Size Portrait (Y) 11.7"* Specifies the 
length of the 
custom size paper.

8.3-14.0"

Landscape (X) 8.3"* Specifies the width 
of the custom size 
paper.

5.5-8.5"

Paper Type Plain*

Plain Thick

Light Card

Heavy Card

Labels

Letterhead

Hole Punched

Colored

Other Type

Display Screen Off Does not display a popup menu that prompts to set Paper 
Type and Paper Size when paper is loaded in the standard 
550 sheet tray.

On* Displays a popup menu that prompts to set Paper Type and 
Paper Size when paper is loaded in the standard 550 sheet 
tray.
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Tray2

NOTE: 

• Tray2 is available only when the optional 550 sheet feeder is installed.

Purpose:

To specify the paper loaded in the optional 550 sheet feeder.

NOTE: 

• For more information on supported paper sizes, see also "Usable Print Media" on page 118.

Paper Size

mm series

Auto*

New Custom Size Portrait(Y) 297 mm* Specifies the 
length of the 
custom size paper.

210-355 mm

Landscape(X) 210 mm* Specifies the width 
of the custom size 
paper.

140-215 mm

inch series Auto*

New Custom Size Portrait(Y) 11.7"* Specifies the 
length of the 
custom size paper.

8.3-14.0"

Landscape(X) 8.3"* Specifies the width 
of the custom size 
paper.

5.5-8.5"

Paper Type Plain*

Plain Thick

Light Card

Heavy Card

Labels

Letterhead

Hole Punched

Colored

Other Type

Display Screen Off Does not display a popup menu that 
prompts to set Paper Type and Paper 
Size when paper is loaded in the optional 
550 sheet feeder.

On* Displays a popup menu that prompts to 
set Paper Type and Paper Size when 
paper is loaded in the optional 550 sheet 
feeder.
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Tray3

NOTE: 

• Tray3 is available only when two or more optional 550 sheet feeders are installed.

Purpose:

To specify the paper loaded in the optional 550 sheet feeder.

NOTE: 
• For more information on supported paper sizes, see also "Usable Print Media" on page 118.

Paper Size

mm series

Auto*

New Custom Size Portrait(Y) 297 mm* Specifies the 
length of the 
custom size paper.

210-355 mm

Landscape(X) 210 mm* Specifies the width 
of the custom size 
paper.

140-215 mm

inch series Auto*

New Custom Size Portrait(Y) 11.7"* Specifies the 
length of the 
custom size paper.

8.3-14.0"

Landscape(X) 8.3"* Specifies the width 
of the custom size 
paper.

5.5-8.5"

Paper Type Plain*

Plain Thick

Light Card

Heavy Card

Labels

Letterhead

Hole Punched

Colored

Other Type

Display Screen Off Does not display a popup menu that 
prompts to set Paper Type and Paper 
Size when paper is loaded in the optional 
550 sheet feeder.

On* Displays a popup menu that prompts to 
set Paper Type and Paper Size when 
paper is loaded in the optional 550 sheet 
feeder.
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Tray4

NOTE: 

• Tray4 is available only when three optional 550 sheet feeders are installed.

Purpose:

To specify the paper loaded in the optional 550 sheet feeder.

NOTE: 
• For more information on supported paper sizes, see also "Usable Print Media" on page 118.

Paper Size

mm series

Auto*

New Custom Size Portrait(Y) 297 mm* Specifies the 
length of the 
custom size paper.

210-355 mm

Landscape(X) 210 mm* Specifies the width 
of the custom size 
paper.

140-215 mm

inch series Auto*

New Custom Size Portrait(Y) 11.7"* Specifies the 
length of the 
custom size paper.

8.3-14.0"

Landscape(X) 8.3"* Specifies the width 
of the custom size 
paper.

5.5-8.5"

Paper Type Plain*

Plain Thick

Light Card

Heavy Card

Labels

Letterhead

Hole Punched

Colored

Other Type

Display Screen Off Does not display a popup menu that 
prompts to set Paper Type and Paper 
Size when paper is loaded in the optional 
550 sheet feeder.

On* Displays a popup menu that prompts to 
set Paper Type and Paper Size when 
paper is loaded in the optional 550 sheet 
feeder.
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Tray Priority
Purpose:

To set the priority order of the paper trays for automatic tray selection. If paper trays loaded with the same paper size 
and type exists, the paper tray is selected according to this priority order.

Values:

NOTE: 

• Tray2, Tray3, Tray4, 3rd Priority, 4th Priority, and 5th Priority are available only when the optional 550 
sheet feeder is installed.

• The paper tray name is not displayed in the priority menu after once selected.

1st Priority Bypass Tray* Sets the bypass tray as the first priority.

Tray1 Sets the standard 550 sheet tray as the first priority.

Tray2 Sets the optional 550 sheet feeder as the first 
priority.

Tray3 Sets the optional 550 sheet feeder as the first 
priority.

Tray4 Sets the optional 550 sheet feeder as the first 
priority.

2nd Priority Bypass Tray Sets the bypass tray as the second priority.

Tray1* Sets the standard 550 sheet tray as the second 
priority.

Tray2 Sets the optional 550 sheet feeder as the second 
priority.

Tray3 Sets the optional 550 sheet feeder as the second 
priority.

Tray4 Sets the optional 550 sheet feeder as the second 
priority.

3rd Priority Bypass Tray Sets the bypass tray as the third priority.

Tray1 Sets the standard 550 sheet tray as the third 
priority.

Tray2* Sets the optional 550 sheet feeder as the third 
priority.

Tray3 Sets the optional 550 sheet feeder as the third 
priority.

Tray4 Sets the optional 550 sheet feeder as the third 
priority.

4th Priority Bypass Tray Sets the bypass tray as the fourth priority.

Tray1 Sets the standard 550 sheet tray as the fourth 
priority.

Tray2 Sets the optional 550 sheet feeder as the fourth 
priority.

Tray3* Sets the optional 550 sheet feeder as the fourth 
priority.

Tray4 Sets the optional 550 sheet feeder as the fourth 
priority.

5th Priority Bypass Tray Sets the bypass tray as the fourth priority.

Tray1 Sets the standard 550 sheet tray as the fifth priority.

Tray2 Sets the optional 550 sheet feeder as the fifth 
priority.

Tray3 Sets the optional 550 sheet feeder as the fifth 
priority.

Tray4* Sets the optional 550 sheet feeder as the fifth 
priority.
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 Panel Language
Purpose:

To determine the language of the text on the LCD panel.

Values:

English

Simplified Chinese

Traditional Chinese

Korean
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Panel Lock Function
This feature prevents unauthorized users from changing settings made by the administrator. However, you can 
select settings for individual print jobs using the print driver.

This section includes:

• "Enabling the Panel Lock" on page 196

• "Disabling the Panel Lock" on page 196

NOTE: 

• Disabling the operator panel menus does not prevent access to the Secure Print, Sample Print and Tray Settings 
menus.

 Enabling the Panel Lock

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Secure Settings, and then press the  button.

4 Select Panel Lock, and then press the  button.

5 Select Panel Lock Set, and then press the  button.

6 Select Enable, and then press the  button.

7 Enter the new password, and then press the  button.

8 Re-enter the password to confirm the password that you entered, and then press the  button.

NOTE: 

• The factory-default panel password is 0000.

• If you forget your password, turn off the printer. Then, while holding the  (Menu) button, turn on the printer. Continue to 
hold the  (Menu) button until the display indicates to enter the new password. Enter the new password, and then press the 

 button. Re-enter the password, and then press the  button. The display will briefly indicate the password has been 
initialized.

• If you change the password, perform steps 1 to 2. Enter the current password, and then press the  button. Perform steps 3 
to 4. Select Change Password, and then press the  button. Enter the current password, and then press the  button. 
Perform steps 7 and 8. This will change the password.

 Disabling the Panel Lock

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Enter the password, and then press the  button.

4 Select Secure Settings, and then press the  button.

5 Select Panel Lock, and then press the  button.

6 Select Panel Lock Set, and then press the  button.

7 Select Disable, and then press the  button.

8 Enter the current password, and then press the  button.
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Changing the Language
To change language used on the operator panel:

1 Press the  (Menu) button.

2 Select Panel Language and then press the  button.

3 Select the desired language, and then press the  button.



198 Using the Operator Panel Menus

Setting the Power Saver Time Option
You can set the power saver time for the printer. The printer switches to the Power Saver mode after the specified 
time.

NOTE: 

• If the Panel Lock Set is set to Enable, you need to enter the four digit password to enter the Admin Menu.

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select System Settings, and then press the  button.

4 Select Power Saver Time, and then press the  button.

5 Select Low Power Timer or Sleep Timer, and then press the  button.

6 Press the  or  button or enter the desired value, and then press the  button.

You can select from 1–60 minutes for Low Power Timer or 1–60 minutes for Sleep Timer.

7 To return to the previous screen, press the  (Back) button.
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Resetting to Factory Defaults
After executing this function and rebooting the printer, all the menu parameters, except the parameters for the 
network, are reset to their default values.

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Initialize NVM, and then press the  button.

5 Ensure that Are You Sure? appears, and then press the  button.

The printer restarts automatically to apply the settings.
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7
Troubleshooting

This chapter includes:

• "Clearing Jams" on page 202

• "Basic Printer Problems" on page 222

• "Display Problems" on page 223

• "Printing Problems" on page 224

• "Print Quality Problems" on page 226

• "Noise" on page 240

• "Digital Certificate Problem" on page 241

• "Problems With Installed Optional Accessories" on page 242

• "Other Problems" on page 243

• "Understanding Printer Messages" on page 244

• "Contacting Service" on page 246

• "Getting Help" on page 247

• "Non-Genuine Mode" on page 248
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Clearing Jams
This section includes:

• "Avoiding Jams" on page 202

• "Identifying the Location of Paper Jams" on page 203

• "Clearing Paper Jams From the Bypass Tray" on page 204

• "Clearing Paper Jams From the Standard 550 Sheet Tray" on page 206

• "Clearing Paper Jams From the Fusing Unit" on page 208

• "Clearing Paper Jams From the Duplexer" on page 212

• "Clearing Paper Jams From the Regi Roll" on page 213

• "Clearing Paper Jams From the Optional 550 Sheet Feeder" on page 215

• "Jam Problems" on page 218

Careful selection of appropriate print media and proper loading allow you to avoid most jams. 

See also: 
• "About Print Media" on page 116

• "Supported Print Media" on page 118

NOTE: 

• Before buying large quantities of any print media, it is recommended that you try a sample first.

 Avoiding Jams
• Use only recommended print media.

• See "Loading Print Media in the Standard 550 Sheet Tray and the Optional 550 Sheet Feeder" on page 123 
and "Loading Print Media in the Bypass Tray" on page 126 to load print media properly.

• Do not overload the print media sources. Ensure that the print media stack height does not exceed the 
maximum height indicated by the load-line in the tray.

• Do not load wrinkled, creased, damp, or curled print media.

• Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at 
a time through the bypass tray.

• Do not use print media that you have cut or trimmed.

• Do not mix print media sizes, weights, or types in the same print media source.

• Ensure that the recommended print side is face up when you load the print media.

• Keep print media stored in an acceptable environment.

• Do not remove the feeding tray during a print job.

• Push the tray in firmly after loading.

• Ensure that all cables that connect to the printer are correctly attached.

• Overtightening the guides may cause jams.

• Wipe the feed roller in the tray or bypass tray with a cloth moistened with water if jams caused by misfeeding 
paper occur frequently.

See also: 

• "About Print Media" on page 116 

• "Supported Print Media" on page 118

• "Print Media Storage Guidelines" on page 117
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 Identifying the Location of Paper Jams

IMPORTANT: 

• Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path.

WARNING:

• If you cannot remove the paper jam by doing the procedures in the manual, do not try to forcibly remove the jam. 
Doing so may cause injuries. Contact your local Fuji Xerox representative.

WARNING:

• Fusing Unit Safety
Do not remove the Fusing Unit. If you cannot remove the paper jam by doing the procedures in the manual, do not 
try to forcibly remove the jam. Doing so may cause injuries. Contact your local Fuji Xerox representative.

CAUTION:

• Do not attempt to remove a paper deeply jammed inside the product, particularly a paper wrapped around the fusing 
unit or the heat roller. Otherwise, it may cause injuries or burns. Switch off the product immediately and contact 
your local Fuji Xerox representative.

1 Fusing Unit

2 Regi Roll

3 Duplexer

4 Optional Rear Door

5 Optional 550 Sheet Feeder

6 Standard 550 Sheet Tray

7 Bypass Tray

1

5

7

2

6

3

4
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 Clearing Paper Jams From the Bypass Tray
IMPORTANT: 

• Protect the drum of the drum cartridge against bright light. If the rear door remains open for more than 3 minutes, print quality 
may deteriorate.

NOTE: 

• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Remove the remaining documents from the bypass tray.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Pull the standard 550 sheet tray from the printer about 200 mm.

4 Hold the standard 550 sheet tray with both hands, and remove it from the printer.
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5 Pull the rear door handle to open the rear door.

6 Remove the jammed paper.

7 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 

• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

8 Insert the bypass tray into the printer, push until it stops, and close the cover.

9 Close the rear door, and press the  button.
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 Clearing Paper Jams From the Standard 550 Sheet Tray
IMPORTANT: 

• Protect the drum of the drum cartridge against bright light. If the rear door remains open for more than 3 minutes, print quality 
may deteriorate.

NOTE: 

• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Open the bypass tray cover.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Pull the standard 550 sheet tray from the printer about 200 mm.

4 Hold the standard 550 sheet tray with both hands, and remove it from the printer.
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5 Pull the rear door handle to open the rear door.

6 Remove the jammed paper.

7 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 

• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

8 Insert the bypass tray into the printer, push until it stops, and close the cover.

9 Close the rear door.
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 Clearing Paper Jams From the Fusing Unit
IMPORTANT: 

• Ensure nothing touches or scratches the surface (black-colored film) of the transfer unit. Scratches, dirt, or oil from your hands 
on the film of the transfer unit may reduce print quality.

• Protect the drum of the drum cartridge against bright light. If the rear door remains open for more than 3 minutes, print quality 
may deteriorate.

NOTE: 

• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Open the bypass tray cover, or remove the remaining documents from the bypass tray.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Pull the standard 550 sheet tray from the printer about 200 mm.

4 Hold the standard 550 sheet tray with both hands, and remove it from the printer.
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5 Pull the rear door handle to open the rear door.

6 Lift the levers on both sides of the fusing unit.

IMPORTANT: 

• The fusing unit is hot. Do not touch it, doing so may cause burns.

7 If the document is jammed under the fusing unit, remove the jammed document from under the fusing unit.

If the document is jammed above the fusing unit:

a Hold and lower the right side of the tab to open the inner part.
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b Remove the jammed document from above the fusing unit.

c Replace the inner part.

8 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 

• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

9 Insert the bypass tray into the printer, push until it stops, and close the cover.
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10 Press down the levers on both sides of the fusing unit, and then close the rear door.
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 Clearing Paper Jams From the Duplexer 
IMPORTANT: 

• Ensure nothing touches or scratches the surface (black-colored film) of the transfer unit. Scratches, dirt, or oil from your hands 
on the film of the transfer unit may reduce print quality.

• Protect the drum of the drum cartridge against bright light. If the rear door remains open for more than 3 minutes, print quality 
may deteriorate.

NOTE: 

• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Pull the rear door handle to open the rear door.

2 Remove the jammed paper from the duplexer.

3 Close the rear door.
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 Clearing Paper Jams From the Regi Roll
IMPORTANT: 

• Ensure nothing touches or scratches the surface (black-colored film) of the transfer unit. Scratches, dirt, or oil from your hands 
on the film of the transfer unit may reduce print quality.

• Protect the drum of the drum cartridge against bright light. If the rear door remains open for more than 3 minutes, print quality 
may deteriorate.

NOTE: 

• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Open the bypass tray cover, or remove the remaining documents from the bypass tray.

2 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

3 Pull the standard 550 sheet tray from the printer about 200 mm.

4 Hold the standard 550 sheet tray with both hands, and remove it from the printer.
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5 Pull the rear door handle to open the rear door.

\

6 Remove the jammed paper from the regi roll.

7 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 

• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

8 Insert the bypass tray into the printer, push until it stops, and close the cover.

9 Close the rear door.
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 Clearing Paper Jams From the Optional 550 Sheet Feeder
NOTE: 

• If two or more optional 550 sheet feeders are installed on the printer, perform the following procedure for the tray indicated in 
the error message displayed on the LCD panel.

• To resolve the error displayed on the LCD panel, you must clear all print media from the print media path.

1 Pull the optional 550 sheet feeder from the printer about 200 mm.

2 Hold the optional 550 sheet feeder with both hands, and remove it from the printer.

3 Pull the rear door handle to open the rear door.
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4 Remove the jammed paper. If you cannot remove the paper, go to step 5, and if you can remove, go to step 8.

5 Open the optional rear door.

6 Remove the jammed paper.

7 Close the optional rear door.
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8 Insert the optional 550 sheet feeder into the printer, and push until it stops.

IMPORTANT: 

• Do not use excessive force on the feeder. Doing so could damage the feeder or the inside of the printer.

9 Close the rear door.
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 Jam Problems
This section includes:

• "Standard 550 Sheet Tray/Optional 550 Sheet Feeder Misfeed Jam" on page 218

• "Bypass Tray Misfeed Jam" on page 219

• "Regi Jam (Exit Sensor On JAM)" on page 220

• "Exit Jam (Exit Sensor Off JAM)" on page 220

• "Standard 550 Sheet Tray/Optional 550 Sheet Feeder Multi-feed Jam" on page 221

• "Bypass Tray Multi-feed Jam" on page 221

Standard 550 Sheet Tray/Optional 550 Sheet Feeder Misfeed Jam

Problem Action

Print media misfeeds occur in the 
standard 550 sheet tray or the 
optional 550 sheet feeder.

Ensure that the standard 550 sheet tray or the optional 550 sheet feeder is properly 
inserted.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 118

If not, use the print media recommended for the printer.

If the problem persists, ensure that the print media is not curled.

Ensure that the print media is not curled.

If the problem persists, fan the print media.

Ensure that the print media is not damp.

If the print media is damp, turn over the print media.

If the problem persists, use print media that is not damp.

If the print media is not damp, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the standard 550 sheet tray or the 
optional 550 sheet feeder with a cloth moistened with water.

Wipe the feed roller in the standard 550 sheet tray or the optional 550 sheet feeder 
with a cloth moistened with water.

See also: 
• "Cleaning Inside the Printer" on page 250

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Bypass Tray Misfeed Jam

Problem Action

Print media misfeeds occur in the 
bypass tray.

Ensure that the bypass tray is properly inserted.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 118

If not, use the print media recommended for the printer.

If the problem persists when using cardstock paper, set Print Peeling Prevention 
Mode to On on the Advanced tab of the PCL 6 driver. For more information, refer to 
the Help provided for the PCL 6 driver.

If the problem persists, ensure that the print media is not damp.

Ensure that the print media is not curled.

If the problem persists, fan the print media.

Ensure that the print media is not damp.

If the print media is damp, turn over the print media.

If the problem persists, use print media that is not damp.

If the print media is not damp, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the bypass tray with a cloth moistened 
with water.

Wipe the feed roller in the bypass tray with a cloth moistened with water.

See also: 
• "Cleaning Inside the Printer" on page 250

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Regi Jam (Exit Sensor On JAM)

Exit Jam (Exit Sensor Off JAM)

Problem Action

Regi jam (Exit Sensor On JAM) 
occurs.

Ensure that the drum cartridge is installed correctly.

If the problem persists, replace the drum cartridge if you have a spare cartridge as 
instructed in "Replacing the Drum Cartridge" on page 257.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

If the problem persists, ensure that the fusing unit is installed correctly.

Ensure that the fusing unit is installed correctly.

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger Roll" on page 261.

Replace the fusing unit.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the problem persists, ensure that the transfer unit is installed correctly.

Ensure that the transfer unit is installed correctly.

If the problem persists, replace the transfer unit, the retard roll, and the feed roll as 
instructed in "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and 
Nudger Roll" on page 261.

Replace the transfer unit, the retard roll, and the feed roll.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

Exit jam (Exit Sensor Off JAM) 
occurs.

Ensure that the fusing unit is installed correctly.

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger Roll" on page 261.

Replace the fusing unit.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Standard 550 Sheet Tray/Optional 550 Sheet Feeder Multi-feed Jam

Bypass Tray Multi-feed Jam

Problem Action

Print media multiple feeds occur 
in the standard 550 sheet tray or 
optional 550 sheet feeder.

Ensure that the tray or feeder is properly inserted.

If the problem persists, use print media that is not damp.

Use print media that is not damp.

If the problem persists, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the tray or feeder where the multifeed 
occurred with a cloth moistened with water.

Wipe the feed roller in the tray or feeder where the multifeed occurred with a cloth 
moistened with water.

See also: 
• "Cleaning Inside the Printer" on page 250

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

Print media multiple feeds occur 
in the bypass tray.

Ensure that the media type you are using.

If the problem persists, use print media that is not damp.

Use print media that is not damp.

If the problem persists, fan the print media.

Fan the print media.

If the problem persists, wipe the feed roller in the tray where the multifeed occurred 
with a cloth moistened with water.

Wipe the feed roller in the tray where the multifeed occurred with a cloth moistened 
with water.

See also: 
• "Cleaning Inside the Printer" on page 250

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Basic Printer Problems
Some printer problems can be easily resolved. If a problem occurs with your printer, check each of the following:

• The power cord is connected to the printer, and to a properly grounded electrical outlet.

• The printer is turned on.

• The electrical outlet is not turned off at any switch or breaker.

• Other electrical equipment plugged into the outlet is working.

• All options are properly installed.

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, and then turn 
on the printer. This often fixes the problem.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer is 
turned off.

NOTE: 

• If error messages are displayed on the LCD panel screen or on your computer screen, follow the on-screen instructions to 
resolve the printer problems. For details about error messages and error codes, see "Understanding Printer Messages" on 
page 244.
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Display Problems

Problem Action

Menu settings changed from the 
operator panel have no effect.

Settings in the software program, the print driver, or the printer utilities have 
precedence over the settings made on the operator panel.
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Printing Problems

NOTE: 

• If Panel Lock Set is set to Enable, you need to enter the four digit password to enter the Admin Menu menu.

Problem Action

Job did not print or incorrect 
characters printed.

Ensure that the top menu appears on the LCD panel before you send a job to print. 
Press the  (Menu) button twice to return to the top menu.

Ensure that the print media is loaded in the printer. Press the  (Menu) button twice 
to return to the top menu.

Verify that you are using the correct print driver.

Ensure that the correct USB cable, Ethernet cable or wireless printer adapter is 
securely connected to the printer.

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

Check the printer's interface from the Admin Menu menu.

Determine the host interface you are using. Print a Panel Settings page to verify that 
the current interface settings are correct.

Print media misfeeds or multiple 
feeds occur.

Ensure that the print media you are using meets the specifications for your printer.

See also: 
• "Usable Print Media" on page 118

Fan the print media before loading it.

Ensure that the print media is loaded correctly.

Ensure that the width and length guides of the print media sources are adjusted 
correctly.

Ensure that the standard 550 sheet tray, the optional 550 sheet feeder, or the bypass 
tray is securely inserted.

Do not overload the standard 550 sheet tray, the optional 550 sheet feeder, or the 
bypass tray.

Do not force print media into the bypass tray when you load it; otherwise, it may skew 
or buckle.

Ensure that the print media is not curled.

Face the recommended print side up.

See also: 
• "Loading Print Media" on page 122

Turn the print media over or around and try printing again to see if feeding improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom curled sheets of a ream before loading the print media.

Load print media only when the standard 550 sheet tray, the optional 550 sheet 
feeder, or the bypass tray is empty.

Wipe the feed roller in the standard 550 sheet tray, the optional 550 sheet feeder, or 
the bypass tray with a cloth moistened with water.

See also: 
• "Cleaning Inside the Printer" on page 250

The envelope is creased after 
printed.

Make sure that the envelope is loaded in the bypass tray as instructed in "Loading 
Envelope in the Bypass Tray" on page 129.

Page breaks in unexpected 
places.

Increase the value for the Timeout on the operator panel or CentreWare Internet 
Services. 
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Print media does not stack neatly 
in the output tray.

Turn the print media stack over in the standard 550 sheet tray or the bypass tray.

Cannot print from the standard 
550 sheet tray or the optional 550 
sheet feeder because the print 
media in the tray or feeder is 
curled.

Load the print media into the bypass tray.

Problem Action
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Print Quality Problems
This section includes:

• "The Output Is Too Light" on page 227

• "Toner Smears or Print Comes Off" on page 228

• "Random Spots/Blurred Images" on page 229

• "The Entire Output Is Blank" on page 230

• "Streaks Appear on the Output" on page 231

• "Vertical Blanks" on page 232

• "Mottle" on page 233

• "Ghosting" on page 233

• "Light-Induced Fatigue" on page 234

• "Fog" on page 234

• "Bead-Carry-Out (BCO)" on page 235

• "Jagged Characters" on page 235

• "Banding" on page 236

• "Auger Mark" on page 236

• "Wrinkled/Stained Paper" on page 237

• "Damage on the Leading Edge of Paper" on page 238

• "The Top and Side Margins Are Incorrect" on page 238

• "Protrudent/Bumpy Paper" on page 239

• "Images Are Skewed" on page 239

NOTE: 

• In this section, some procedures use the operator panel, CentreWare Internet Services or PCL 6 driver.

See also: 
• "Understanding the Printer Menus" on page 162

• "CentreWare Internet Services" on page 65
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 The Output Is Too Light

Problem Action

The output is too light. The toner cartridge may be low or need to be replaced. Confirm the amount of toner 
in the toner cartridge.

1 Check the toner level in the Status Monitor window.

2 Replace the toner cartridge as necessary.

If the problem persists, disable Toner Saver in the print driver.

Disable Toner Saver in the print driver. The following procedure uses the PCL 6 
driver as an example.

1 On the Image Options tab, ensure that Off is selected in the Toner Saver 
drop-down menu.

If the problem persists, try changing the Paper Type setting in the print driver.

The print media surface may be uneven. Try changing the Paper Type setting in the 
print driver. For example, change the plain paper to heavyweight using a PCL 6 
driver.

1 On the Paper/Output tab, change the Paper Type setting.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 118

If not, use the print media recommended for the printer.

If the problem persists, ensure the transfer unit is correctly installed.

Ensure the transfer unit is correctly installed.

See also:  
• "Installing a Transfer Unit" on page 264

If the problem persists, adjust the density level.

Adjust the density level.

1 Check the density level in the Adjust Density menu.

2 Adjust the density level lower.

See also:  
• "Adjust Density" on page 184

If the problem persists, clean the toner in a drum cartridge.

Clean the toner in a drum cartridge.

1 On the operator panel, press the  (Menu) button and select Admin Menu → 
Maintenance Mode → Toner Refresh.

2 Press the  button.

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Toner Smears or Print Comes Off

Problem Action

Toner smears or print comes off. The print media surface may be uneven. Try changing the Paper Type setting in the 
print driver. For example, change the plain paper to heavyweight using a PCL 6 
driver.

1 On the Paper/Output tab, change the Paper Type setting.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 118

If not, use the print media recommended for the printer.

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

1 Replace the drum cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

2 After you replace the drum cartridge, test print your document again.

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger Roll" on page 261.

Replace the fusing unit.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the problem persists, replace the transfer unit and the retard roll as instructed in 
"Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger Roll" on 
page 261.

Replace the transfer unit and the retard roll.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Random Spots/Blurred Images

Problem Action

The printed result has random 
spots or is blurred.

Ensure that the toner cartridge is installed correctly. 

See also: 
• "Installing a Toner Cartridge" on page 256

If the problem persists, ensure that the drum cartridge is installed correctly.

Ensure that the drum cartridge is installed correctly.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

If the problem persists, clean the chute above the regi roll inside the rear of the printer 
with a dry cloth.

Clean the chute above the regi roll inside the rear of the printer with a dry cloth.

See also: 
• "Rear View" on page 33

If the problem persists, lower the transfer unit voltage.

Lower the transfer unit voltage.

1 Check the transfer unit voltage in the Adjust TransUnit menu.

2 Decrease the voltage.

See also: 
• "Adjust TransUnit" on page 183

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger Roll" on page 261.

Replace the fusing unit if you have a spare unit.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 The Entire Output Is Blank

Problem Action

The entire output is blank. The toner cartridge may be low or need to be replaced. Confirm the amount of toner 
in the toner cartridge.

1 Check the toner level in the Status Monitor window.

2 Replace the toner cartridge as necessary.

If the problem persists, disable Toner Saver in the print driver.

Disable Toner Saver in the print driver. The following procedure uses the PCL 6 
driver as an example.

1 On the Image Options tab, ensure that Off is selected in the Toner Saver 
drop-down menu.

If the problem persists, try changing the Paper Type setting in the print driver.

The print media surface may be uneven. Try changing the Paper Type setting in the 
print driver. For example, change the plain paper to heavyweight using the PCL 6 
driver.

1 On the Paper/Output tab, change the Paper Type setting.

If the problem persists, verify that the correct print media is being used.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 118

If not, use the print media recommended for the printer.

If the problem persists, ensure the transfer unit is correctly installed.

Ensure the transfer unit is correctly installed.

See also: 
• "Installing a Transfer Unit" on page 264

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.



Troubleshooting 231

 Streaks Appear on the Output

Problem Action

Streaks appear on the output. The toner cartridge may be low or need to be replaced. Confirm the amount of toner 
in the toner cartridge.

1 Check the toner level in the Status Monitor window.

2 Replace the toner cartridge as necessary.

If the problem persists, stir the developer in a drum cartridge.

Stir the developer in a drum cartridge.

1 On the operator panel, press the  (Menu) button and select Admin Menu → 
Maintenance Mode → Clean Developer.

2 Press the  button.

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger Roll" on page 261.

Replace the fusing unit if you have a spare unit.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Vertical Blanks

Problem Action

The printed result has vertical 
blanks.

Clean the rear side of the drum cartridge with a dry cloth.

See also: 
• "Replacing the Drum Cartridge" on page 257

If the problem persists, ensure the light path is not covered.

Ensure the light path is not covered.

1 Remove the drum cartridge, and keep it in the dark place.

See also: 
• "Replacing the Drum Cartridge" on page 257

2 Check the light path, and then remove the shielding.

3 Re-install the drum cartridge.

See also: 
• "Installing a Drum Cartridge" on page 260

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger Roll" on page 261.

Replace the fusing unit if you have a spare unit.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Mottle

 Ghosting

Problem Action

The printed result has mottled 
appearance.

Verify that the print media recommended for the printer is being used.

If you use non-recommended print media, use the print media recommended for the 
printer.

If the problem persists, raise the transfer unit voltage.

Raise the transfer unit voltage.

1 Check the transfer unit voltage in the Adjust TransUnit menu.

2 Increase the voltage.

See also: 
• "Adjust TransUnit" on page 183

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

The printed result has ghosting. If the type of the ghosting is positive ghost:

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

If the type of the ghosting is negative ghost:

Verify that the print media recommended for the printer is being used.

If you are using non-recommended print media, use the print media recommended 
for the printer.

See also: 
• "Ghost Control" on page 186

If the problem is solved, adjust the transfer bias.

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Adjust the transfer bias.

1 On the operator panel, press the  (Menu) button and select Admin Menu → 
Maintenance Mode → Adjust TransUnit.

2 Adjust the setting for the type of print media being used.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Light-Induced Fatigue

 Fog

Problem Action

The printed result has 
light-induced fatigue pattern.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

The printed result is foggy. Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Bead-Carry-Out (BCO)

 Jagged Characters

Problem Action

Bead-Carry-Out (BCO) is 
happening.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

The printed result has jagged 
characters.

Enable Bitmap Smoothing in the print driver. The following procedure uses the PCL 
6 driver as an example.

1 On the Advanced tab, set Bitmap Smoothing under Image Options to On.

If the problem persists, check whether or not the downloaded font you are using is 
recommended.

If using a downloaded font, ensure that the font is recommended for the printer, 
operating system, and the application being used.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Banding

 Auger Mark

Problem Action

The printed result has banding. Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Replace the fusing unit if you have a spare unit.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the cause of the problem is not located, contact the Fuji Xerox local representative 
office or an authorised dealer.

Replace the transfer unit and the retard roll.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the cause of the problem is not located, contact the Fuji Xerox local representative 
office or an authorised dealer.

Problem Action

The printed result has auger 
mark.

Stir the developer in a drum cartridge.

1 On the operator panel, press the  (Menu) button and select Admin Menu → 
Maintenance Mode → Clean Developer.

2 Press the  button.

If the problem persists, replace the drum cartridge if you have a spare cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

• "Installing a Drum Cartridge" on page 260

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Wrinkled/Stained Paper

Problem Action

The output is wrinkled.
The output is stained.

Verify that the correct print media is being used.

See also: 
• "Usable Print Media" on page 118

• "About Print Media" on page 116

If not, use the print media recommended for the printer.

If the problem with printing on an envelope persists, check the wrinkle of the 
envelope.

If the problem with printing on a print media other than envelopes persists, contact 
the Fuji Xerox local representative office or an authorised dealer.

Envelopes may get wrinkled depending on their paper type and condition.

Check whether the wrinkle of the four edges of the envelope is within 30 mm.

If the wrinkle of the four edges of the envelope is within 30 mm, this type of wrinkle is 
considered normal. Your printer is not at fault.

If not, load the envelopes in the bypass tray properly.

Load the envelopes in the bypass tray properly.

See also: 
• "Loading Envelope in the Bypass Tray" on page 129

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger Roll" on page 261.

Replace the fusing unit if you have a spare unit.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Damage on the Leading Edge of Paper

 The Top and Side Margins Are Incorrect

Problem Action

The output is damaged on its 
leading edge.

When using the bypass tray, reverse the paper and then try again. 

If the problem persists, change the paper with another one and then try again.

When using the standard 550 sheet tray or optional 550 sheet feeder, change the 
paper and then try again.

Change the paper with another one and then try again.

If the problem persists, use the standard 550 sheet tray or optional 550 sheet feeder 
in place of the bypass tray.

Use the standard 550 sheet tray or optional 550 sheet feeder in place of the bypass 
tray.

If the problem persists, replace the fusing unit as instructed in "Replacing the Fusing 
Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger Roll" on page 261.

Replace the fusing unit if you have a spare unit.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

The top and side margins are 
incorrect.

Ensure that the margins are set correctly on the application being used.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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 Protrudent/Bumpy Paper

 Images Are Skewed

Problem Action

Printed surface got 
protrudent/bumpy.

Clean up the fusing unit.

1 Load one sheet of paper in the bypass tray, and then print a solid image all over 
paper.

2 Load the printed sheet with the side to be printed on facing down, and then print a 
blank sheet of paper.

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.

Problem Action

The printed result are skewed. Adjust the paper guides properly.

If the problem persists, install the transfer unit according to an appropriate procedure.

Install the transfer unit according to an appropriate procedure.

See also: 
• "Installing a Transfer Unit" on page 264

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Noise

Problem Action

The printed result has the noise. Replace the transfer unit and the retard roll.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the problem persists, replace the drum cartridge.

Replace the fusing unit.

See also: 
• "Replacing the Fusing Unit, Transfer Unit, Retard Roll, Feed Roll and Nudger 

Roll" on page 261

If the problem persists, replace the toner cartridge.

Replace the drum cartridge if you have a spare cartridge.

See also: 
• "Replacing the Drum Cartridge" on page 257

If the problem persists, replace the toner cartridge.

Replace the toner cartridge.

See also: 
• "Replacing the Toner Cartridge" on page 254

If the problem persists, contact the Fuji Xerox local representative office or an 
authorised dealer.
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Digital Certificate Problem

Problem Action

The Upload Signed Certificate 
button is not displayed.

Confirm whether the optional hard disk unit is connected correctly, and confirm 
whether data encryption is enabled from the operator panel.

The Upload Signed Certificate 
button is disabled.

Create a self-signed certificate and enable SSL.

 The Certificate Management 
button is disabled.

The certificate cannot be 
imported.

Confirm validity period of the certificate as well as the time setting of the device.

Confirm whether the password is correct.

Confirm whether the file type is PKCS#7/#12 or x509CACert (extension: 
p7b/p12/pfx/cer/crt).

Confirm whether the attribute information (key Usage/Extended key usage) of the 
certificate to be imported is set correctly.

Use Internet Explorer.

016-404 is displayed when 
setting the encryption of the 
optional hard disk unit to off.

After initializing, import the certificate and enable the security settings again. The 
action is the same when formatting the optional hard disk unit.

016-404 is displayed when 
formatting the optional hard disk 
unit.

Security is set to off when setting 
encryption of the optional hard 
disk unit to off.

Security is set to off when 
formatting the optional hard disk 
unit.

A certificate is deleted when 
setting encryption of the optional 
hard disk unit to off.

A certificate is deleted when 
formatting the optional hard disk 
unit.

A certificate cannot be set in 
Certificate Details page.

The validity period of the certificate is invalid.

Confirm whether the time setting of the machine is correct, and whether the validity 
period of the certificate has expired.

The certificate chain (path validation) of the imported certificate may not be correctly 
validated.

Confirm whether all of the high-level certificates (Trusted/Intermediate) have been 
imported and are not deleted, and whether the validity period has expired.

Although a certificate was 
imported, it is not displayed when 
selecting Local Device for 
Category in Certificate 
Management page.

To import a certificate for use with the device (own device), import the secret key and 
a certificate of the PKCS#12 (p12/pfx) format as a pair.

Server validation is not operating 
correctly.

Although importing a root certificate (Trusted) to use for server authentication, an 
Intermediate certificate may be required when validating the path.

When executing a certificate file with the certification authority, create the certificate 
with a format including all paths and then import that certificate.

Digital Signature cannot be 
selected with the IPsec setting.

Either the certificate has not been imported or the certificate has not been associated 
for use with Digital Signature mode of IPsec. See "Using Digital Certificates" on 
page 152 to set a certificate of IPsec.
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Problems With Installed Optional Accessories
If an option does not operate correctly following installation or stops working:

• Turn off the printer, wait for 10 seconds, and then turn on the printer. If this does not fix the problem, unplug the printer, and 
check the connection between the option and the printer.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

• Ensure the option is selected in the print driver you are using.

• Print the Printer Settings page to see if the option is listed in the Printer Options list. If the option is not listed, re-install it.

See also: 

• "Report / List" on page 162

The following table lists printer's option and corrective action for related problem. If the suggested corrective action 
does not correct the problem, contact customer support.

Problem Action

The optional 550 sheet feeder 
does not work correctly.

Ensure that the optional 550 sheet feeder is correctly installed on the printer. 
Re-install the optional 550 sheet feeder. 

See also: 
• "Removing the Optional 550 Sheet Feeder" on page 281

• "Installing the Optional 550 Sheet Feeder" on page 41

If the problem persists, contact customer support.

Ensure that the print media is loaded correctly.

See also: 
• "Loading Print Media in the Standard 550 Sheet Tray and the Optional 550 Sheet 

Feeder" on page 123

If the problem persists, contact customer support.

The optional 512MB memory 
does not work correctly.

Ensure that the optional 512MB memory is securely connected to the memory 
connector.

If the problem persists, contact customer support.

The optional hard disk unit does 
not work correctly.

Ensure that the optional hard disk unit is securely inserted to the correct slot.

The optional wireless printer 
adapter does not work correctly.

Ensure that the optional wireless printer adapter is securely inserted to the correct 
slot.
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Other Problems

Problem Action

Condensation has occurred 
inside the printer.

This usually occurs within several hours after you heat the room in winter. This also 
occurs when the printer is operating in a location where relative humidity reaches 
85% or more. Adjust the humidity or relocate the printer to an appropriate 
environment.
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Understanding Printer Messages
The printer LCD panel displays messages describing the current state of the printer and indicates possible printer 
problems you must resolve. This section describes messages, their meanings, and how to clear the messages.

When you contact customer support about an error, have the error codes and messages ready.

IMPORTANT: 

• When an error code is displayed, the print data remaining on the printer and the information accumulated in the memory of the 
printer are not secured.

• When you turn off the printer to recover, if the optional hard disk unit is not installed on your printer, note that the data in the 
memory are cleared when the printer is turned off.

NOTE: 

• An error code is listed in an error message.

• For error messages that are not listed in this chapter, refer to instructions in each error messages.

Error-Code What You Can Do

010-317 Turn off the printer and wait for 40 minutes. Open the rear door and make sure that the fusing unit is 
fully installed, and turn on the printer.

010-397 Turn off the printer. Confirm that the fusing unit is correctly installed, and turn on the printer.

016-404 Contact your system administrator.

016-405

016-500 Turn off the printer, and turn it on again.

016-501

016-502

016-520 Contact your system administrator.

016-521

016-522

016-523

016-524

016-527

016-737 Turn off the printer, and turn it on again.

016-741

016-744

016-750 Press the  button, or wait for the time set in Fault Time-out for the printer to recover.

016-753

016-755

016-757

016-758

016-759

016-799 Press the  button, or wait for the time set in Fault Time-out for the printer to recover.

016-930 The device is not supported. Remove it from the USB port.

016-931 The USB hub is not supported. Remove it from the USB port.

027-446 Change IP address to avoid duplication. Turn off the printer, and turn it on again.

027-452

042-700 Wait for a while until the printer cools down.

077-300 Close the front cover.

093-922 Remove and shake the toner cartridge.

093-925 Turn off the printer. Confirm the toner cartridge is correctly installed, and turn on the printer.

093-926 Open the front cover. Remove the unsupported toner cartridge, and install a supported cartridge.

093-973 Open the front cover, and make sure that the toner cartridge is fully installed.

116-316 Turn off the printer. Remove the optional 512MB memory from the slot, and then reattach it firmly. Turn 
on the printer. Contact customer support if this failure is repeated.
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116-317 Turn off the printer, and turn it on again.

116-320 Remove the unsupported optional memory module.
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Contacting Service
When you call for printer service, be prepared to describe the problem you are experiencing or the error message on 
the LCD panel.

You need to know the model type and service tag of your printer. See the label located on the rear of your printer.



Troubleshooting 247

Getting Help
This section includes:

• "LCD Panel Messages" on page 247

• "SimpleMonitor Alerts" on page 247

• "Obtaining the Product Information" on page 247

Fuji Xerox provides several automatic diagnostic tools to help you produce and maintain print quality.

 LCD Panel Messages
The LCD panel provides you with information and troubleshooting help. When an error or warning condition occurs, 
the LCD panel displays a message informing you of the problem. 

See also: 
• "Understanding Printer Messages" on page 244

 SimpleMonitor Alerts
The SimpleMonitor is a tool that is included on the Driver CD Kit. It automatically checks the printer status when you 
send a print job. If the printer is unable to print your job, the SimpleMonitor automatically displays an alert on your 
computer screen to let you know that the printer needs attention.

 Obtaining the Product Information

Obtaining the Latest Print Driver
The latest print driver can be obtained by downloading it from our web site.

The following procedure uses the PCL 6 driver as an example.

NOTE: 

• The communication fee shall be borne by users. 

1 In your print driver's Printing Preferences dialog box, click the Advanced tab and then click About.

2 Click Fuji Xerox Web Site.

Your web browser launches and our web site is displayed.

3 Follow the instructions on the web site and download an appropriate print driver.

NOTE: 

• You can browse our web site also on the Driver CD Kit included with the printer. To access the web site, click Fuji Xerox Web 
Site on the installation startup window of the CD-ROM.

• The URL of the driver download service page is as follows: http://www.fujixeroxprinters.com/

• For the latest information about the print driver features, refer to the Help provided for the print driver.

Updating the Printer's Firmware
Our web site also provides a tool that allows you to update the printer's firmware (software embedded within the 
printer) from your computer.

The latest firmware and updating tool can be downloaded from the following URL.

Follow the instructions on the web site and download the correct firmware update.

http://www.fujixeroxprinters.com/

NOTE: 

• The communication fee shall be borne by users.

http://www.fujixeroxprinters.com/
http://www.fujixeroxprinters.com/


248 Troubleshooting

Non-Genuine Mode
When toner within a toner cartridge is empty, the Replace Toner Cartridge message appears.

When you want to use the printer in Non-Genuine mode, program the mode and replace the toner cartridge.

IMPORTANT: 

• If you use the printer in the Non-Genuine mode, the performance of the printer may not be at its optimum. And any problems 
that may arise from the use of the Non-Genuine mode are not covered by our quality guarantee. The continuous use of the 
Non-Genuine mode can also cause the printer to break down, and any repair charges for such break down will be incurred by 
users.

NOTE: 

• Before starting the operation described below, confirm that Ready is displayed on the LCD panel.

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Non-Genuine, and then press the  button.

5 Select Toner, and then press the  button.

6 Select On, and then press the  button.

The printer switches to the Non-Genuine mode.
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8
Maintenance

This chapter includes:

• "Cleaning the Printer" on page 250

• "Replacing Consumables" on page 253

• "Ordering Supplies" on page 272

• "Storing Print Media" on page 273

• "Storing Consumables" on page 274

• "Managing the Printer" on page 275

• "Conserving Supplies" on page 276

• "Checking Page Counts" on page 277

• "Moving the Printer" on page 278

• "Removing Options" on page 279
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Cleaning the Printer
This section describes how to clean the printer in order to maintain it in good condition and print clean printouts all 
the time.

This section includes:

• "Cleaning Inside the Printer" on page 250

 Cleaning Inside the Printer
Clean the feed roller inside the printer if print media does not feed correctly.

1 Turn off the printer and disconnect the power cord.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Gently pull open the bypass tray cover.

3 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.

WARNING:

• When cleaning this product, use the designated cleaning materials exclusive to it. Other cleaning materials may 
result in poor performance of the product. Never use aerosol cleaners to avoid catching fire and explosion.

CAUTION:

• When cleaning this product, always switch off and unplug it. Access to a live machine interior may cause electric 
shock.
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4 Pull the tray out of the printer about 200 mm.

5 Hold the tray with both hands, and remove it from the printer.

6 Wipe the feed roller inside the printer with a cloth moistened with water.

7 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 

• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

Bypass Tray Feed Roller

Standard 550 Sheet Tray 
Feed Roller
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8 Insert the bypass tray into the printer, push until it stops, and close the cover.
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Replacing Consumables
This section describes how to replace consumables.

The following consumables are supplied as the replaceable items.

• Toner cartridge

• Drum cartridge

• Fusing unit

• Transfer unit

• Retard roll

• Feed roll

• Nudger roll

WARNING:

• Use a broom or a wet cloth to wipe off spilled toner. Never use a vacuum cleaner for the spills.
It may catch fire by electric sparks inside the vacuum cleaner and cause explosion. If you spill a large 
volume of toner, contact your local Fuji Xerox representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and 
cause burn injuries or explosion.
If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for 
its disposal.

CAUTION:

• Keep a drum cartridge and a toner cartridge out of the reach of children. If a child accidentally 
swallows toner, spit it out, rinse mouth with water, drink water and consult a physician immediately.

• When replacing a drum cartridge and a toner cartridge, be careful not to spill the toner. In case of any 
toner spills, avoid contact with clothes, skin, eyes and mouth as well as inhalation.

• If toner spills onto your skin or clothing, wash it off with soap and water. 
If you get toner particles in your eyes, wash it out with plenty of water for at least 15 minutes until 
irritation is gone. Consult a physician if necessary. 
If you inhale toner particles, move to a fresh air location and rinse your mouth with water.
If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a 
physician immediately.
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 Replacing the Toner Cartridge
Fuji Xerox toner cartridge is available only through Fuji Xerox. 

It is recommended that you use Fuji Xerox toner cartridge for your printer. Fuji Xerox does not provide warranty 
coverage for problems caused by using accessories, parts, or components not supplied by Fuji Xerox.

This section includes:

• "Overview" on page 254

• "Removing the Toner Cartridge" on page 255

• "Installing a Toner Cartridge" on page 256

Overview
When a toner cartridge reaches its usable life-span, the following messages appear on the LCD panel.

*1: This warning appears only when Fuji Xerox toner cartridge is used (Non-Genuine mode is set to Off).

*2: When a high capacity toner cartridge is set, the remaining page yield is approx. 2,500 pages. The remaining page yield differs 
depending on printing conditions, contents of the documents, and frequency of turning on/off the printer. For more information, see 
IMPORTANT of "Consumables" on page 272.

IMPORTANT: 

• When placing a used toner cartridge on the floor or on a table, place a few sheets of paper under the toner cartridge to catch 
any toner that may spill.

• Do not reuse old toner cartridge once you remove it from the printer. Doing so can impair print quality.

• Do not shake or pound the used toner cartridge. The remaining toner may spill.

• We recommend you to use up the toner cartridge within one year after removing it from the packaging.

Message Remaining Page Yield Printer Status and Action

Toner Low

Replace Soon*1
1,000 pages*2 The toner cartridge has become low. Prepare a new 

one.

Replace

Toner Cartridge

- The toner cartridge has become empty. Replace the 
old toner cartridge with a new one.
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Removing the Toner Cartridge

1 Put your fingers in the hole on the front cover, and then pull it down to open.

2 Grasp the toner cartridge lock lever, and then raise it upward to unlock.

3 Grasp the handle on the toner cartridge, and then pull it out.

IMPORTANT: 

• Do not shake the toner cartridge as it may cause toner spills. 
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Installing a Toner Cartridge

1 Unpack a new toner cartridge.

NOTE: 

• Handle the toner cartridge carefully to avoid spilling of the toner.

2 Shake the new toner cartridge five or six times to distribute the toner evenly.

3 Make sure that the two tabs of the toner cartridge align with the grooves on the printer, and then insert it into the 
printer until it clicks.

4 Grasp the toner cartridge lock lever, and then pull it down until it stops.

5 Close the front cover.
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 Replacing the Drum Cartridge
This section describes how to replace the drum cartridge.

IMPORTANT: 

• Protect the drum of the drum cartridge against bright light. If the rear door remains open for more than 3 minutes, print quality 
may deteriorate.

This section includes:

• "Removing the Drum Cartridge" on page 258

• "Installing a Drum Cartridge" on page 260

Overview
When a drum cartridge reaches its usable life-span, the following messages appear on the LCD panel.

Message Remaining Page Yield Printer Status and Action

K Drum Cartridge

Replace Soon

10,000 pages The drum cartridge is near the end of its life. Prepare a 
new one.

Replace Black

Drum Cartridge

- The drum cartridge has reached the end of its life. 
Replace the old drum cartridge with a new one.
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Removing the Drum Cartridge

1 Put your fingers in the hole on the front cover, and then pull it down to open.

2 Grasp the toner cartridge lock lever, and then raise it upward to unlock.

3 Grasp the handle on the toner cartridge, and then pull it out.

IMPORTANT: 

• Do not shake the toner cartridge as it may cause toner spills.

• Keep the removed toner cartridge on a level surface.

4 Grasp the handle on the front of the drum cartridge, and then pull it out halfway with one hand.
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5 Grasp the handle on the top of the drum cartridge with the other hand, and then pull it out completely.
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Installing a Drum Cartridge

1 Unpack a new drum cartridge.

2 Insert the drum cartridge into the cartridge slot, and then push until it stops.

NOTE: 

• The protective cover of the drum comes off while inserting the drum cartridge into the cartridge slot. You do not need to 
remove it in advance.

3 Make sure that the two tabs of the toner cartridge align with the grooves on the printer, and then insert it into the 
printer until it clicks.

4 Grasp the toner cartridge lock lever, and then pull it down until it stops.

5 Close the front cover.
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 Replacing the Fusing Unit, Transfer Unit, Retard Roll, 
Feed Roll and Nudger Roll

You need to replace five parts (fusing unit, transfer unit, retard roll, feed roll and nudger roll) at a time. The transfer 
unit, the retard roll, the feed roll and the nudger roll for replacement come with a new fusing unit.

Fuji Xerox fusing unit, transfer unit, retard roll, feed roll and nudger roll are available only through Fuji Xerox. To 
order by phone, see also "Online Services" on page 293.

It is recommended that you use Fuji Xerox fusing unit, transfer unit, retard roll, feed roll and nudger roll for your 
printer. Fuji Xerox does not provide warranty coverage for problems caused by using accessories, parts, or 
components not supplied by Fuji Xerox.

This section includes:

• "Removing the Fusing Unit" on page 262

• "Installing a Fusing Unit" on page 263

• "Removing the Transfer Unit" on page 263

• "Installing a Transfer Unit" on page 264

• "Removing the Retard Roll in the Standard 550 Sheet Tray" on page 265

• "Installing a Retard Roll in the Standard 550 Sheet Tray" on page 266

• "Removing the Feed Roll and Nudger Roll" on page 267

• "Installing the Feed Roll and Nudger Roll" on page 270

• "Resetting the Counter of the Fusing Unit" on page 271

Overview
When a fusing unit reaches its usable life-span, the following messages appear on the LCD panel.

CAUTION:

• Fusing Unit Safety
When removing the Fusing Unit, always switch off first and wait for 40 minutes until it cools off.

Message Remaining Page Yield Printer Status and Action

Fusing Unit Life

Replace Soon

20,000 pages The fusing unit is near the end of its life. Prepare a 
new one.

Replace the fusing unit as well as the transfer unit at 
the same time.

Fusing Unit Life

Replace

- The fusing unit has reached the end of its life. Replace 
the old fusing unit with a new one.
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Removing the Fusing Unit

1 Turn off the printer, and wait for 40 minutes.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Pull the rear door handle on the rear of the printer to open the rear door.

3 Raise the two gray levers on the both sides of the fusing unit to unlock.

4 Grasp the grips on both sides of the fusing unit placing thumb on the knurling, and then pull out the unit.
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Installing a Fusing Unit

1 Unpack a new fusing unit.

2 Remove the packing material from the fusing unit.

3 Insert the fusing unit into the printer until it clicks.

NOTE: 

• Hold both sides of the fusing unit with your hands.

• Make sure that the fusing unit is firmly set in the slots and cannot be moved easily.

4 Lower the two gray levers to lock the fusing unit.

NOTE: 

• After replacing the fusing unit, initialize its life counter. For details, see "Resetting the Counter of the Fusing Unit" on 
page 271.

Removing the Transfer Unit

1 Push the tabs on both sides of the transfer unit inward, and then lift it out of the printer.



264 Maintenance

Installing a Transfer Unit

1 Unpack a new transfer unit.

2 Hold the transfer unit by its both ends.

3 Push the both ends of the transfer unit inward, put it on the duplexer, and then rotate the transfer unit forward.

4 Make sure that the arrow marks on the transfer unit and the printer face each other, and then press the two tabs 
on transfer unit inward to lock.

5 Close the rear door.
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Removing the Retard Roll in the Standard 550 Sheet Tray

1 Hold the standard 550 sheet tray with both hands, and remove it from the printer.

NOTE: 

• Ensure that you remove all the paper from the standard 550 sheet tray before removing the retard roll.

2 Slightly pressing down the lock lever on the standard 550 sheet tray to the right with one hand, raise the retard 
roll with the other hand.

3 Slide the retard roll to the left to remove it from the standard 550 sheet tray.
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Installing a Retard Roll in the Standard 550 Sheet Tray

1 Unpack a new retard roll.

2 Slide the two axles of the retard roll into the holes on the standard 550 sheet tray.

3 Press down the retard roll until it snaps.

4 Load paper in the standard 550 sheet tray, and then insert the standard 550 sheet tray into the printer and push 
until it stops.

IMPORTANT: 

• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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Removing the Feed Roll and Nudger Roll

IMPORTANT: 

• Before replacing the feed roll and nudger roll, clean the inside of the printer if it is very dirty.

• When the optional 550 sheet feeder is installed on the printer, be sure to remove it before beginning the replacement. For 
details, see "Removing the Optional 550 Sheet Feeder" on page 281.

1 Turn off the printer and disconnect the power cord.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Pull the tray out of the printer about 200 mm. 

3 Hold the tray with both hands, and remove it from the printer.

4 Hold the printer with both hands, and gently rotate the printer onto its left side.
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5 Rotate the feed roll so that its tab comes to the front.

6 Pull the tab toward you, and pull the feed roll upward to remove it from the shaft.

7 Rotate the nudger roll so that its tab comes to the front.
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8 Pull the tab toward you, and pull the nudger roll upward to remove it from the shaft.
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Installing the Feed Roll and Nudger Roll

1 Unpack a new feed roll and nudger roll.

NOTE: 

• The feed roll and nudger roll have the same shape. There is no difference between the replacement rollers.

2 Insert the nudger roll into the right shaft. Set the knob of the roller into the notches of the clutch.

3 Insert the feed roll into the left shaft. Set the knob of the roller into the notches of the clutch.

NOTE: 

• Make sure that the feed roll and nudger roll are firmly set in the shaft and cannot be moved easily.

4 Hold the printer with both hands, and gently place the printer upright.
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5 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 

• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

IMPORTANT: 

• After replacing the feed roll and nudger roll, perform two or three test prints.

Resetting the Counter of the Fusing Unit
After replacing the fusing unit, use the operator panel to reset the counter of the fusing unit.

1 Press the  (Menu) button.

2 Select Admin Menu, and then press the  button.

3 Select Maintenance Mode, and then press the  button.

4 Select Reset FusingUnit, and then press the  button.

5 Ensure that Are You Sure? appears, and then press the  button.
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Ordering Supplies
This section includes:

• "Consumables" on page 272

• "When to Order Supplies" on page 272

• "Recycling Supplies" on page 272

Certain consumables and routine maintenance items need to be ordered occasionally. Each supply includes 
installation instructions on the box.

 Consumables
IMPORTANT: 

• Use of consumables/periodical replacement parts not recommended by Fuji Xerox can impair machine quality and 
performance. Use only consumables/periodical replacement parts recommended by Fuji Xerox.

IMPORTANT: 

• Average standard pages. Declared yield in accordance with ISO/IEC 19752. These values are estimates and vary depending 
on conditions such as the content being printed, paper size, paper type, the printer's operating environment, initializing 
process done when you turn on or off the printer, and adjustments to maintain print quality.

 When to Order Supplies
The LCD panel displays a warning when the supply nears its replacement time. Verify that you have replacements 
on hand. It is important to order these supplies when the messages first appear to avoid interruptions to your 
printing. The LCD panel displays an error message when the supply must be replaced.

For details on error messages about replacing the toner cartridge, drum cartridge, fusing unit, or transfer unit, see 
"Replacing Consumables" on page 253.

To order supplies, contact the Fuji Xerox local representative office or an authorised dealer.

IMPORTANT: 

• This printer is designed to provide the most stable performance and print quality when used with the recommended 
consumables. Not using consumables recommended for this machine degrades the performance and printing quality of the 
printer. You could also incur charges if the machine breaks down. To receive customer support and achieve the optimum 
performance of the printer, be sure to use recommended consumables.

 Recycling Supplies
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner cartridges and 

drums (photoreceptors) to make recycle parts, recycle materials or energy recovery.

• Proper disposal is required for toner cartridges and drums (photoreceptors) no longer needed. Do not open 
toner cartridges and drums (photoreceptors). Return them to your local Fuji Xerox representative.

Product Name Product Code Printable number of pages

Toner Cartridge 455 (Standard Capacity) CT201948 10,000 pages

Toner Cartridge 455 (High Capacity) CT201949 25,000 pages

Drum Cartridge 455 CT350976 100,000 pages

200K Maintenance Kit(110V) EL300845 200,000 pages

200K Maintenance Kit(220V) EL300846 200,000 pages
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Storing Print Media
To avoid potential paper feeding problems and uneven print quality, there are several things you can do:

• To achieve the best possible print quality, store print media in an environment where the temperature is 
approximately 70 °F/21 °C and the relative humidity is 40%.

• Store cartons of print media on a pallet or shelf, rather than directly on the floor.

• If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface 
so the edges do not buckle or curl.

• Do not place anything on top of the print media packages.
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Storing Consumables
Store consumables in their original packaging until you need to use them. Do not store consumables in:

• Temperatures greater than 104 °F/40 °C.

• An environment with extreme changes in humidity or temperature.

• Direct sunlight.

• Dusty places.

• A car for a long period of time.

• An environment where corrosive gases are present.

• A humid environment.
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Managing the Printer
This section includes:

• "Checking or Managing the Printer with CentreWare Internet Services" on page 275

• "Checking Printer Status with SimpleMonitor (Windows Only)" on page 275

 Checking or Managing the Printer with CentreWare 
Internet Services 

When the printer is installed in a TCP/IP environment, you can use CentreWare Internet Services to check the 
printer status, the remaining volume of consumables, and the paper loaded in this printer. You can also use 
CentreWare Internet Services to configure printer settings.

NOTE: 

• When using the printer as a local printer, you cannot use CentreWare Internet Services. For details about checking the status 
of a local printer, refer to "Checking Printer Status with SimpleMonitor (Windows Only)" on page 275.

Starting CentreWare Internet Services
Use the following procedure to start CentreWare Internet Services.

1 Launch your web browser.

2 Enter the IP address in the browser’s address field, and then press the Enter key.

The CentreWare Internet Services screen appears.

• Using Online Help
For details regarding the items that can be set in each CentreWare Internet Services screen, click the Help button to 
display the online Help.

 Checking Printer Status with SimpleMonitor (Windows 
Only)

SimpleMonitor is a tool that is installed with your Fuji Xerox print driver. It automatically checks the printer status 
when you send a print job. SimpleMonitor can also check the status of the tray and remaining amount of 
consumables, such as the toner cartridge.

Starting SimpleMonitor
Double-click the SimpleMonitor icon on the taskbar or right-click the icon and select Select Printer.

If the SimpleMonitor icon is not displayed on the taskbar, open SimpleMonitor from the Start menu:

The following procedure uses Microsoft® Windows® 7 as an example.

1 Click Start → All Programs → Fuji Xerox → SimpleMonitor for Asia-Pacific → Activate SimpleMonitor.

The Select Printer window appears.

2 Click the name of the desired printer from the list.

3 The Status Monitor window appears.

For details about the functions of SimpleMonitor, refer to the online Help.



276 Maintenance

Conserving Supplies
You can change several settings in your print driver to conserve toner cartridge and paper.

The following descriptions use the Windows PCL 6 driver as an example.

Supply Setting Function

Toner cartridge Toner Saver in the Image 
Options tab

This check box allows the users to select a print mode 
that uses less toner. The image quality will be lower 
when this feature is used.

Print media Pages Per Sheet (N-Up) 
in the Layout/Watermark 
tab

The printer prints two or more pages on one side of a 
sheet. Values for Pages Per Sheet (N-Up) are 1-Up, 
2-Up, 4-Up, 8-Up, 16-Up, 32-Up. Combined with the 
duplex setting, Pages Per Sheet (N-Up) allows you to 
print up to 64 pages on one sheet of paper. (32 images 
on the front and 32 on the back)



Maintenance 277

Checking Page Counts
The total number of printed pages can be checked at the operator panel. Four meters are available: Meter 1, 
Meter 2, Meter 3, and Meter 4.

The Meter Readings counts the number of pages printed properly. Single side print (including Pages Per Sheet 
(N-Up)) is counted as one job, and 2-sided print (including Pages Per Sheet (N-Up)) is counted as two. During 
2-sided printing, if an error occurs after one side is printed properly, it is counted as one.

When doing 2-sided printing, a blank page may be inserted automatically depending on the settings of the 
application. In this case, the blank page is counted as one page.

For information about the individual meter, see "Meter Readings" on page 163.

Use the following procedure to check a meter:

1 Press the  (Menu) button.

2 Select Meter Readings, and then press the  button.

3 Select the desired meter to check the number of pages.
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Moving the Printer
This section describes how to move the printer.

IMPORTANT: 

• To prevent you from dropping the printer and getting backache or injuries, lift the printer by firmly gripping the recessed areas 
on both sides of the printer. Never lift the printer by gripping any other areas.

NOTE: 

• If the optional 550 sheet feeder has been installed, uninstall the all optional 550 sheet feeders before moving the printer. If the 
optional 550 sheet feeder is not fixed securely to the printer, it may fall to the ground and cause injuries. For details on how to 
uninstall the optional 550 sheet feeder, see "Removing the Optional 550 Sheet Feeder" on page 281.

1 Turn off the printer and disconnect the power cord, interface cable, and any other cables.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Remove any paper in the output tray and slide the output tray extension inside the printer.

3 Lift the printer and move it gently.
NOTE: 
• If you move the printer over a long distance, remove the toner cartridge from the printer to prevent toner from 

spilling, and pack the printer inside a box.
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Removing Options
If the printer location needs to be changed or the printer and print media handling options need to be shipped to a 
new location, all print media handling options must be removed from the printer. For shipping, pack the printer and 
print media handling options securely to avoid damage.

This section includes:

• "Removing the Optional 512MB Memory" on page 279

• "Removing the Optional 550 Sheet Feeder" on page 281

• "Removing the Optional Wireless Printer Adapter" on page 285

• "Removing the Optional Font ROM" on page 287

 Removing the Optional 512MB Memory
IMPORTANT: 

• When you remove the optional 512MB memory, be sure to turn off the printer, unplug the power cord, and disconnect all 
cables from the rear of the printer before starting these tasks.

1 Turn off the printer.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Turn the screw on the control board cover counterclockwise.

NOTE: 

• Loosen the screw. You do not need to remove the screw.

3 Slide the control board cover towards the rear of the printer to remove the cover.
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4 Push the clips on both sides of the slot outward to raise the 512MB memory.

5 Hold the 512MB memory and pull it straight out.

6 Align the guide on the control board cover with the slot around the control board, and slide it towards the front 
of the printer.

7 Turn the screw clockwise.

8 Turn on the printer.
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 Removing the Optional 550 Sheet Feeder
IMPORTANT: 

• When you remove the optional 550 sheet feeder (Tray 2, Tray 3 or Tray 4), be sure to turn off the printer, unplug the power 
cord, and disconnect all cables from the rear of the printer before starting these tasks.

1 Turn off the printer.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Disconnect the power cord from the power connector on the rear of the printer.

3 Gently pull open the bypass tray cover.

4 Grasp both sides of the bypass tray, and then pull the bypass tray from the printer.
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5 Pull the standard 550 sheet tray out of the printer about 200 mm. Hold the standard 550 sheet tray with both 
hands, and remove it from the printer.

6 Remove the two screws joining the printer and the optional 550 sheet feeder by unscrewing them with a coin or 
similar object.

NOTE: 

• The screw hole is located in 145 mm recess from the front of the printer.

7 Gently lift the printer off the optional 550 sheet feeder, and place it on a level surface.

When you remove the multiple optional 550 sheet feeders, go to step 8.

When you remove a single optional 550 sheet feeder, go to step 13.

8 Pull the optional 550 sheet tray out of another optional 550 sheet feeder.
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9 Remove the two screws joining the optional 550 sheet feeder and the other feeder by unscrewing them with a 
coin or similar object.

10 Gently lift the optional 550 sheet feeder off the other feeder, and place it on a level surface.

11 Insert the optional 550 sheet tray into the feeder, and push until it stops.

12 Repeat steps 8 to 11 when installing another optional 550 sheet feeder.

13 Insert the standard 550 sheet tray into the printer, and push until it stops.

IMPORTANT: 

• Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.
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14 Insert the bypass tray into the printer, push until it stops, and close the cover.

15 Reconnect all cables into the rear of the printer and turn on the printer.
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 Removing the Optional Wireless Printer Adapter
IMPORTANT: 

• If you remove the optional wireless printer adapter, be sure to turn off the printer, unplug the power cord, and disconnect all 
cables from the rear of the printer before removing the adapter.

1 Turn off the printer.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Disconnect the power cord from the power connector on the rear of the printer.

3 Turn the screw on the control board cover counterclockwise.

4 Slide the control board cover towards the rear of the printer and remove the cover.
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5 Remove the wireless printer adapter from the printer by releasing the adapter's hook while pushing the wireless 
printer adapter towards the front of the printer.

6 Align the guide on the control board cover with the slot around the control board, and slide it towards the front 
of the printer.

7 Turn the screw clockwise.

8 Reconnect all cables into the rear of the printer and turn on the printer.
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 Removing the Optional Font ROM
IMPORTANT: 

• When you remove the optional Font ROM, be sure to turn off the printer, unplug the power cord, and disconnect all cables 
from the rear of the printer before starting these tasks.

1 Turn off the printer.

IMPORTANT: 

• If the optional hard disk unit is not installed on your printer, note that the data in the memory are cleared when the printer 
is turned off.

2 Turn the screw on the control board cover counterclockwise.

NOTE: 

• Loosen the screw. You do not need to remove the screw.

3 Slide the control board cover towards the rear of the printer to remove the cover.

4 Pull the tabs on both sides of the font ROM outward to raise it.

IMPORTANT: 

• If there is an optional hard disk unit, pull it out before removing the font ROM.
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5 Hold the font ROM and pull it straight out.

NOTE: 

• If you need, bring the removed hard disk unit back to the printer.

6 Align the guide on the control board cover with the slot around the control board, and slide it towards the front 
of the printer.

7 Turn the screw clockwise.

8 Turn on the printer.
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 Removing the Optional Hard Disk Unit
IMPORTANT: 

• If you remove the optional hard disk unit, be sure to turn off the printer, unplug the power cord, and disconnect all cables from 
the rear of the printer before removing the hard disk unit.

1 Turn off the printer.

2 Disconnect the power cord from the power source.

3 Turn the screw on the control board cover counterclockwise.

NOTE: 

• Loosen the screw. You do not need to remove the screw.

4 Slide the control board cover towards the rear of the printer and remove the cover.
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5 Remove the hard disk unit from the printer by releasing the hook of hard disk unit.

6 Align the guide on the control board cover with the slot around the control board, and slide it towards the front 
of the printer.

7 Turn the screw clockwise.

8 Reconnect all cables into the rear of the printer and turn on the printer.
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9
Contacting Fuji Xerox
This chapter includes:

• "Technical Support" on page 292

• "Online Services" on page 293
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Technical Support
Fuji Xerox recommends the Customer first utilize support materials shipped with the product, product diagnostics, 
information contained on the Web, and email support. If unsuccessful, to obtain service under product warranty the 
Customer must notify Fuji Xerox Telephone Support or its authorized service representative of the defect before the 
expiration of the warranty period. Customer will provide appropriate assistance to Telephone Support personnel to 
resolve issues, such as restoration of the operating system, software program and drivers to their default 
configuration and settings, verification of functionality of Fuji Xerox supplied products, replacement of customer 
replaceable units, clearing paper misfeeds and cleaning the unit and other prescribed routine and preventative 
maintenance.

If the Customer’s product contains features that enable Fuji Xerox or its authorised service representative to 
diagnose and repair problems with the product remotely, Fuji Xerox may request that the Customer allow such 
remote access to the product.
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Online Services
You can find detail Product and Consumable warranty information and activate your warranty by registering your 
details on our website at http://www.fujixerox.com/support/docuprint/

Fuji Xerox Online Support Assistant provides instructions and troubleshooting guides to resolve your printer 
problems. It is an easy-to-use, searchable online help. To find out more, please visit our online support at 
http://www.fujixerox.com/support/docuprint/

http://www.fujixerox.com/support/docuprint/
http://www.fujixerox.com/support/docuprint/
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